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Legal Notices
Product specifications are subject to change without notice and do not represent a commitment on the part of Avid Technology, Inc.

This product is subject to the terms and conditions of a software license agreement provided with the software. The product may 
only be used in accordance with the license agreement.

This document is protected under copyright law. An authorized licensee of Avid Motion Graphics may reproduce this publication for 
the licensee’s own use in learning how to use the software. This document may not be reproduced or distributed, in whole or in part, 
for commercial purposes, such as selling copies of this document or providing support or educational services to others. This 
document is supplied as a guide for Avid Motion Graphics. Reasonable care has been taken in preparing the information it contains. 
However, this document may contain omissions, technical inaccuracies, or typographical errors. Avid Technology, Inc. does not 
accept responsibility of any kind for customers’ losses due to the use of this document. Product specifications are subject to change 
without notice.

This product may be protected by one or more U.S. and non-U.S patents. Details are available at www.avid.com/patents.

Copyright © 2013 Avid Technology, Inc. and its licensors. All rights reserved.

The following disclaimer is required by Apple Computer, Inc.:
APPLE COMPUTER, INC. MAKES NO WARRANTIES WHATSOEVER, EITHER EXPRESS OR IMPLIED, REGARDING THIS 
PRODUCT, INCLUDING WARRANTIES WITH RESPECT TO ITS MERCHANTABILITY OR ITS FITNESS FOR ANY PARTICULAR 
PURPOSE. THE EXCLUSION OF IMPLIED WARRANTIES IS NOT PERMITTED BY SOME STATES. THE ABOVE EXCLUSION 
MAY NOT APPLY TO YOU. THIS WARRANTY PROVIDES YOU WITH SPECIFIC LEGAL RIGHTS. THERE MAY BE OTHER 
RIGHTS THAT YOU MAY HAVE WHICH VARY FROM STATE TO STATE.

The following disclaimer is required by Sam Leffler and Silicon Graphics, Inc. for the use of their TIFF library:
Copyright © 1988–1997 Sam Leffler 
Copyright © 1991–1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software [i.e., the TIFF library] and its documentation for any purpose is 
hereby granted without fee, provided that (i) the above copyright notices and this permission notice appear in all copies of the 
software and related documentation, and (ii) the names of Sam Leffler and Silicon Graphics may not be used in any advertising or 
publicity relating to the software without the specific, prior written permission of Sam Leffler and Silicon Graphics.

THE SOFTWARE IS PROVIDED “AS-IS” AND WITHOUT WARRANTY OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, 
INCLUDING WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR 
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR 
PROFITS, WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE, AND ON ANY THEORY OF LIABILITY, ARISING 
OUT OF OR IN CONNECTION WITH THE USE OR PERFORMANCE OF THIS SOFTWARE.

The following disclaimer is required by the Independent JPEG Group:
This software is based in part on the work of the Independent JPEG Group.

This Software may contain components licensed under the following conditions:
Copyright (c) 1989 The Regents of the University of California. All rights reserved. 

Redistribution and use in source and binary forms are permitted provided that the above copyright notice and this paragraph are 
duplicated in all such forms and that any documentation, advertising materials, and other materials related to such distribution and 
use acknowledge that the software was developed by the University of California, Berkeley. The name of the University may not be 
used to endorse or promote products derived from this software without specific prior written permission. THIS SOFTWARE IS 
PROVIDED ``AS IS'' AND WITHOUT ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT LIMITATION, THE 
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 

Copyright (C) 1989, 1991 by Jef Poskanzer. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

Copyright 1995, Trinity College Computing Center. Written by David Chappell. 

Permission to use, copy, modify, and distribute this software and its documentation for any purpose and without fee is hereby 
granted, provided that the above copyright notice appear in all copies and that both that copyright notice and this permission notice 
appear in supporting documentation. This software is provided "as is" without express or implied warranty. 

http://www.avid.com/US/about-avid/legal-notices/patent-marking
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Copyright 1996 Daniel Dardailler. 

Permission to use, copy, modify, distribute, and sell this software for any purpose is hereby granted without fee, provided that the 
above copyright notice appear in all copies and that both that copyright notice and this permission notice appear in supporting 
documentation, and that the name of Daniel Dardailler not be used in advertising or publicity pertaining to distribution of the software 
without specific, written prior permission. Daniel Dardailler makes no representations about the suitability of this software for any 
purpose. It is provided "as is" without express or implied warranty. 

Modifications Copyright 1999 Matt Koss, under the same license as above. 

Copyright (c) 1991 by AT&T. 

Permission to use, copy, modify, and distribute this software for any purpose without fee is hereby granted, provided that this entire 
notice is included in all copies of any software which is or includes a copy or modification of this software and in all copies of the 
supporting documentation for such software. 

THIS SOFTWARE IS BEING PROVIDED "AS IS", WITHOUT ANY EXPRESS OR IMPLIED WARRANTY. IN PARTICULAR, 
NEITHER THE AUTHOR NOR AT&T MAKES ANY REPRESENTATION OR WARRANTY OF ANY KIND CONCERNING THE 
MERCHANTABILITY OF THIS SOFTWARE OR ITS FITNESS FOR ANY PARTICULAR PURPOSE.

This product includes software developed by the University of California, Berkeley and its contributors.

The following disclaimer is required by Nexidia Inc.:
© 2010 Nexidia Inc.  All rights reserved, worldwide.  Nexidia and the Nexidia logo are trademarks of Nexidia Inc. All other 
trademarks are the property of their respective owners.  All Nexidia materials regardless of form, including without limitation, 
software applications, documentation and any other information relating to Nexidia Inc., and its products and services are the 
exclusive property of Nexidia Inc. or its licensors.  The Nexidia products and services described in these materials may be covered 
by Nexidia's United States patents: 7,231,351; 7,263,484; 7,313,521; 7,324,939; 7,406,415, 7,475,065; 7,487,086 and/or other 
patents pending and may be manufactured under license from the Georgia Tech Research Corporation USA. 

The following disclaimer is required by Paradigm Matrix:
Portions of this software licensed from Paradigm Matrix.

The following disclaimer is required by Ray Sauers Associates, Inc.:
“Install-It” is licensed from Ray Sauers Associates, Inc. End-User is prohibited from taking any action to derive a source code 
equivalent of “Install-It,” including by reverse assembly or reverse compilation, Ray Sauers Associates, Inc. shall in no event be liable 
for any damages resulting from reseller’s failure to perform reseller’s obligation; or any damages arising from use or operation of 
reseller’s products or the software; or any other damages, including but not limited to, incidental, direct, indirect, special or 
consequential Damages including lost profits, or damages resulting from loss of use or inability to use reseller’s products or the 
software for any reason including copyright or patent infringement, or lost data, even if Ray Sauers Associates has been advised, 
knew or should have known of the possibility of such damages.

The following disclaimer is required by Videomedia, Inc.:
“Videomedia, Inc. makes no warranties whatsoever, either express or implied, regarding this product, including warranties with 
respect to its merchantability or its fitness for any particular purpose.”

“This software contains V-LAN ver. 3.0 Command Protocols which communicate with V-LAN ver. 3.0 products developed by 
Videomedia, Inc. and V-LAN ver. 3.0 compatible products developed by third parties under license from Videomedia, Inc. Use of this 
software will allow “frame accurate” editing control of applicable videotape recorder decks, videodisc recorders/players and the like.” 

The following disclaimer is required by Altura Software, Inc. for the use of its Mac2Win software and Sample Source 
Code:
©1993–1998 Altura Software, Inc.

The following disclaimer is required by Ultimatte Corporation:
Certain real-time compositing capabilities are provided under a license of such technology from Ultimatte Corporation and are 
subject to copyright protection.

The following disclaimer is required by 3Prong.com Inc.:
Certain waveform and vector monitoring capabilities are provided under a license from 3Prong.com Inc.

The following disclaimer is required by Interplay Entertainment Corp.:
The “Interplay” name is used with the permission of Interplay Entertainment Corp., which bears no responsibility for Avid products.

This product includes portions of the Alloy Look & Feel software from Incors GmbH.
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This product includes software developed by the Apache Software Foundation (http://www.apache.org/).

© DevelopMentor

This product may include the JCifs library, for which the following notice applies:
JCifs © Copyright 2004, The JCIFS Project, is licensed under LGPL (http://jcifs.samba.org/). See the LGPL.txt file in the Third Party 
Software directory on the installation CD.

Avid Interplay contains components licensed from LavanTech. These components may only be used as part of and in connection 
with Avid Interplay.

Attn. Government User(s). Restricted Rights Legend
U.S. GOVERNMENT RESTRICTED RIGHTS. This Software and its documentation are “commercial computer software” or 
“commercial computer software documentation.” In the event that such Software or documentation is acquired by or on behalf of a 
unit or agency of the U.S. Government, all rights with respect to this Software and documentation are subject to the terms of the 
License Agreement, pursuant to FAR §12.212(a) and/or DFARS §227.7202-1(a), as applicable.

Trademarks
003, 192 Digital I/O, 192 I/O, 96 I/O, 96i I/O, Adrenaline, AirSpeed, ALEX, Alienbrain, AME, AniMatte, Archive, Archive II, Assistant 
Station, AudioPages, AudioStation, AutoLoop, AutoSync, Avid, Avid Active, Avid Advanced Response, Avid DNA, Avid DNxcel, Avid 
DNxHD, Avid DS Assist Station, Avid Ignite, Avid Liquid, Avid Media Engine, Avid Media Processor, Avid MEDIArray, Avid Mojo, Avid 
Remote Response, Avid Unity, Avid Unity ISIS, Avid VideoRAID, AvidRAID, AvidShare, AVIDstripe, AVX, Beat Detective, Beauty 
Without The Bandwidth, Beyond Reality, BF Essentials, Bomb Factory, Bruno, C|24, CaptureManager, ChromaCurve, 
ChromaWheel, Cineractive Engine, Cineractive Player, Cineractive Viewer, Color Conductor, Command|24, Command|8, 
Control|24, Cosmonaut Voice, CountDown, d2, d3, DAE, D-Command, D-Control, Deko, DekoCast, D-Fi, D-fx, Digi 002, Digi 003, 
DigiBase, Digidesign, Digidesign Audio Engine, Digidesign Development Partners, Digidesign Intelligent Noise Reduction, 
Digidesign TDM Bus, DigiLink, DigiMeter, DigiPanner, DigiProNet, DigiRack, DigiSerial, DigiSnake, DigiSystem, Digital 
Choreography, Digital Nonlinear Accelerator, DigiTest, DigiTranslator, DigiWear, DINR, DNxchange, Do More, DPP-1, D-Show, DSP 
Manager, DS-StorageCalc, DV Toolkit, DVD Complete, D-Verb, Eleven, EM, Euphonix, EUCON, EveryPhase, Expander, 
ExpertRender, Fader Pack, Fairchild, FastBreak, Fast Track, Film Cutter, FilmScribe, Flexevent, FluidMotion, Frame Chase, FXDeko, 
HD Core, HD Process, HDpack, Home-to-Hollywood, HYBRID, HyperSPACE, HyperSPACE HDCAM, iKnowledge, Image 
Independence, Impact, Improv, iNEWS, iNEWS Assign, iNEWS ControlAir, InGame, Instantwrite, Instinct, Intelligent Content 
Management, Intelligent Digital Actor Technology, IntelliRender, Intelli-Sat, Intelli-sat Broadcasting Recording Manager, InterFX, 
Interplay, inTONE, Intraframe, iS Expander, iS9, iS18, iS23, iS36, ISIS, IsoSync, LaunchPad, LeaderPlus, LFX, Lightning, Link & 
Sync, ListSync, LKT-200, Lo-Fi, MachineControl, Magic Mask, Make Anything Hollywood, make manage move | media, Marquee, 
MassivePack, Massive Pack Pro, Maxim, Mbox, Media Composer, MediaFlow, MediaLog, MediaMix, Media Reader, Media 
Recorder, MEDIArray, MediaServer, MediaShare, MetaFuze, MetaSync, MIDI I/O, Mix Rack, Moviestar, MultiShell, NaturalMatch, 
NewsCutter, NewsView, NewsVision, Nitris, NL3D, NLP,  NSDOS, NSWIN,  OMF, OMF Interchange, OMM, OnDVD, Open Media 
Framework, Open Media Management,  Painterly Effects, Palladium, Personal Q, PET, Podcast Factory, PowerSwap, PRE, 
ProControl, ProEncode, Profiler, Pro Tools, Pro Tools|HD, Pro Tools LE, Pro Tools M-Powered, Pro Transfer, QuickPunch, 
QuietDrive, Realtime Motion Synthesis, Recti-Fi, Reel Tape Delay, Reel Tape Flanger, Reel Tape Saturation, Reprise, Res Rocket 
Surfer, Reso, RetroLoop, Reverb One, ReVibe, Revolution, rS9, rS18, RTAS, Salesview, Sci-Fi, Scorch, ScriptSync, 
SecureProductionEnvironment, Serv|GT, Serv|LT,  Shape-to-Shape, ShuttleCase, Sibelius, SimulPlay, SimulRecord, Slightly Rude 
Compressor, Smack!, Soft SampleCell, Soft-Clip Limiter, SoundReplacer, SPACE, SPACEShift, SpectraGraph, SpectraMatte, 
SteadyGlide, Streamfactory, Streamgenie, StreamRAID, SubCap, Sundance, Sundance Digital, SurroundScope, Symphony, SYNC 
HD, SYNC I/O, Synchronic, SynchroScope,  Syntax, TDM FlexCable, TechFlix, Tel-Ray, Thunder, TimeLiner, Titansync, Titan, TL 
Aggro, TL AutoPan, TL Drum Rehab, TL Everyphase, TL Fauxlder, TL In Tune, TL MasterMeter, TL Metro, TL Space, TL Utilities, 
tools for storytellers, Transit, TransJammer, Trillium Lane Labs, TruTouch, UnityRAID, Vari-Fi, Video the Web Way, VideoRAID, 
VideoSPACE, VTEM, Work-N-Play, Xdeck, X-Form, Xmon and XPAND! are either registered trademarks or trademarks of Avid 
Technology, Inc. in the United States and/or other countries.
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Using This Guide

Congratulations on your purchase of the Avid Motion Graphics Server. This server is the 
foundation for reliable, high-productivity media production. It is designed for media facilities 
and broadcasters using the industry's most proven real-time storage software technology, 
delivering stable operation, high performance media access, and class-leading value. From 
character generation to full 3D animations, customers can create stunning imagery with a 
complete next-generation creative toolset, featuring an advanced 2D/3D real-time rendering 
engine accelerated by the latest GPU technology.

This guide contains all the task-oriented instructions, conceptual information, and reference 
material you need to setup and configure your new server. It is intended for use by those 
responsible for setup and configuration of the Avid Motion Graphics Server in your facility.

Unless noted otherwise, the material in this document applies to the Windows 7 operating 
system.The screen shots in this document were captured on a Windows 7 system.

n This document describes all the features available for the Avid Motion Graphics Server. 
Depending on your particular configuration, your system might not contain certain features that 
are covered in this documentation.

If You Need Help
If you are having trouble using your Avid product:

1. Retry the action, carefully following the instructions given for that task in this guide. It is 
especially important to check each step of your workflow.

2. Check the latest information that might have become available after the documentation was 
published.

New information would be found in the ReadMe file available online.

You should always check online for the most up-to-date release notes or ReadMe 
because the online version is updated whenever new information becomes available. To 
view the online versions, visit the Knowledge Base at www.avid.com/US/support.

3. Check the documentation that came with your Avid application or your hardware for 
maintenance or hardware-related issues.

4. Visit the online Knowledge Base at www.avid.com/US/support. Online services are 
available 24 hours per day, 7 days per week. Search this online Knowledge Base to find 
answers, to view error messages, to access troubleshooting tips, to download updates, and to 
read or join online message-board discussions.

http://www.avid.com/US/support
http://www.avid.com/US/support
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Accessing the Online Documentation

The Avid Motion Graphics online documentation contains all the product documentation in PDF 
format. You can access the documentation in the Avid Motion Graphics Documentation folder 
on the Avid Motion Graphics installer device. 

n You need to download and install Acrobat Reader on your Avid Motion Graphics Server before 
you can access the PDF documentation.

To access the online documentation from the installer device:

1. Insert your Avid Motion Graphics USB flash drive (UFD) with the Avid Motion Graphics 
software into the USB port.

2. Navigate to the Avid Motion Graphics Documentation folder, and double-click the PDF file 
for the document you want to view.



1 Avid Motion Graphics Overview

Avid Motion Graphics solutions integrate industry-leading broadcast graphics systems and live 
production servers with both the newsroom and broadcast production. The result is facility-wide 
access to branded visual templates and elements—from traffic to the promotions department to 
the journalists—and a more consistent and competitive channel identity in all news, sports and 
entertainment programming.

Depending on your configuration, your Avid Motion Graphics Server might not contain certain 
features and hardware that are covered in this document. Information that applies to a specific 
model is specified as such. This document is intended for use during initial setup and installation 
and may also be useful for system maintenance or troubleshooting.

The following main topics are described in this chapter:

• Product Suite

• Unpacking a New System

• Avid Motion Graphics Hardware

• Avid Motion Graphics Server Front

• Avid Motion Graphics Server Rear Panel

• Checklist: Pre-Installation Preparations
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Product Suite
The Avid Motion Graphics platform is built on a powerful rendering engine that lets everyone 
involved in graphics development make the most of their media. The product suite provides a 
foundation for a variety of applications, including news, sports, live events, post production, and 
channel branding. In addition, Avid Motion Graphics has a variety of tools and plug-ins that 
extend it’s capabilities. The following table describes the different Avid Motion Graphics 
applications.

Application Description

Avid Motion Graphics Avid Motion Graphics is one of three Avid Motion Graphics 
design applications. It is geared towards the high-end broadcast 
graphics designer who needs to produce differentiated broadcast 
graphics with the highest production value. This application has a 
state-of-the-art feature set allowing for advanced, real-time 
2D/3D graphics creation and playout, integrations with common 
workflows and infrastructure, turn-key or distributed hardware 
and control architecture. It also has support for Deko graphics.

Avid Motion Graphics Production Avid Motion Graphics Production is one of three Avid Motion 
Graphics design applications. It is for broadcast graphics 
designers who need a cost-effective, easy to use, graphics solution 
with a w/ 2D/3D production capabilities. This application allows 
simplified real-time 2D/3D creation, and playout with basic 
effects, turn-key or distributed hardware and control architecture, 
and including support for Deko graphics.

Avid Motion Graphics Creation Avid Motion Graphics Creation is one of three Avid Motion 
Graphics design applications. It is for graphics departments where 
graphics designers need separate graphics creation for later 
playout. They can import and edit third-party graphics objects 
using the full Avid Motion Graphics feature set for creation in a 
software only package, which can be installed on a laptop with a 
powerful graphics card and plenty of memory. This application 
includes the Clips and Stereoscopic options and has support for 
Deko graphics.

Avid License Control Must be installed on any computer with a licensed component. 
For instance, the servers pass licenses to Journalist clients and 
News Control Clients. 

Installed on the Avid Motion Graphics computer, Avid Motion 
Graphics Journalist Server, Avid Motion Graphics Preview 
Renderer, and any Computers running 3DS, Photoshop, MAP or 
Avid Motion Graphics Control.
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AMG Advanced Device Manager Used for the iNEWS Command workflow or Automation and is 
installed on the Avid Motion Graphics Server.

Avid Motion Graphics Control Avid Motion Graphics Control is for non-newsroom graphics and 
control room operators. For those who need to control sequenced 
or non-sequenced graphics, and need the ability to adjust graphics 
on-the-fly. This application provides full graphics control for 
playout flexibility. It is installed with Avid Motion Graphics or on 
a separate 3rd party system.

Avid Motion Graphics Font Package Allows use of graphics previously created in Deko and users can 
create new graphics using fonts from this package in Avid Motion 
Graphics too.Installed on the Avid Motion Graphics Server.

AMG Transcode AMG Transcode is an application that allows you to convert from 
multiple types of clips into a known usable format, which allows 
playback in real-time and has aligned audio.

Deko Translator The DekoTranslator is an application that allows you to utilize 
your existing Deko Graphics assets and convert them into native 
AMG Compositions. DekoTranslator is a standalone application 
not requiring AMG or Deko to be installed to work correctly. 
However, to confirm that the all the assets required to process the 
Deko Graphics are available, you need some version of the Deko 
application. It is recommended that you use a single computer that 
has a version of both Deko and AMG installed.

Deko Chart Designer Allows use of Deko graphics previously created with Deko Chart 
Designer. Installed on the computer running Avid Motion 
Graphics with Deko Player or Deko Translator.

Deko Player Deko Player is a component of Avid Motion Graphics that allows 
you to easily play your existing Deko graphics to air.

Avid Motion Graphics Journalist Avid Motion Graphics Journalist is for the journalists who need 
template graphics for easy fulfillment of data.This application 
allows for use of the NRCS Integrated MOS plug-in along with 
flexibility in determining the level of functionality that journalists 
are exposed to for fulfillment of graphics data and adjustment of 
templates. Avid Motion Graphics News Control is also part of this 
installer.

Application Description (Continued)
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Unpacking a New System

When you first receive a new Avid Motion Graphics system, it is important to carefully unpack 
and verify the condition of the components received.

The following main topics describe: 

• Opening the Shipping Container

• Verifying Components

• Inspecting Components for Damage

Opening the Shipping Container

Before unpacking your new system, make sure the location is free of clutter and dust. Also, make 
sure you have a power source and a VGA monitor nearby.

When opening and unpacking the box, follow the diagram on the side of the cardboard shipping 
container. The diagram shows how the foam and inner cartons and boxes were packaged.

n This information is helpful in the event that Customs officials need to unpack the system to 
inspect the serial number of the unit, or if you need to return the unit to Avid.

To unpack a new system:

1. Remove all of the boxes, including the rack rails and lay them out so you can verify that you 
have received all of the components that should have been shipped

2. After all of the boxes and components are unpacked, visually inspect the enclosure to make 
sure it is free of any scratches, dents or other types of visible damage.

Avid Motion Graphics News Control Avid Motion Graphics News Control is designed for the news 
graphics operators who need graphics rundown automation with 
manual control. This application allows for automated graphics 
playout connected to the NRCS rundown, on-the-fly graphics 
adjustment, and third-party production automation integration. 
This application is part of the Avid Motion Graphics Journalist 
installer.

Avid Motion Graphics Operations 
Control

Avid Motion Graphics Operations Control provides a central 
mechanism for users to manage, diagnose and monitor all 
configured AMG render engines from a single interface.

Application Description (Continued)
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3. Ensure there are straight connectors on the back, and that the power-supply securing screws 
are not bent.

4. Verify that you have received all of the components particular to your order.You should get 
between 3-5 boxes for each unit.

n Keep the shipping boxes that come with your Avid Motion Graphics hardware in case you should 
ever need to repackage and ship the components in the future. If you are unpacking multiple 
systems, ensure that you keep the box of media drives with the original AMG system. Mixing the 
drives between AMG servers causes RAID import problems. This could result in needing to 
rebuild the raid configuration, which is a lengthy (8 hour) process.

Verifying Components

After unpacking everything, verify that you have all of the items or components that are listed on 
the packing slip. Each item is marked with a part number appears as a line item on the packing 
slip. If you are missing any of the items listed on your packing slip, contact Avid before 
proceeding.

Inspecting Components for Damage

After verifying that all of your components have been received, you must also ensure that they 
are not damaged.

To inspect components for damage:

1. Visually inspect all of the hardware components to ensure none of them were damaged 
during shipping.

2. If you received a hardware component that was damaged, contact Avid Customer Support or 
your Avid sales representative before proceeding.
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Avid Motion Graphics Hardware

The Avid Motion Graphics Server uses industry standard components to deliver high capacity, 
high performance collaborative media solutions. A single Avid Motion Graphics enclosure is 
comprised of five 1 TB media storage drives, two mirrored system drives, RAID controller, 
Gigabit Ethernet, plus redundant power and fans.

Avid Motion Graphics Server assures media protection and availability using the following:

• Mirrored system drives are used for system operation.

• Media drive replacement without interrupting the operation of the Avid Motion Graphics 
Server.

• Data drives configured into one RAID 5 group.

n If any of the RAID drives fail, the failed drive can be removed and replaced with a new drive 
without interrupting the operation of the Avid Motion Graphics Server.

The Avid Motion Graphics Server uses the Windows® 7 Ultimate operating system. The 
Windows Product Key Certificate of Authenticity is attached to the top cover of the Avid Motion 
Graphics Server enclosure, as shown in the following illustration. You only need this product key 
in the event that you need to reinstall the operating system.
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Avid Motion Graphics Server Front

The Avid Motion Graphics Server comes with an Avid bezel that covers the front of the 
enclosure. This bezel can be locked to prevent unauthorized personnel from accessing the 
buttons and data drives. Two keys are required to unlock and remove the bezel from the server. 
The keys are used at the same time in the lock on each side of the bezel. A total of three 
interchangeable keys are shipped with the server and are found wrapped with the bezel in the 
box.
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The following is an illustration of the Avid Motion Graphics Server enclosure with the front 
bezel installed.

The front of the single-channel Avid Motion Graphics Server provides access to 5 data drives 
(dual-channel AMG servers have 10 data drives), a USB port, network port activity LEDs, an 
error LED, and the Power and Reset buttons. The following is an illustration with the front bezel 
removed and the data drives installed. The data drives are shipped separately and must be 
installed in the server. For more information, see, “Installing the RAID Drives” on page 43. In 
the following illustration, the drives are numbered showing the locations where the data drives 
are installed. Single channel AMG servers only contain five drives (shown in the illustration as 
drives 12-16). Dual channel AMG servers contain a total of 10 drives (shown in the illustration 
as drives 7-16). 

n The actual drives are not numbered.
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Each of the data drives have a blue and red LED on the bottom front of the drive. The left LED 
(blue) is on when a drive has power and flashes when the drive is in use.

The following table describes the parts of the data drive.

The right Fault LED (red) is lit when an error is detected with the drive and the drive needs to be 
replaced, or when the drive is initializing. Details on the data drive LED indicators are in the 
following table.

 3
 4

21

mp

Item Number Description

1 Drive Carrier Latch

2 Drive Lock

3 Fault LED (Red)

4 LED (Blue) Power/Activity 

Data Drive LED Functions  

Drive State Blue LED Red LED Comments

Online Inactive On solid Off Healthy online drive, 
no disk I/O

On-line Active Activity Off Healthy online drive, 
with disk I/O

Online Disk in a 
Degraded Set

On solid/
Activity

Fast flashing Nothing needs to be done to these online 
drives, but failed drive should be replaced

Spare Rebuilding Activity Slow flashing Rebuild automatically occurs on drive 
failure when new drive is installed

Data Rebuilding Activity Fast flashing Rebuild automatically occurs on drive 
failure when new drive is installed

Consistency Check Activity Off No user intervention required
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Server Controls and LEDs

The server has 8 LEDs on the top of the front panel, under the bezel, organized into two rows, 
each row with four LEDs. The first 3 columns of LEDs (6 LEDs) represent activity on each of 
the six network ports. The top right LED represents system hardware errors. The bottom right 
LED represents system drive activity. The following illustration shows the front server controls 
and LEDs.

Initializing Activity Off Happens on initial array creation

Failed Data Disk On solid On solid Disk performance degraded, should 
replace disk

Unused Disk On solid Off No user intervention required

Non-Branded On solid Slow flashing Unapproved disk attempting to be added, 
should replace disk

Data Drive LED Functions (Continued)  

Drive State Blue LED Red LED Comments
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The following table describes the control panel shown in the previous illustration.

item Number Control Description

1 Universal serial bus (USB) 
port

USB 2.0 device port on the front of the system supports one USB 
device. Recommended for use when re-imaging the system drives or 
loading software. There are four more USB ports located on the back 
of the server. Two of them are located on the server itself and can be 
used for a USB Keyboard and Mouse. There are also two located on 
the USB/PS2 expansion card.

2 Halt button This button is not implemented in the current release of this product.

3 System reset button Performs a soft reset when pressed. Do not use this button unless the 
system has had a fatal error and you need to restart. A soft reset restarts 
the system; it clears all active program memory (you lose unsaved 
work) and shuts down all active programs.

4 Six green network activity 
LEDs

Illuminates green when a good network connection is established and 
blinks when there is network activity on the six built-in 1-GB network 
ports. The number beside the LED corresponds with the number beside 
the network port on the rear of the enclosure.

5 Red System error LED Illuminates red when an error is detected with the system (fan, power 
supply, temperature, voltage).

6 System Drive activity LED Indicates drive activity from the onboard SATA controller and blinks 
when either of the system drives is being accessed.

7 System ID button When pressed, it illuminates blue and also illuminates an LED on the 
rear of the enclosure. The rear LED is also blue and is on the lower 
left-hand side of the Ethernet ports. It is used to identify a system for 
servicing when it is installed in a high-density rack/cabinet populated 
with several other similar systems.

8 Power button Press to power on the enclosure. Power button illuminates green when 
the power is on.

9 Control panel located on the front of the server under the bezel.



Avid Motion Graphics Server Front

24

Drive Array and Slot Locations (Single Channel Servers)

For single channel AMG servers, one RAID 5 group is created in the Avid Motion Graphics 
Server enclosure using the 5 data drives.

The single channel Avid Motion Graphics Server provides 5 TB of storage. The numbers 
assigned to the slots and the group numbers are not displayed in the Avid Motion Graphics 
Server software. These numbers and groups are only displayed in the LSI MegaRAID Storage 
Manager. For more information about installing drives, see “Installing the RAID Drives” on 
page 43.

n The LSI MegaRAID Storage Manager is a RAID utility that allows for viewing and management 
of disks in your media array. If your Avid Motion Graphics server OS image is later than version 
4, it will not have the LSI MegaRAID Storage Manager software pre-installed. Earlier Avid 
Motion Graphics software versions had this software pre-installed on the server. 

Therefore, if your system does not have it installed, you must install the LSI MegaRAID Storage 
Manager software yourself in order to view and manage the system. For more information on 
installing the LSI software, see “Install the LSI MegaRAID Storage Manager Software” on 
page 61.

For information on using the LSI MegaRAID Storage Manager software to view and manage 
your media drives, see the relevant topics later in this guide.

The RAID group 0 is configured with drives 12 - 16.

Drive Array and Slot Locations (Dual Channel Servers)

For dual channel AMG servers, two RAID 5 groups are created in the Avid Motion Graphics 
Server enclosure using the 10 data drives.

The dual-channel Avid Motion Graphics Server provides 10 TB of storage. The numbers 
assigned to the slots and the group numbers are not displayed in the Avid Motion Graphics 
Server software. These numbers and groups are only displayed in the LSI MegaRAID Storage 
Manager. For more information about installing drives, see “Installing the RAID Drives” on 
page 43.

Blank Blank Blank 13 — RAID Group 0

Blank Blank Blank 14 — RAID Group 0

Blank Blank Blank 15 — RAID Group 0

Blank Blank 12 — RAID Group 0 16 — RAID Group 0
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n The LSI MegaRAID Storage Manager is a RAID utility that allows for viewing and management 
of disks in your media array. If your Avid Motion Graphics server OS image is later than version 
4, it will not have the LSI MegaRAID Storage Manager software pre-installed. Earlier Avid 
Motion Graphics software versions had this software pre-installed on the server. 

Therefore, if your system does not have it installed, you must you must install the LSI MegaRAID 
Storage Manager software yourself in order to view and manage the system. For more 
information on installing the LSI software, see “Install the LSI MegaRAID Storage Manager 
Software” on page 61.

For information on using the LSI MegaRAID Storage Manager software to view and manage 
your media drives, see the relevant topics later in this guide.

For dual channel AMG servers, the RAID groups are as follows:

• The RAID group 0 is configured with drives 12 - 16.

• The RAID group 1 is configured with drives 7 - 11.

RAID Behavior 

Once the RAID group has been created, any of the drives in the server can be swapped within the 
enclosure. The Avid Motion Graphics Server uses the drive IDs to track what drives are members 
of the RAID group.

Blank Blank 9 — RAID Group 1 13 — RAID Group 0

Blank Blank 10 — RAID Group 1 14 — RAID Group 0

Blank 7 — RAID Group 1 11 — RAID Group 1 15 — RAID Group 0

Blank 8 — RAID Group 1 12 — RAID Group 0 16 — RAID Group 0
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Avid Motion Graphics Server Rear Panel

The rear panel provides access to the power supplies, system drives, 1 gigabit (Gb) Ethernet 
connectors, RS232 Serial Port, and two USB connectors for the standard or USB keyboard and 
mouse provided with the server. 

If you purchased an AMG keyboard, you can connect it to one of the USB ports.

The AMG Server has two power supply modules that set the voltage automatically for either 
100 V or 240 V at 50 to 60 Hz.

• Data drives — The single-channel Avid Motion Graphics Server enclosure has five 1TB, 
externally accessible, data drives located on the front side of the server. The dual-channel 
Avid Motion Graphics Server enclosure has ten 1TB, externally accessible, data drives 
located on the front side of the server. 

• System drives — The Avid Motion Graphics Server uses two externally accessible, mirrored 
system drives for the operating system and application software, located on the back of the 
server.

n The following illustration shows the rear configuration of a dual channel Avid Motion Graphics 
Server.
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The following table describes the back of the Avid Motion Graphics Server.

Item Number Description

1 Power Connector

2 Power Connector

3 Mirrored System Drives

4 Intel Pro 1Gb Ethernet Ports

5 USB Ports (Recommended for use with Keyboard and Mouse)

6 Video Port (disabled)

7 Serial Port - RS232

8 Serial Card - RS422

9 VGA Adapter - used for KVM or VGA Monitor

10 Breakout Panel Interconnect

11 HDMI Preview Port - used for Breakout Panel Preview Monitor

12 Video I/O Card Supports Connection to the Output Program Monitor Through the 
Breakout box

13 (Dual Channel only) VGA Adapter - not used

14 (Dual Channel only) 2nd Breakout Panel Interconnect

15 (Dual Channel only) HDMI Preview Port used for the 2nd Breakout Panel 
Interconnect to the Preview Monitor

16 (Dual Channel only) Video I/O Card Supports Connection to the Output Program 
Monitor Through the Breakout box

17 USB Ports

18 PCI Card with PS/2 and USB Ports
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Expansion Slots

There are six expansion slots accessible from the rear of the Avid Motion Graphics Server 
enclosure. 

n For Single-channel model servers, slots 4 and 5 are blank. 

When upgrading a single-channel AMG server to a dual-channel AMG server, you must install 
the additional boards in slots 4 and 5. For more information, see “Upgrading Your AMG Server 
Hardware to Dual Channel” on page 167.
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The following table lists the standard boards and the expansion slots that are supported for both 
the single and dual-channel AMG Server models.

Item PCI Slot Interface Description

1 Serial Card SeaLevel® 7205eS PCI 
Express serial interface

The Sealevel 7205eS PCI Express serial interface 
provides two serial ports configurable for RS-232 
or RS-422. Each serial port utilizes a 16C950 
UART with 128-byte Tx/Rx FIFOs which enables 
data rates to 921.6K bps for reliable high-speed 
communications in data intensive applications, 
such as automation-type. An expansion cable is 
included, shipped with the server.

2 PCI-E x16 NVidia® Quadro 4000 
VGA board

The NVidia Quadro 4000 VGA board is installed 
in the second PCI-E x16 connector on the Avid 
Motion Graphics Server.

3 PCI-E x4 AJA Kona 3G Video I/O 
board

The AJA Kona 3G Video I/O board is installed in 
the third PCI-E x4 connector. 

4 N/A for single 
channel servers

PCI-E x16 for 
Dual channel 
servers

(For Dual channel servers 
only):

NVidia® Quadro 4000 
VGA board

This slot is not populated for single channel 
servers. However, this slot can be used to install a 
GPI card.

For Dual channel servers, the NVidia Quadro 
4000 VGA board is installed in the fourth PCI-E 
x16 connector on the Avid Motion Graphics 
Server.

5 N/A for single 
channel servers

PCI-E x4 for 
Dual channel 
servers

(For Dual channel servers 
only):

AJA Kona 3G Video I/O 
board

This slot is not populated for single channel 
servers. However, this slot can be used to install a 
GPI card.

For Dual channel servers, the AJA Kona 3G 
Video I/O board is installed in the fifth PCI-E x4 
connector. 

6 USB/PCI Card Allows for 2 USB connections.

In dual channel AMG servers that want for GPI 
connectivity, the USB/PCI card can be removed, 
and the slot can be populated with a Sealevel 
BD8004 or 8012 model GPI card. 

Avid does not supply the GPI card. 

Check the latest Avid Motion Graphics ReadMe 
for further details. 
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System Drives

There are two system drives accessible from the rear of the enclosure. These two drives are 
mirrored and if a failure occurs on either one of the system drives, you can pull the failed drive 
out of the enclosure and install a replacement drive without turning off the Avid Motion Graphics 
Server. 

n The drive carriers for the system drives are locked to prevent them from opening during 
shipment. The plastic drive carrier key is mounted on the rear of the enclosure beside the system 
drives, as shown in the following illustration.

Power Supplies

There are two power supplies accessible from the rear of the Avid Motion Graphics Server 
enclosure. If a failure occurs on either one of the power supplies, you can pull the failed power 
supply out of the enclosure and install a replacement power supply without turning off the 
Server. All operations continue to run uninterrupted. A faint beeping sound can be heard when 
there is a power supply failure. This sound is silenced by restoring the power or replacing the 
module.

Mirrored System drives
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USB Ports

There are four USB ports located on the rear of the Avid Motion Graphics Server. Avid 
recommends using the USB ports, located on the expansion card containing the PS/2 
connections, for USB devices.

If your AMG playout chassis is dual channel, and you want to install GPI functionality in the 
chassis, the USB PCI card must be removed from the AMG playout chassis, and replaced with 
the GPI card. 

n Doing so, reduces the number of available USB ports to two, and completely removes any PS/2 
connectivity to your server.

The following illustration shows the rear USB and PS/2 ports on the Avid Motion Graphics 
Server.

The illustration depicts a single-channel model Avid Motion Graphics server.

The following table describes the USB and PS/2 ports on the Avid Motion Graphics Server.
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Item Number Description

1 These USB Ports are recommended for use with your Keyboard and mouse

2 Available USB Ports

3 PS/2 Ports
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USB Devices and License Activation ID

There two USB devices, one for software application installation and one that contains the AMG 
Drive recovery image.

The software license is provided on an Activation ID. Depending on your specific configuration 
you may receive more than one Activation ID card. The card ships in a box separately from the 
server and could potentially be in a box with another product that might be unrelated to the Avid 
Motion Graphics system, if you have purchased multiple products on the same order. 

Below is an example of a AMG System ID/ Activation ID card:
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Checklist: Pre-Installation Preparations

Before you start to install software and configure the Avid Motion Graphics Server, ensure the 
following tasks are completed.

Checked Tasks Refer to...

 Unpack your system For more information, see “Unpacking a New 
System” on page 16.

 Verify System components 
against your packing slip

For more information, see “Verifying Components” 
on page 17.

 Inspect components for damage For more information, see “Inspecting Components 
for Damage” on page 17.

 Rack mount the system and attach 
peripherals.

For more information, see “Installing the AMG 
Server in a Rack” on page 34.

 Install RAID Drives For more information, see “Installing the RAID 
Drives” on page 43.

 Configure hardware (reference, 
video, & audio)

For more information, see “Rack Mounting and 
Cabling Your Server” on page 34.

 Connect the Breakout box For more information, see “Installing the Breakout 
Box” on page 44.

 Cable the AMG server For more information, see “Cabling Avid Motion 
Graphics” on page 46.

 Connecting power cord and other 
cables

For more information, see “Connecting Power 
Cords to the AMG Server” on page 58.

 Starting the AMG server For more information, see “Powering on Avid 
Motion Graphics” on page 59.

 Configure your Network and 
Operating System Settings

For more information, see “Network and Operating 
System Settings” on page 59.

 Install the AMG and Related 
Software

For more information, see “Software Installation” 
on page 65.

 Activate Licenses For more information, see “Software Licensing” on 
page 83.



2 Rack Mounting and Cabling Your Server

The following describes how to rack mount and cable your Avid Motion Graphics server. It 
includes information about attaching peripherals, connecting the AMG keyboard, serial 
connections, and network protection.

The following main topics describe: 

• Installing the AMG Server in a Rack

• Installing the RAID Drives

• Installing the Breakout Box

• Cabling Avid Motion Graphics

• Connecting Power Cords to the AMG Server

• Powering on Avid Motion Graphics

• Network and Operating System Settings

Installing the AMG Server in a Rack

The Avid Motion Graphics Server is designed for 19-inch (483-mm) racks and requires three 
EIA rack units (3U), or 5.25 inches (133.4 mm) of rack space. The rail kit installs into rails that 
are between 23-inches (584.2-mm) to 31-inches (787.4-mm) inches deep. 

The Avid Motion Graphics Server includes rack mounting slide rails. If instructions are included 
with your rail kit, use them instead of the instructions included in this section. The standard rail 
configuration is for racks with square mounting holes. Optional brackets are included for racks 
with round holes. The rack-mounting kit requires inner slide rails be mounted to the Avid Motion 
Graphics Server and the outer slide rails are mounted to the rack. Once both the inner and outer 
rails are in place, slide the server with the inner rails attached into the outer rails. Secure the Avid 
Motion Graphics Server in the rack so it does not slide forward. 

c The Avid Motion Graphics Server is designed to be installed horizontally in a rack. 
Installing the server on an angle or in a sloped console causes the internal drives to wear 
faster than the intended life of the drive.

w To ensure the stability of the rack enclosure, start from the bottom when you install the 
rack components in the rack enclosure.
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Rack-mount Requirements
• Elevated Operating Ambient — If installed in a closed or multi-unit rack assembly, the 

operating ambient temperature of the rack environment might be greater than room ambient. 
Therefore, consider installing the equipment in an environment compatible with the 
maximum ambient temperature specified by the manufacturer.

• Reduced Air Flow — Installation of the equipment in a rack should be such that the amount 
of air flow required for safe operation of the equipment is not compromised. Avid Motion 
Graphics Server airflow is from the front of the enclosure to the rear. Make allowances for 
cooling air to be available to the front panel surface and no restrictions at the rear.

• Mechanical Loading — Mounting of the equipment in the rack should be such that a 
hazardous condition is not achieved due to uneven mechanical loading. Ensure your rack 
enclosure is stable enough to prevent tipping over when one or more Avid Motion Graphics 
Engines are extended on the sliding rails.

• Circuit Overloading — Consideration should be given to the connection of the equipment to 
the supply circuit and the effect that overloading of the circuits might have on surge 
protection and supply circuit wiring. Appropriate consideration of equipment nameplate 
ratings should be used when addressing this concern.

• Reliable Grounding — Reliable grounding of rack-mounted equipment should be 
maintained. Particular attention should be given to supply connections other than direct 
connections to the branch circuit (for example, use of power strips).

• Inside Enclosure Access — If you want to extend the enclosure, and remove the top cover, 
you must allow 0.5 in (1.3 cm) clearance on top of the enclosure for cover removal.

Rack mounting your server involves the following tasks:

• Positioning the Server in the Rack

• Separating the Slide Rails

• Attaching Inner Slide Rails to the Server

• Attaching the Outer Rails to a Square-Hole Rack

• Attaching the Outer Rails to a Round-Hole Rack

• Securing the Server in a Rack
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Positioning the Server in the Rack

The following information helps you decide where to install the Avid Motion Graphics Server in 
the rack. 

n Avid recommends 5 rack spaces to allow for room between devices in future expansion.

To position the server in the rack enclosure:

t Select a position in the rack where the Avid Motion Graphics Server is at the proper baseline 
position.

The following table describes various positioning points in the previous illustration.
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Item Number Description

1 Rack mounting rail hole spacing

2 Rack mounting rail

3 EIA rack unit

4 Avid Motion Graphics Server

5 Avid Motion Graphics Server front panel mounting holes

6 Outer slide rail bracket assembly
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Separating the Slide Rails

You need to separate the slide rails and attach the inner “movable” section to the File Gateway 
server and the outer “fixed” section to the rack rails. 

To separate the slide rails:

1. Slide the slide rail completely open.

2. Press the spring clip on the inner slide rail as shown in the following illustration.

n The blowup of the spring clip shown in the illustration is on the bottom side of the slide rail.

3. Pull and separate the two halves.

4. Repeat these steps to separate the second slide rail.

Attaching Inner Slide Rails to the Server

Attach the inner slide rails that were separated from the outer slide rails to the Avid Motion 
Graphics Server.

To attach the inner slide rails:

1. Position the inner slide rail against the side of the server so that the screw holes are toward 
the rear of the server, and front of the slide rail fits over the tab at the front of the server.

7 Baseline position is between two 1/2 inch holes

Item Number Description
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2. Secure the inner slide rail to the server with two of the small screws.

n You might find more screws in the rail kit than is needed, and described in this procedure.

3. Repeat this procedure to attach the other inner slide rail on the other side of the server.

Attaching the Outer Rails to a Square-Hole Rack

After separating the slide rails as previously described (see Separating the Slide Rails), perform 
the following procedure. If your mounting rails have round holes, see Attaching the Outer Rails 
to a Round-Hole Rack. 

To attach the outer slide rails to the rack with square holes:

1. Align the outer slide rail bracket assembly with the front rack-mounding holes.

n Have someone help you by holding the slide rails level while you are positioning them in the 
rack.

2. Slide the square tabs through the holes in the front, vertical rack-mounting rail. 
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3. Push the outer rail towards the outside of the rack, to secure the outer rail in place.

4. Adjust the outer slide rail bracket assembly to the rear mounting rail.

5. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.

6. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 
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Attaching the Outer Rails to a Round-Hole Rack

After separating the slide rails as previously described (see Separating the Slide Rails), perform 
the following procedure. If your mounting rails have round holes, you first need to clip on the 
round hole adapter. 

To attach the outer slide rails to the rack with round holes:

1. Locate the four round hole adapters (which ship in the accessory kit's plastic bag, not in the 
rack mount kit box) and position the adapter on the end of the outer slide rail bracket 
assembly as shown in the following illustration. 

2. With the bracket assembly tabs aligning with the cut-out in the round hole adapter, swing the 
adapter so that the holes face the front of the bracket assemble as shown in the following 
illustration. 

1 

2 

3 

Item Number Description

1 Bracket Assembly Tabs

2 Outer Slide Rail Bracket Assembly

3 Round Hole Adapter
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3. Slide the outer slide rail bracket assembly onto the side rack-mounting rail so that the round 
hole adapter is over the rack rail. 

n It is helpful to have someone holding the slide rails level for you when positioning them in the 
rack.

4. Insert the small (10-32) Phillips-head screws through the round-hole adapter and mounting 
rail, into the bracket. If the rack holes are different size, you need to supply your own screws.

5. Adjust the outer slide rail bracket assembly to the rear mounting rail.

6. Secure the rear outer slide rail bracket assembly to the rear mounting rail as you did for the 
front rack-mounting rail.
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7. Repeat this procedure to attach the second outer slide rail on the other side of the rack. 

Securing the Server in a Rack

c You should have someone helping you lift the Avid Motion Graphics Server while you are 
positioning it into the slide rails.

To secure the Avid Motion Graphics Server to the rack enclosure:

1. Lift and position the Avid Motion Graphics Server so that the inner slide rails (secured to the 
Avid Motion Graphics Server) align with the outer slide rails secured to the rack.

2. Push the front of the Avid Motion Graphics Server flush against the front mounting rail. The 
holes in the Avid Motion Graphics Server front panel align with the holes in the front 
mounting rail.

3. From the front of the rack enclosure, insert the large screws through the Avid Motion 
Graphics Server and front mounting rail, and tighten.

n You can use your own rack hardware if your rack has square holes or unique fasteners.

1 2 

Item Number Description

1 Rack Enclosure Front Mounting Rail

2 One of the four Screws
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Installing the RAID Drives

After rack-mounting the hardware, you can install the RAID drives.

n For information about configuring the RAID drives after they are installed, seeConfiguring the 
RAID Drives (For Single Channel Servers only).

To install the RAID drives:

1. Locate the drives shipped with your system. 

n Single channel Avid Motion Graphics servers ship with 5 drives. Dual channel Avid Motion 
Graphics servers ship with 10 drives.

2. Select a drive. There is no particular drive assignment, it doesn’t matter which drive goes in 
which of the available open compartments.

3. Push the drive carrier latch in to release the handle and pull the handle completely open to 
insert the drive carrier.

4. Ensure the drive LEDs are on the bottom and that the drive carrier latch is on your right 
before you begin to slide the drive into the compartment.

5. Slide the drive into the open drive slot in the server until it stops. Approximately 1/2 inch of 
the drive carrier should be outside the compartment.

The following table describes the parts of the data drive.

 3
 4

21

Item Number Description

1 Drive Carrier Latch

2 Drive Lock

3 Fault LED (Red)

4 LED (Blue) Power/Activity 
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c Do not force a drive into a slot. If you are having problems installing a drive, check to make 
sure it is level and flat as you insert it into the compartment, that the drive carrier latch is 
open and at a 45 degree angle to the drive carrier, and that the LEDs are on the bottom of 
the drive carrier.

6. Push the handle into the drive carrier. This seats the drive in the server. You’ll hear a click 
when the drive is fully seated and the handle latches in place.

7. Repeat these steps for each remaining drive.

For information about configuring the RAID drives after they are installed, seeConfiguring 
the RAID Drives (For Single Channel Servers only).

Installing the Breakout Box

A Breakout box is necessary to transfer any video from the video I/O card to the monitor. Avid 
recommends the AJA K3G Breakout box for use with the Avid Motion Graphics Server. The 
AJA K3G Breakout box is described in the following example.

n Although AES Audio in and out channels are labeled in the following illustration, AES Audio is 
not enabled for the Avid Motion Graphics Server. RS-422 Machine Control is likewise labeled in 
the following illustration but is not enabled for the Avid Motion Graphics Server.

Item Number Description

1 AES/EBU Audio In Channels 1 through 8 (not enabled)

2 AES/EBU Audio In Channels 9 through 16 (not enabled)

3 RS422 Machine Control (not enabled)

4 AES/EBU Audio Out Channels 1 through 8 (not enabled)

5 AES/EBU Audio Out Channels 9 through 16 (not enabled)

6 HDMI 1.4 Output (HDMI to SDI conversion necessary for preview out)
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The breakout box is required for cabling the Avid Motion Graphics system. The following 
information describes how to install the breakout box in a rack.

n Ensure you have at least 1RU of rack space available prior to installing.

To connect the breakout box

1. Lift and position the breakout box so that the rack-mount brackets on the panel are aligned 
with the rear outer rack rails.

2. Position the front of the box flush against the rear mounting rails so that the holes in the 
bracket align with the holes in the rear mounting rails.

n You may mount the breakout box above or below your Avid Motion Graphics Server. For 
single-channel models, allow a total of 5RUs of space between each server. 

For dual-channel model servers, a 2nd breakout box is required for video cabling, and allow 
6RUs of space between each server.

3. To connect video I/O to the breakout box, see Connecting Video Cables.

7 SDI Input/Output (enabled)

8 Component/Composite Video Output (not enabled)

9 Reference In/Out Loop Terminate loop with 75 ohm termination

10 LTC Input/Output (enabled)

11 Analog Audio Output (not enabled)

Item Number Description (Continued)
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Cabling Avid Motion Graphics

After the Avid Motion Graphics server is placed in a rack, you can connect the VGA monitor, 
Mouse, and Keyboard. To do this you might need to use a KVM extender, Avid recommends 
Avocent®.

Video Connections

The are video setup guidelines based on your system type. Video reference must be present prior 
to the integration of the video output signal into customer production environment. The video 
reference synchronizes the in-house resolution with the Avid Motion Graphics server.

n Although a video output can be generated without the presence of video reference, it is not going 
to integrate properly with other downstream devices that may be used in production. As a result, 
the time synchronization with the production house is incorrect.

Video inputs must be synchronized with the in-house reference signal supplied to the Avid 
Motion Graphics Server as there is no input timing adjustment included in the hardware settings. 

The Video I/O card(s), located on the back of the Avid Motion Graphics Server, auto senses the 
presence of video reference and identifies the reference supplied in the Hardware Settings menu. 
Reference input is located on the input/output video reference cable supplied with your Avid 
Motion Graphics Server.

n Dual channel Avid Motion Graphics Servers contain two (2) Video I/O cards.

Video Formats AMG 2.x Servers

The following are a list of video formats supported by the Avid Motion Graphics 2.x servers. As 
new technology is added, your software release could include additional formats.

525i 29.97 Hz 1080p 24.00 Hz

625i 25 Hz 1080p 50.00 Hz

720p 24 Hz 1080p 59.94 Hz

720p 50.00 Hz 1080p 60.00 Hz

720p 59.94 Hz 2048i 47.96 Hz

720p 60.00 Hz 2K: 2048 - 1080p 23.98

1080i 50.00 Hz 2K: 2048 - 1080p 24.00

1080i 59.94 Hz 2K: 2048 - 1080p 25.00
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n Custom Resolutions:  Avid Motion Graphics allows users to set non-standard video formats (i.e. 
1080 x 1920 9:16 for a digital signage type or studio display). Custom resolutions are set in the 
File / Preferences area of the Avid Motion Graphics interface.

n  Half frame rates of HD formats are also supported.

Video Formats AMG 1.x Servers and DekoPlayer Formats

The following are a list of video formats supported by the Avid Motion Graphics v1.x servers 
and DekoPlayer supported formats. As new technology is added, your software release could 
include additional formats.

1080i 60.00 Hz 2K: 2048 - 1080p 29.97

1080PsF 23.98 Hz 2K: 2048 - 1080 30

1080PsF 24.00 Hz 2K: 2048 - 1080p 50

1080PsF 25.00 Hz 2K: 2048 - 1080p 59.94

1080PsF 29.97 Hz 2K: 2048 - 1080p 60

1080PsF 30.00 Hz Custom Resolutions

1080p 23.98 Hz

NTSC (4x3 and 16:9)

PAL (4x3 and 16:9)

1080i 59.95Hz

1080i 60.00 Hz

1080i 50.00 Hz

720p 50.00 Hz

720p 59.94 Hz

720p 60.00 Hz
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Connecting Video Cables

The following information explains how to make the video connections for the Avid Motion 
Graphics Server to the Monitor going through a breakout box. The breakout box transfers any 
video from the Video I/O card(s) to the monitor. The following illustration shows the front of the 
breakout box to which the video cables connect.

The following illustration shows the video connections on the back of the breakout box.

For more information, see “Installing the Breakout Box” on page 44.
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The Video I/O card is located on the back of the Avid Motion Graphics Server. There are three 
different cables, which must be connected from this video card on the server to the breakout box. 
It has 4 mini-BNC connectors, labeled SDI 1 through 4 on the lower portion of the card, as 
shown in the following illustration.

The Avid Motion Graphics Server comes with a with a 4 foot breakout video cable to adapt the 
mini-BNC SDI 1-4 connections from the video card to the standard-BNC connections on the 
back of the video breakout box, for distribution. The following table describes the types of SDI 
connections.

SDI Connection Connection Description

SDI 1 Provides Video In

SDI 2 Provides Key Channel In

SDI 3 Provides Program Video Out

SDI 4 Provides Key Channel Out
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The cable(s) are labeled as are the connections on the Video I/O card(s) and the breakout box. 
The video cable supplied is shown in the following illustration.

n For dual channel Avid Motion Graphics servers, you would have two video cables.

Also supplied with your Avid Motion Graphics Server is a 60-pin breakout connector cable, as 
shown in the following illustration.

n For dual channel Avid Motion Graphics servers, you would have two 60-pin breakout connector 
cables.
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The following illustration shows a close up of one of the ends of the breakout connector cable.

One end of this cable connects to the multi-port connector, located at the top of the Video I/O 
card on the back of the Avid Motion Graphics Server, and the other end connects to the 
multi-port connector on the back of the breakout box.

The final cable you must connect from your Video I/O card and the breakout box is the HDMI 
cable. The HDMI out provides Preview video. It has a mini end, which connects to the HDMI 
Preview connector in between the 4 mini-BNC connectors and the multi-port connector, on the 
video card. It also has a standard size end, which connects to the breakout box.

n For dual channel Avid Motion Graphics servers, you would have two HDMI cables.

The HDMI cable and some close-up pictures of the ends are shown in the following illustrations.
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The following illustration shows the standard size end of the HDMI cable.

The following illustration shows the mini size end of the HDMI cable.

Connecting the KVM Switch

The next step is to connect the KVM switch to your VGA adapter.

To do so, connect the KVM switch power cord into a Power outlet. 

n Your network switch might not have a Power switch and might be powered on when you plug the 
power cords into a power outlet.

The LEDs on the front of the switch light and the fan can be heard.
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COM Port Pinouts

The Avid Motion Graphics Server comes with an RS-232 COM 1 port located off the 
motherboard. It is usually used for connecting to an automation system. 

The male pinouts for COM Port 1 for automation control are shown in the following illustration.

The following table lists the RS-232 signals for the male COM Port 1 connector on the rear panel 
of the Avid Motion Graphics Server. These COM ports operate as standard COM ports.

1 5

6 9

Pin Number Signal

1 Data Carrier Detect (DCD)

2 Receive data

3 Transmit data

4 Data Transmit Ready (DTR)

5 Ground

6 Data Set Ready (DSR)

7 Request To Send (RTS)

8 Clear To Send (RTS)

9 Ring Indicator
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Connecting VGA Cables

VGA cables are used to connect the VGA output to a VGA monitor or KVM.

The VGA card slots (s) are located on the back of the Avid Motion Graphics Server. Use a VGA 
cable (not supplied) to connect the VGA card on the server to a VGA monitor or KVM. the 
location of the VGA Adapter on the rear of the AMG server is shown in the following 
illustration.

A VGA cable is shown in the following illustration.

VGA Adapter
(for KVM or
VGA Monitor)
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The following illustration shows a close up of one of the ends of the VGA cable.

Serial Input and Output Connections

For serial input connections, Pins 1 and 4 of the RS-232 connector can be used to detect a GPI 
from a standard contact closure (such as a GPI output from a switcher). Alternatively, a short 
pulse (minimum 10 milliseconds) on pin 1 also triggers the GPI input for a Deko application.

For serial output connections, Pin 7 on the RS-232 connector pulses high (for approximately 100 
milliseconds) when a GPI output command is issued from, for instance, the Deko application. 
This can be used to trigger an external device that is expecting a pulse to trigger an event 
fromDeko.

For more information, see COM Port Pinouts.

Connecting the Serial Cable

Automation uses RS-232 communication between the serial port of the system and the serial port 
of the Newsroom Computer System. A standard nine-pin null modem cable can be used to 
connect the two systems. RS-232 serial cables are always female to female.

To connect the serial cable:

1. (Option) If making your own cable, connect the following pins (the system only uses three 
of the nine wires.)

- 2 to 3

- 3 to 2

- 5 to 5

2. Connect one end of the cable to the desired port of the Newsroom Computer System, and the 
other end to COM Port 1 on the rear of the server.

n RS-232 is rated for fifty feet.
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Setting Serial Protocol

Set the serial protocol to the following:

• 9600 baud

• 8 bits

• No Parity

• One Stop Bit

n The serial protocol of your system and the automation system must match.

To set the communication ports of your system:

1. Press the Ctrl + Esc keys on your keyboard.

A menu displays.

2. Select Settings > Control panel.

3. Double-click Ports to display the selection of serial ports (usually COM1).

The Ports window opens.

4. Double-click the port to which you connected the serial cable.

The Settings dialog box opens.

5. Change the settings as needed, to match those of the Newsroom Automation system.

6. Click OK to accept the changes in the settings dialog box.

7. Click Close in the Ports window.

Connecting to Ethernet Port 1

The Avid Motion Graphics Server ships with six on-board 1-Gb Ethernet (network) ports. A 
single Ethernet port (Port 1) is supported at this time. 

To connect to Ethernet port 1:

1. Locate your Ethernet cable.

2. Connect the Ethernet cable to Port 1 (top left corner) as shown in the following illustration:

Ethernet port 1
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3. Once you log on to your AMG server, you should disable Ethernet ports 2-6 prior to 
installing the AMG software or licensing. For more information, see Disabling Ethernet 
Ports.

Connecting a Keyboard, Monitor, and Mouse

An industry standard keyboard, mouse with center wheel and monitor are used to access the 
software on the server. 

If you ordered an AMG keyboard, plug it into one of the USB ports. Following is an example of 
the AMG keyboard. 

There are four USB ports located on the rear of the Avid Motion Graphics Server. Avid 
recommends using the USB ports, located on the expansion card, in slot 6. It contains the PS/2 
connections, for USB devices For more information, see USB Ports.

The connection for the monitor is DVI. Therefore if a VGA Monitor is used, you must also use a 
VGA-to-DVI adapter or connector.

When installed in a rack with several servers, an optional KVM switch can also be used with 
your system. The keyboard, monitor, and mouse connections use the same ports described in the 
following procedure. 

n Follow the instructions supplied with your KVM switch. You need to supply KVM cables that are 
compatible with your KVM switch.
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To connect a keyboard, monitor, and mouse to the Avid Motion Graphics Server:

1. (Option) Install your KVM switch in a suitable location next to the Avid Motion Graphics 
Server in the rack. 

You can also place the monitor on a shelf, and the keyboard and mouse on a sliding tray in 
the rack. These items are optional and can be purchased locally or from Avid.

c Do not place the monitor on top of the Avid Motion Graphics Server.

2. Attach the DVI connector on the monitor cable to the DVI port on the video card at the back 
of the Avid Motion Graphics Server. Ensure the connection is secure.

Connecting Power Cords to the AMG Server

Once your AMG server is cabled up, you can connect power to it. The last step you must perform 
when cabling up your AirSpeed 5000 is to connect the power cords. Two U.S. IEC power cords 
are shipped with the unit. If your local power distribution is not compatible with the supplied 
cords, you must provide your own IEC power cables that are compatible with your country’s 
power system. The power connector accepts 100 to 240 Vac, 50/60 Hz.

To connect power to the AMG server:

1. Attach the power cords to both power receptacles on the rear of the AMG server as shown:

2. Connect the other end of both power cords to a properly grounded stable power source.The 
system will power on after you connect the first power supply. The Monitor application will 
also automatically launch.

3. Once powered on, you must set up your system. For more information, see Powering on 
Avid Motion Graphics.

c For maximum power protection, Avid recommends a surge protected un-interruptible 
power supply (UPS).

Power
Connectors

S
D

I 3
S

D
I 4

S
D

I 2
S

D
I 1
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Powering on Avid Motion Graphics

When you turn on the power to your Avid Motion Graphics Server hardware, you must do it in 
the following order so that the Avid Motion Graphics Server locate and acknowledge all of its 
connected components.

n If you encounter an error when starting the Avid Motion Graphics application for the first time, 
close the error message and change the display resolution frequency to 60Hz. For further 
information contact Avid support.

To power on each component:

1. (Option) If you have a KVM switch as part of your system, ensure the power is on.

2. Ensure you have all your network cables connected before you turn on the power or load the 
Avid Motion Graphics Server software.

3. Push the Power button at the top left on the front of the your Avid Motion Graphics Server.

4. Wait for the Windows operating system to load before you attempt to use the Avid Motion 
Graphics Server. This can take several minutes.

Network and Operating System Settings

The Avid Motion Graphics Server arrives with the Windows 7 Ultimate operating system already 
installed. However, there are settings that must be configured based on the geographical location 
of your server. If you are setting up Avid Motion Graphics software only on a qualified, 
customer-supplied laptop or computer, if not already done, these settings must also be 
configured.

Server Log On

When you first power on your server, you are asked to login. The default login username is 
AMG, which is not case sensitive and the password is left blank (no password is assigned). 
When installing the software, you should log on as user of AMG and no password. 

n If you log on as Administrator when installing the software, it will not launch. 

However, if you need to restore the operating system on the server using the USB drive provided, 
login as Administrator, and the password is avid (the password is case sensitive and is lower 
case).

When turning on your Avid Motion Graphics Server for the first time, the Apply Computer Setup 
message is displayed for approximately 3 to 5 minutes. 
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Complete the Windows installation by answering the Windows operating system prompts. When 
the system prompts you to enter the Windows activation key, locate the Windows Certificate of 
Authenticity. 

n The Windows Product Key Certificate of Authenticity is attached to the top of the Avid Motion 
Graphics Server. 

Use the information in the following sections to configure the Avid Motion Graphics Server or 
qualified, customer-supplied laptop or computer with the correct date, time, computer name, and 
network properties.

n On the Avid Motion Graphics Server, login with the username as AMG, which is not case 
sensitive, and leave the password blank. If you are logging in as an administrator, the username 
is Administrator and the password is “avid”. AMG software should be installed on the AMG 
user.

Specifying a Unique Computer Name

The Avid Motion Graphics Server has been imaged at Avid with the current operating system 
configuration and drivers that have been qualified with the Avid Motion Graphics Server. This 
image creates a unique Host name for the system based on the MAC ID of the system board.

If you change the computer name of the system you must also rename the computer after 
re-imaging the system. When you re-image the system, the Host system name is reset back to a 
Host name based on the MAC ID.

To specify a unique computer name:

1. Right-click the computer icon on the desktop, and select Properties.

The Control Panel/System dialog box opens.

2.  In the Computer Name, Domain, and Workgroup Settings section, click Change settings.

The System Properties dialog box opens.

3. On the Computer Name tab, click the Change button.

The Computer Name /Domain Changes dialog box opens.

4. Type the name for the Avid Motion Graphics Server in the Computer name text box.

5. (Option) Determine if you need to select the Domain or Workgroup in the “Member of” 
section at the bottom of the dialog box. If you are unsure, contact your network 
administrator for assistance.

6. Click the OK button.

After a short delay, you are informed that you must restart your computer in order for your 
changes to take effect.
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7. Close all open windows and restart the Avid Motion Graphics Server.

Configuring Date and Time Parameters

Assuming your Windows operating system is already installed, you must configure the date, 
time, time zone, and daylight saving time parameters.

To configure date and time parameters:

1. Click the time in the taskbar.

The Date/Time Properties dialog box opens.

2. Click Change date and time settings.

3. In the Date and Time tab, click the Change date and time button.

4. Set the date and time using the Date & Time tab.

5. Click OK to close the Date and Time Settings dialog box.

6. Click the Change time zone button.

7. Set the time zone for the geographic location of this Avid Motion Graphics Server.

n Make sure the “Automatically adjust clock for Daylight Saving Time” option is selected if your 
location observes daylight saving time.

8. Click the OK button to close the Time Zone Settings dialog box.

9. Click the OK button to close the Date and Time dialog box.

Install the LSI MegaRAID Storage Manager Software

Install the LSI MegaRAID Storage Manager software. If your Avid Motion Graphics server OS 
image is later than version 4, it will not have the LSI MegaRAID Storage Manager software 
pre-installed. Earlier Avid Motion Graphics software versions had this software pre-installed on 
the server. Therefore, if your system does not have it installed, you must you must install the LSI 
MegaRAID Storage Manager software yourself in order to view and manage the system.

To install the LSI MegaRAID Storage Manager Software:

t To get the latest LSI MegaRAID Storage Manager software, it is available to download 
under LSI’s terms and conditions at http://www.lsi.com.

From the website, you can locate and download the latest Windows-based LSI MegaRAID 
Storage Manager software that supports the MegaRAID SAS 9260 4i product.

Once you install the software, you can access it from your Avid Motion Graphics by 
selecting Start > All Programs > MegaRAID Storage Manager. 

This software should be used only when instructed to by Avid Customer Support. 
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Disabling Ethernet Ports

The AMG server has 6 Ethernet ports. By default, they are all enabled. Before you install your 
AMG software or license your system, you need to disable Ethernet ports 2-6.

n  Disable Ethernet ports 2-6 in Windows before you activate any licenses on the server. Failure to 
do so, will cause licensing issues. Once these ports are disabled, plugging or unplugging 
Ethernet ports or connecting them to different networks should have no effect.

To disable Ethernet ports on your AMG server:

1. Right-click on Network, and select Properties. 

The Network and Sharing Center dialog box opens.

2. Click Change adapter settings in the left pane.

The Network Connections dialog box opens.

3. Right-click the Ethernet port you want to disable, and select Disable from the menu. 

The status will change from “Network cable unplugged” to “Disabled”.

4. Close the Network Connections dialog box.

Network Protection

The System Administrator for the site must be contacted to obtain network configuration 
information for the system.

n If you need Administrator privileges while accessing the server operating system, “avid” is the 
built-in default administrator password included in the image. 

The following guidelines are intended for network System Administrators to use for protecting 
the system from viruses. While not always practical, following these suggestions provides the 
best level of protection against system compromise. 

• Share a folder or drive to “Everyone” with full access.

• All systems have a local Administrator with the username of the Administrator and 
password of “avid” preassigned.

c Always assign a local Administrator password on every machine. Not assigning a local 
Administrator password can introduce a serious security risk. 

• Restrict Internet access on the Avid Motion Graphics server.

• Anti-virus software can be installed on Avid hardware components that are used on air. 
However, it must not be set for active virus detection and the schedule scan set up must be 
set for non-production times of the day. For instance, between 1:00 AM and 3:00 AM. 
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Configuring the RAID Drives (For Single Channel 
Servers only)

After the drives are installed and the server is powered on, the RAID configuration must be 
imported using the LSI MegaRAID Storage Manager tool. The following procedure summarizes 
the LSI MegaRAID procedure for importing a Foreign Configuration. For more information, see 
the LSI MegaRAID Storage Manager tool Help.

n For more information about installing the RAID drives in the server, seeInstalling the RAID 
Drives.

To import the RAID configuration:

1. Start the server and give it about 3 minutes to initialize.

2. Start the LSI MegaRAID Storage Manager tool by double-clicking the shortcut on the 
desktop. If a shortcut is not on the desktop, start the tool by selecting Start > Programs > 
MegaRAID Storage Manager > StartupUI. 

n If your Avid Motion Graphics server OS image is later than version 4, it will not have the LSI 
MegaRAID Storage Manager software pre-installed. Earlier Avid Motion Graphics software 
versions had this software pre-installed on the server. To get the latest LSI MegaRAID Storage 
Manager software, it is available to download under LSI's terms and conditions at 
http://www.lsi.com.

From the website, you can locate and download the latest Windows-based LSI MegaRAID 
Storage Manager software that supports the MegaRAID SAS 9260 4i product.

3. Log in using the username “AMG” and no password or the username, “Administrator” and 
the password “avid”.

4. Double-click on the selected Host in the Remote Servers section.

5. Click the Logical tab

6. Select the LSI MegaRAID controller located in the left pane.

7. Select Go To > Controller > Scan Foreign Configuration.

A pop-up window appears reporting the detection of foreign configurations.

c Do not select the Clear option. Clearing the configuration deletes the RAID configuration 
off the disks. Doing so renders the RAID set unusable. All of the data in the Storage Group 
becomes unrecoverable.
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8. Select the Import logical configuration from all foreign drives option and click the OK 
button.

The Foreign Configuration Wizard window appears listing the foreign configurations.

9. Click the Accept button.

A dialog box appears asking you to confirm the import.

10. Click the Yes button.

A dialog box confirms when the import is completed.

n A background initialization is started and can take several hours to complete. You can use the 
server during this process but performance is better after the initialization is finished. If you 
have a problem, contact Avid customer support. 



3 Software Installation

The following provides instructions for installing and configuring Avid Motion Graphics 
software on the Avid Motion Graphics server.

n While Avid Motion Graphics and Avid Motion Graphics Production software is typically 
installed on the Avid Motion Graphics Server, the Avid Motion Graphics Creation software can 
also be installed on a qualified laptop or customer-supplied Windows or Macintosh computer. 
When installing the software on a computer other than the AMG server, you should select the 
“Avid Motion Graphics Offline” installation option. 

For more information, see the Avid Motion Graphics Offline Software Only Installation Guide.

If you are installing Avid Motion Graphics Journalist or News Control, there is a separate 
installer required.

The following main topics describe: 

• Installation Considerations

• Installing Avid Motion Graphics Software and All Dependencies

• Installing Avid Motion Graphics Tools

• Installing Avid Motion Graphics Plugins



Installation Considerations

66

Installation Considerations

After setting up and configuring operating system and network settings for your Avid Motion 
Graphics server, you can install the Avid Motion Graphics software.

The Avid Motion Graphics software is installed onto the system using a USB flash drive. For 
Avid Motion Graphics and Avid Motion Graphics Production the system comes with a blank 
USB flash drive. The USB flash drive should be used in the event that you want to keep a copy of 
the software in order to install it on the server. This USB flash drive stores approximately 16 GB 
of data and is used should the operating system for the Avid Motion Graphics Sever ever need to 
be restored.

n The Avid Motion Graphics software is available on the Avid Download Center 
(www.avid.com/support/downloadcenter).

n Make sure that you have disabled the network (Ethernet) ports 2-6 prior to installing any 
software. The software license device ID is generated based on active network ports. disabling a 
port after licensing will potentially break the license installed, preventing the operator from 
launching the application. 

n When installing Avid Motion Graphics Creation, Journalist, or News Control, see the AMG 
News Installation Guide, or the appropriate chapters in this guide.

To Install This Software See The Following Section

Avid Motion Graphics Online See “Installing Avid Motion Graphics Software and All 
Dependencies” on page 67.

Avid Motion Graphics Tools See, “Installing Avid Motion Graphics Tools” on page 75.

Avid Motion Graphics Plug-ins See, “Installing Avid Motion Graphics Plugins” on page 80.
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Installing Avid Motion Graphics Software and All 
Dependencies

Your system should have arrived with a USB flash drive. This is for you to download the 
software applications, and to use later for server recovery, if needed. Software can be 
downloaded from the Avid Download Center. 

n Prior to visiting the Avid Download Center (www.avid.com/support/downloadcenter) to 
download the Avid Motion Graphics software, ensure that you have available the Activation ID 
and System ID card, which shipped with your system.

n Avid recommends that you click the Open Documentation Folder link to view the available 
documentation. The ReadMe file provides the latest information regarding the Avid Motion 
Graphics Server, and software. You must have Adobe Reader installed to view the PDF. The 
ReadMe is also available online in the Avid Knowledge Base at www.avid.com/US/support

To install the AMG software on the AMG server:

1. Log in to the Avid Motion Graphics Server with the username and password.

2. Insert the USB flash drive into any open USB port on your Avid Motion Graphics Server.

n You can run the software installer from the USB flash drive.

If the USB flash drive does not automatically display:

a. Double-click the computer icon on the desktop. 

b. Double-click the USB flash drive icon in the window and copy the software kit into the 
new folder you created on the Avid Motion Graphics Server. 

3. Login to your Avid Master Account, or if you are a new user, create an Avid Master Account

4. Download the Avid Motion Graphics software kit from the Avid Download Center 
(www.avid.com/support/downloadcenter). 

5. Unzip the downloaded software kit in the new folder on the Avid Motion Graphics Server, or 
onto the USB drive. In any event, you should always download a backup of the software on 
the supplied USB drive.



Installing Avid Motion Graphics Software and All Dependencies

68

6. Navigate to and double-click on the Avid_Motion_Graphics_setup.exe file.

The installer splash screen appears.

7. To install Avid Motion Graphics software on the AMG chassis, select Avid Motion 
Graphics Online. 

n If you get a message saying “Driver Update Required! Click Here.”, click on it to install the 
latest drivers.

n To install Avid Motion Graphics Creation software on a different workstation (Windows or 
Macintosh) designated for graphics design, you will need a separate License Activation card, 
and you would need to select Avid Motion Graphics Offline. For more information, see the Avid 
Motion Graphics Offline Software Only Installation Guide.
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This begins the installation of the AMG software on the AMG server. The next screen 
appears:
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8. Click the Install Avid Motion Graphics and all dependencies option to install the AMG 
software and all the dependent applications.

n Wait for all of the components to install before continuing. After each component successfully 
installs, a green circle, containing a white check mark, replaces all of the red circles, containing 
white Xs. If a component is already installed, it is detected and the green circle with the check 
mark appears immediately.
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When all components have been installed, the Installshield Wizard for the Avid Motion 
Graphics application opens.

9. Click Next to continue. The License Agreement dialog box opens.
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10. Follow the screen prompts accepting the defaults and the License agreement. Click Next to 
continue. The Destination Folder dialog box opens.
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11. In the Destination Location dialog box, if you want to change the destination location, select 
Change..., then navigate to the location where you want to install the software. Otherwise, 
select Next to install the software in the default location. The Ready to Install the Program 
dialog box opens.
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12. Click the Install button to begin installing the software.

The Status bar displays followed by the InstallShield Wizard Completed dialog box.

13. (Option) Select the Show Windows installer log check box to view the install log.

14. Click the Finish button.

15. (Option) If you have connected an Avid Motion Graphics Keyboard (AMGK) you may now 
click the Avid Motion Graphics Tools option on the installer. A Windows Security dialog 
box appears alerting you that software is being installed. Do the following: 

a. Mark the Always trust software from this company check box so the installation can 
continue. 

b. Click the Install button. This is a quick installation. When it is finished, a green check 
mark next to the option confirms the installation is complete.

16. (Optional) Click the Open Documentation folder to view or print any of the user, workflow 
or ReadMe documentation for Avid Motion Graphics. This documentation is also available 
online at the Avid Knowledge Base www.avid.com/support.

17. Click Exit.

18. Next, you must install Avid Motion Graphics tools. For more see “Installing Avid Motion 
Graphics Tools” on page 75.

http://www.avid.com/US/support
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Installing Avid Motion Graphics Tools

When using your Avid Motion Graphics system in an environment with other software 
applications you can install the following Avid Motion Graphics Tools. 

Tool Name When/Why Needed Where Installed
Available on 
Macintosh?

Avid License 
Control

Must be installed on all computers 
running AMG software, tools or 
plug-ins with a licensed component. 
For instance, the servers pass licenses 
to Journalist clients and News 
Control Clients. 

Installed on the Avid Motion Graphics 
computer, Avid Motion Graphics 
Journalist Server, Avid Motion Graphics 
Preview Renderer, and any Computers 
running 3DS, Photoshop, MAP or Avid 
Motion Graphics Control.

Yes

AMG Advanced 
Device Manager 
(ADM)

Used for the iNEWS Command 
workflow or Automation.

Installed on the Avid Motion Graphics 
Server, or any Windows computer. 

n License Activation is required.

No

AMG Control Used to control playout of graphics. 
Used in non-newsroom playout 
situations.

Installed on any computer that has 
network access to the Avid Motion 
Graphics Server, or any Windows 
computer.

n We do not recommend installing 
AMG Control on the AMG server 
chassis as this might cause 
performance issues.

n License Activation is required.

No

Avid Motion 
Graphics Font 
Package

This font package provides fonts to 
support graphics previously created 
in Deko. Users can create new 
graphics using fonts from this 
package in Avid Motion Graphics 
too.

Installed on the Avid Motion Graphics 
Server. This installer must also be run 
on all iNEWS clients so they can edit 
the templates in a newsroom workflow.

No
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AMG Operations 
Console

Provides a central mechanism for 
users to manage, diagnose and 
monitor all configured AMG render 
engines from a single interface. 

Each individual Avid Motion 
Graphics Rendering engine is 
considered as a separate entity and is 
referred to as a Channel within the 
application. The Avid Motion 
Graphics Operations Console allows 
grouping of Channels, allowing you 
to organize Avid Motion Graphics 
engines within your facility. This 
provides an efficient, dependable 
method of managing and previewing 
specific channels.

Installed on any Windows computer that 
has network access to Avid Motion 
Graphics Server. The Avid Motion 
Graphics Operations Console requires a 
LAN connection to all Avid Motion 
Graphics playout engines intended to be 
monitored and managed remotely.

The Avid Motion Graphics Operations 
Console relies on the following external 
control applications to take Avid Motion 
Graphics compositions to air:

• Avid Motion Graphics Control

• News Rundown-driven graphics 
playout applications, including: 
Avid Motion Graphics Journalist, 
ADM, Avid iNEWS Command or 
Avid Motion Graphics News 
Control

n We do not recommend installing 
AMG Operations Console on the 
AMG server chassis, as this 
might cause performance issues.

n License Activation is required.

No

AMG Transcode AMG Transcode lets you convert 
from multiple clip types into a known 
usable format, which allows real-time 
playback with correct audio 
alignment. You can use it to convert 
clips that suffer from real-time 
playback and audio issues.

Installed on the Avid Motion Graphics 
Server, or any Windows computer.

No

Tool Name When/Why Needed Where Installed (Continued)
Available on 
Macintosh?
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Deko Translator The Deko Translator is an application 
that allows you to utilize your 
existing Deko Graphics assets and 
convert them into native AMG 
Compositions. 

DekoTranslator is a standalone 
application not requiring AMG or 
Deko to be installed to work 
correctly. However, to confirm that 
the all the assets required to process 
the Deko Graphics are available, you 
need some version of the Deko 
application. 

Can be installed on any Win7 64 bit 
system to translate.dko files – it does 
not need to be installed on the Avid 
Motion Graphics system or any system 
running Avid Motion Graphics 
software. It is a good practice to have 
PostDeko running on the same 
computer.

n It is recommended that you use a 
single computer that has a 
version of both Deko and AMG 
installed.

No

Deko Chart 
Designer

Allows use of Deko graphics 
previously created with Deko Chart 
Designer.

Installed on the Avid Motion Graphics 
Server, This is installed automatically 
when installing Deko Player. Deko 
Chart Designer supports the chart 
design option from Deko systems 
running v5.3 or later. 

n It cannot be run independently 
from Deko Player.

No

Deko Player Deko Player is a component of Avid 
Motion Graphics that allows you to 
easily play your existing Deko 
graphics to air.

Installed on Avid Motion Graphics 
Server or any windows-based Avid 
Motion Graphics Creation computer.

No

AMG Log 
Collector

AMG Log Collector is a component 
of Avid Motion Graphics that allows 
you to collect AMG logs for use in 
analyzing data.

Can be installed on any or all of the 
following:

• AMG Server

• AMG Creation computer (Windows 
only)

• AMG News

• AMG Journalist Server

• AMG Preview Renderer

• AMG Journalist Client plug-in

No

Tool Name When/Why Needed Where Installed (Continued)
Available on 
Macintosh?
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AMG GPI Service AMG GPI Service is a component 
that enables you to manage the 
rundown using GPI signals. This GPI 
support is provided by a Windows 
service designed to work with 
Sealevel SeaIO GPI cards (models 
BD8004 and 8012.)

Can be installed wherever you install 
the Sealevel card. 

It can be the AMG Playout chassis or 
any Windows PC that is running AMG 
NewsControl or AMG Control.

Once installed, it must be configured on 
the AMG Playout chassis using the Avid 
Motion Graphics GPI Configuration 
Tool in AMG Control.

Then it must be configured from AMG 
Control (on a computer that has network 
access to the AMG playout chassis) by 
clicking the Settings icon (upper right) 
just selecting the port (5130), and 
selecting the Enabled checkbox

No

Tool Name When/Why Needed Where Installed (Continued)
Available on 
Macintosh?
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The following steps describe how to install the Avid Motion Graphics Tools.

To install Avid Motion Graphics Tools:

1. Do one of the following:

t Navigate to and double-click on the Avid_Motion_Graphics_setup.exe file. When the 
installer window opens, click the Avid Motion Graphics Tools option in the list.

t If the installer window is already open, click the Avid Motion Graphics Tools option in 
the list.

n In the previous illustration, AMG License Control 3.0.0 was detected and shown as already 
installed.

2. Click the tool you want installed. Repeat this step for each tool that you want installed.

After the tools are installed, you can return to the main installer or exit the install.

3. Do one of the following:

t To return to the main installer window, click Main Menu.

t To Exit the installer, click Exit.
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Installing Avid Motion Graphics Plugins

There are several plugins available to install for use with Avid Motion Graphics.

Plugin Name When/Why Needed Where Installed
Available on 
Macintosh?

Avid License 
Control

Must be installed on all computers 
running AMG software, tools or 
plug-ins with a licensed 
component. For instance, the 
servers pass licenses to Journalist 
clients and News Control Clients. 

Installed on the Avid Motion Graphics 
computer, Avid Motion Graphics 
Journalist Server, Avid Motion Graphics 
Preview Renderer, and any Computers 
running 3DS, Photoshop, MAP or Avid 
Motion Graphics Control.

n Avid License Control must be 
installed prior to installing any 
other plugins. 

Yes

AMG 
3DSStudio 
Exporter

A component of Avid Motion 
Graphics that exports .OBJ files 
created in Autodesk 3D Studio 
Max and makes them AMG 
compatible.

Installed on a windows computer that 
runs Autodesk 3D Studio max.

n Autodesk 3D Studio Max must be 
installed on a Windows system 
prior to installing the AMG 3D 
Studio Exporter plugin.

No

AMG PSD Allows you to export Adobe 
Photoshop .PSD files to an AMG 
compatible .SCN file. 

Installed on any computer that runs 
Adobe Photoshop.

n Adobe Photoshop and must be 
installed prior to installing the 
AMG PSD plugin. 

Yes
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To install Avid Motion Graphics Plugins:

1. Do one of the following:

t Navigate to and double-click on the Avid_Motion_Graphics_setup.exe file. When the 
installer window opens, click the Avid Motion Graphics Plugins option in the list.

t If the installer window is already open, click the Avid Motion Graphics Plugins option 
in the list.

n AMG Plugins can be installed on customer owned computers running Autodesk 3D Studio Max 
(available only on Windows systems), and Adobe Photoshop. 

c Avid does not recommend installing any 3rd party applications on the AMG Servers 
directly as this impacts play-out performance when going to air. 

n In the previous illustration, AMG License Control 3.0.0 was detected and with a green check 
mark, shown as already installed.
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2. Click the plug-in you want installed. Repeat this step for each plug-in that you want 
installed.

After the plug-ins are installed, you can return to the main installer or exit the install.

3. Do one of the following:

t To return to the main installer window, click Avid Motion Graphics Main.

t To exit the installer, click Exit.

4. After installing your plug-ins, make sure to activate your AMG 3DS or PSD plug-in option. 
For more information, see “Software Licensing” on page 83.



4 Software Licensing

After you have installed the Avid Motion Graphics Software you must use the Avid License tool 
to activate the license for your products.

The following main topics describe: 

• What You Need to Activate the Software License

• License Activation Using an Internet Connection

• License Activation Without an Internet Connection

• Deactivating the License
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What You Need to Activate the Software License

The software license is provided on an Activation ID. Depending on your specific configuration, 
you may receive more than one Activation ID card. The card ships in a box separately from the 
server and, if you have purchased multiple products on the same order, it could potentially be in 
a box with another product that might be unrelated to the Avid Motion Graphics system.

Below is an example of an AMG System ID / Activation ID card:

c If you change your system configuration — for instance, by replacing your hard drive, a 
network adapter, or by upgrading your operating system — you must first deactivate your 
Avid software. 

n Your network administrator might need to open a few ports that are used during the license 
activation. The Avid License Control tool utilizes both port 3443 and port 443 for license request 
and response communication. Port 3443 is the primary port, but if this port is blocked, the 
Activation Service tries port 443, which is more likely to be open for Web communication.
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To activate the software using the Avid License Control tool, you need the items listed in the 
following table.

License Activation Using an Internet Connection

To activate the software license using an Internet connection:

1. Locate your System ID and Activation ID card(s) included with your new hardware or 
software. 

n For hardware installations, the card could be in a separate box.

2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens.

3. In the Activation tab, click the Activate button located in the Action column for the Avid 
Motion Graphics software product name you are activating.

n You might need to click the Activation tab to continue with the product activation.

Identification Number Type Where you can find it:

Activation ID The Activation ID is provided on an Activation ID and System ID 
card shipped with your new Avid Motion Graphics system. The 
Activation ID is used to activate the software license and has been 
linked to your System ID.

System ID The System ID is provided on an Activation ID and System ID card 
shipped with your new Avid Motion Graphics system. The System 
ID is used for expediting warranty verification and customer service. 
After activation, the License Profile tab of the Avid License Control 
tool displays information about your system. Click “Copy to 
Clipboard” to copy the information to your clipboard. You can then 
paste from the clipboard to an e-mail or create a text file. This is 
helpful if you need to save this information for your records or need 
to send system information to Avid Customer Support.

Device ID The Device ID is only needed if you are activating your software on 
a system that is not connected to the Internet. This is provided 
through the Avid License Control tool during activation.
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4. Select I am connected to the Internet and will use this computer and then click 
Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page License Activation Without an Internet Connection.

5. Enter your system identification number in the System ID text box.
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6. Enter your activation identification number in the Activation ID text box.

7. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

n After your Avid software is activated, the License Profile tab displays your System ID, Activation 
ID, and Device ID.

License Activation Without an Internet Connection

License Activation Without an Internet Connection

When you do an indirect activation, you are given a “.bin” activation file. This file is only works 
for a single activation. If you have done an indirect activation, and deactivate your license for any

reason, you may not use the same activation file to reactivate your license. You must repeat the 
“License Activation Without an Internet Connection” procedure and obtain a new “.bin” 
activation file.

To activate the software license from a separate computer

1. Locate your System ID and Activation ID card included with your new hardware.

2. Open the Avid License Control tool, select Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens.

3. Click the Activate button located next to the Avid product software name.

4. Select I am not connected to the Internet and will be using another computer that is 
connected to the Internet, then click the Continue button.

5. Enter your system identification number in the System ID text box.

6. Enter your activation identification number in the Activation ID text box.

7. Click the Next button.
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8. Follow the instructions in the Avid License Control tool, then click the Next button.

n Your System ID, Activation ID, and Device ID are displayed on the Activation tab, write these 
numbers down to use later. These IDs are displayed in the License Profile tab after your Avid 
software is activated.

9. On a computer with an Internet connection, open a Web browser and navigate to 
http://avid.com/license.

10. Follow the on screen instructions on the web page.

The Website creates a license.bin file. This file contains license information needed to 
activate your Avid Motion Graphics software.

11. Copy the license.bin file to the computer you want to activate.

A USB flash drive is a good method of moving the license.bin file.

12. Close the Web browser on the computer with the Internet connection.
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13. Return to the computer where you left off in the Avid License Control tool and click the 
Next button.

14. Click the Browse button and navigate to the license.bin file on your computer, then click 
Open.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

Deactivating the License

If you need to move your Avid Motion Graphics application to a different computer, deactivate 
the Avid Motion Graphics application before you un-install it. If you un-install your software 
first, you may not be able to retrieve your System ID or Activation ID.

Once you deactivate your Avid Motion Graphics software license from one computer, you can 
use the license on another computer. 

n To be able to deactivate the software and it’s options, you must have an Internet connection.

To deactivate the software license:

1. Close any Avid Motion Graphics applications that are running.

2. Open the Avid License Control tool, select Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens.

3. Next to the Avid Motion Graphics software, click the Deactivate button.
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4. Click Yes.

5. Click Done to close the Avid License Control tool.



5 Video Setup and Preferences

The following provides instructions for configuring the Avid Motion Graphics software. 

You must complete your Avid Licensing before performing the video setup, and selecting 
preferences. For more information, see “Software Licensing” on page 83. 

n While Avid Motion Graphics and Avid Motion Graphics Production software is typically 
installed on the Avid Motion Graphics server, the Avid Motion Graphics Creation software 
installation is performed on a qualified laptop or computer supplied by the customer.

If you are installing Avid Motion Graphics Journalist or News Control, there is a separate 
installer required.

The following main topics describe: 

• Video Setup

• Preferences
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Video Setup

The Avid Motion Graphics Video Setup Wizard is used for video setup.

To open the Avid Motion Graphics Video Setup Wizard:

1. From the Start menu, do one of the following:.

t For single channel AMG servers, select All Programs > Avid > Avid Motion Graphics 
A Channel Video Setup.

t For dual channel AMG servers, select All Programs > Avid > Avid Motion Graphics 
B Channel Video Setup.

The Avid Motion Graphics Video Setup Wizard opens.
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2. There are four templates available for video setup. The standard configuration to select for 
an AMG Server is: AJA Kona 3G Quad Input  + Output  + HDMI, as shown selected in the 
previous illustration.

n A different template can get selected by default even if the Video Setup has already been 
performed on this particular computer. Ensure the correctness of the template selection on each 
start of the Video Setup.

3. The Video Output Hardware settings must have the following default values.

- Stream #1 Pipe 0 – Aja Kona 3G Quad – Card #0

- Stream #2 Pipe 1 – Aja Kona 3G Quad – Card #0

n Stream #1 is used for Program/Key output and Stream #2 is used for HDMI/Preview Video 
output, no key. Audio is only supported for Stream #1. All other Audio check boxes should be 
cleared.

4.  In the Video Input Hardware Settings section, only Video In #1 is supported.

- Aja Kona 3G Quad – Card #0 – SDI 1

- Audio input check box should be unchecked

To configure video format settings:

1. In the Video Format Settings section, select your video formats. For a list of video formats, 
see “Video Connections” on page 46.

2. After selecting the video format, set the Sync Format to properly genlock the system into a 
broadcast environment. 

If the reference input is Blackburst, select the Sync to be Blackburst and the sync format to 
be either NTSC or PAL.
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3. For Composite Trilevel set the Sync field as Composite Trilevel and set the Sync-Format to 
the proper format of the tri-level signal you are providing.

4. Do not change the OutBuffer or InBuffer settings from the default, BGRA.

5. The Field Render Mode allows a choice of how the interlaced image is rendered. For most 
video formats (except for 1080i), the Frame mode should always be set. Failing to do so 
might result in incorrect rendering of the video output. 

For 1080i modes, there are two choices:

t Field (default): For better performance. Select this for1080i video mode only.

t Frame: For better quality at the expense of performance. Select Frame for all video 
modes, except 1080i.

6. H Delay and V Delay are the Horizontal and Vertical video delay adjustments.

7. The Number of buffers should not be changed from the factory default of 6.

8. After selecting the Video Setup options, click the Install button, and then the Ok & Exit 
buttons to confirm your changes. 

n If you click the Ok button instead of Ok & Exit, you will need to close the Video Setup window 
manually.

Shaped and Unshaped Keying

Working with multiple sources in a video production environment requires a mixing operation to 
properly combine independent Video + Key elements. This operation is normally found in 
graphics systems, character generators, DVE (Digital Video Effects) and switchers that are used 
for on air broadcasts. Traditionally, two different methods of keying have been used in this 
environment: Shaped and Unshaped Keying. These two methods cannot be used interchangeably 
and can sometimes lead to confusion and improper operation.

In the broadcast environment, video and key signals are normally transported on two separate 
signals. The terms Shaped and Unshaped refer to how a separate key signal is used in 
conjunction with an associated video (or fill) signal to represent a non-opaque source.
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The Avid Motion Graphics video setting Unshape is by default Off. This default setting is for 
shaped keying. Shaped refers to a video and key pair that has the key pre-applied (or 
pre-multiplied) to the video signal. 

If you need unshaped keying use the pull down for Stream #1 and select Expand1. The Stream #2 
is for preview only output and should not be changed. 

Preferences

The preferences for Avid Motion Graphics are set using the Preferences option available from 
the Avid Motion Graphics user interface. This option is used to define the file structure and 
preferences for the Viewports, Text, Paths, Desktop Shortcuts, and other miscellaneous 
properties.

Configuring Viewports Preferences

The Viewports preferences are configured using AMG Preferences in the Viewports tab. 

To configure Viewports preferences:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Viewports tab.
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When you select a Video Format the Size, Camera Aspect Ratio, and Pixel Aspect Ratio are 
populated based on the correct default settings for the particular video format selected.

n This is setting the size of the viewport and will not impact your video output. Avid recommends a 
setting of HDV/HDTV 1080.

3. (Optional) If you want, you can select the Focal Length for the viewport camera. The 
Optimal setting is 50mm – 3D objects might appear stretched when moving to the corners of 
the viewport with lower value settings.

4. (Optional) If you want, you can select the Output Fit Anamorphic (the default) Output Fit or 
Letterbox (4x3 video). Avid recommends the Anamorphic option.

5. (Optional) If you want, you can turn on or off the Edit Stereo for the edit viewport for 
stereoscopic.

n Stereoscopic settings are not available unless properly licences for these settings.

6. (Optional) If you want, you can turn on or off the Program Stereo for the output for 
stereoscopic.

7. (Optional) If you want, you can set the Stereo Parallax for stereoscopic 3D (the higher the 
number the more dramatic the affect).

8. (Optional) In the Viewports Reduced Render section you can set parameters for viewport 
rendering. Avid recommends accepting defaults for the settings in this section for optimal 
performance.

9. (Optional) Mark the Video Pattern check box to display a test pattern for diagnostics (testing 
output or video signal). A test pattern is displayed on the video output for testing and 
configuration – this is disabled when closing preference menu.

Configuring Text Preferences

The Text preferences are configured using AMG Preferences in the Text tab.

To configure Text preferences:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Project tab.
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3. Click the Text tab.

4. (Optional) Select Unicode Shaping to support Unicode characters such as Arabic.

5. (Optional) Select Spell Check to enables spell checking.

6. Click the Ok button.

Configuring Path Preferences

The Avid Motion Graphics Design applications allows multiple designers to work with one 
common project library. Path preferences are defined and configured using AMG Preferences on 
the Path tab. The tab allows you to define the following four main paths:

n The illustrations that follow represent examples of paths and are not intended as best practice 
examples. It is best to create your content on the terabyte storage drive of the AMG server (drive 
letter E) as originally configured by Avid. Reserve drive letter X for all mapped media as this 
drive letter is used in the AMG News and AMG Journalist workflows.

• User Projects paths — User Projects is the path where all projects are saved. By default, it 
is set to Documents\Avid\AMG\Projects. It can be changed to another folder.

• Admin Projects paths — The Admin Projects path is where all shared projects are saved. 
When you publish a composition, the composition is saved to the Admin Projects path. By 
default, Admin Projects is the same as the User Projects path.

• Common Library paths — The Common Library path, which is not set by default, is 
where you save all custom objects, materials, textures, fonts and other items which are 
available for other designers.

• Common Assets paths — Common Assets path, which is not set by default, is where all 
shared media files are saved (clips, JPG, PNG, etc.), so they can be used by multiple 
designers without copying them to their local computers.

To configure a User Projects path:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Machine tab.
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3. Click the Path tab.

4. Do one of the following:

t Click the down-arrow to browse the AMG browser.

t Click the magnifying glass to use the Windows browser.

t Click the User Default button to select the default path.

5. Select a location.

6. Click the Ok button.

To configure a Admin Projects path:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Machine tab.

3. Do one of the following:

t Click the down-arrow to browse the AMG browser.

t Click the magnifying glass to use the Windows browser.

t Click the Admin Default button to select the default Admin location.

4. Double-click the folder in which to keep the published compositions.

5. Click the Ok button.

When a designer publishes a composition for the first time, Avid Motion Graphics saves the 
composition to the _published folder and creates a special folder for the designer with 
their credentials. Each designer has their own folder where their compositions are 
automatically saved. Thus, if you want to load a published composition, you select the Load 
published option from File > Composition. Avid Motion Graphics opens the FileLoader 
window where you can select a designer, whose composition you want to load.
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To configure a Common Library path:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Machine tab.

3. Click the Path tab.

4. Click the black arrow to open the File browser window (or magnifying glass icon if you 
prefer to use a Windows browser).

The File window opens.

5. Select the network drive on which to keep the Common Library.

6. Double-click the folder in which to save your objects.

7. Click the Ok button.

When you save a custom object to the Common library AMG automatically creates a folder 
with the object type (‘obj’ for objects, ‘font’ for fonts, etc) and puts your item into the proper 
folder.
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To configure a Common Assets path:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

Common Assets path (empty by default) is where all shared media files are saved (clips, 
.jpg,.png files, etc) to be used by many designers without having to copy them to their local 
computers. 

2. Click the Machine tab.

3. Click the Path tab.

4. Click the magnifying glass to open the browser.

5. Navigate to the network drive and the folder in which Media will be saved.

6. Click the Ok button on the File window to set the Assets path.

7. Click the Ok button on the Path tab to save the Assets path.

Configuring Desktop Shortcut Preferences

The Desktop Shortcut preferences are configured using AMG Preferences in the Desktop 
Shortcuts tab.

To configure Desktop Shortcut preferences:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Machine tab.

3. Click the Desktop Shortcuts tab.
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4. Do one of the following:

t Shortcut layout — This allows the user to select the layout into which they want AMG 
open when double clicking the AMG shortcut. By default, this is set to None, which 
then uses the default layout.

t Create Open All — When this is selected, when the user double-clicks the shortcut, it 
opens that project and loads all compositions contained in that project.

t Create Open Lazy —When this is selected, when the user double-clicks the shortcut, it 
opens that project but does not load any of the compositions associated with that project. 
The compositions appear in the Stormlogic tab but the contents of the compositions are 
not loaded. This is typically used when the Avid Motion Graphics Server is used in a 
newsroom controlled workflow.

5. Click the Ok button.

Configuring Miscellaneous Preferences

The miscellaneous preferences are configured using AMG Preferences in the Misc tab.

To configure Miscellaneous preferences:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Machine tab.

3. Click the Misc tab.
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4. Do one of the following:

t Video Input #1 Enabled —If you use a Video In signal and you want to enable Video 
Input #1.

t Composition thumbnail size — The size of the Composition thumbnail.

5. In the Project Saving backup modes section:

t Enable backup creation when saving —When checked (default) it saves the copy of 
the project that was in memory to disk. The location it saves it to is 
C:\Users\<user>\AppData\Roaming\Avid\AMG\Backup

t Automatically save the project every (minutes) —The number of minutes to have the 
project automatically saved. Recommended to set at a number greater than 10.

t Restart button —resets the minute value to 0.

t Keep maximum number of stored backups to — the number of backups stored if the 
previously described number is set to something other than 0.

6. Click the Ok button.

Configuring the Reduced Renderer Preferences

The reduced renderer preferences are configured using AMG Preferences in the Reduced 
Renderer tab.

To configure Miscellaneous preferences:

1. In the Avid Motion Graphics user interface, select File > Preferences.

The AMG Preferences window opens.

2. Click the Project tab.
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3. Click the Reduced Renderer tab. 

4. Adjust the Render settings for Edit. These settings are auto set when using playout mode. 
For example, when in Playout mode, it does not need to use performance to render the edit 
pipe. Options are:

- Off

- OnMouse

- OnFocus

- Continuous

5. Click the Ok button when you are done adjusting the render settings.



6 Installing and Configuring Avid Motion 
Graphics Journalist

The following provides instructions for installing and configuring Avid Motion Graphics 
Journalist software and related applications.

The following main topics are described in this chapter:

• What You Need to Activate the Software License

• Setting Up the Avid Motion Graphics Journalist Server

• Installing AMG Journalist Client Software

• Setting Up the AMG Preview Renderer

• Setting Up the AMG Advanced Device Manager

• Installing the Avid Service Framework

• Setting Up the AMG Device Service

• Confirming Functionality

• Example of AMGConf.ini File for iNEWS Command
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What You Need to Activate the Software License

This section contain general steps for using Avid License Control to license AMG, AMG 
Journalist, and AMG Preview Renderer. To activate the software using the Avid License Control 
tool, you need the items listed in the following table:

c If you change your system configuration — for instance, by replacing your hard drive, a 
network adapter, or by upgrading your operating system — you must first deactivate your 
Avid software. 

n Your network administrator might need to open a few ports that are used during the license 
activation. The Avid License Control tool utilizes both port 3443 and port 443 for license request 
and response communication. Port 3443 is the primary port, but if this port is blocked, the 
Activation Service tries port 443, which is more likely to be open for Web communication.

Identification Number Type Where you can find it:

Activation ID The Activation ID is provided on an Activation ID and System ID 
card shipped with your new Avid Motion Graphics system. The 
Activation ID is used to activate the software license and has been 
linked to your System ID.

System ID The System ID is provided on an Activation ID and System ID card 
shipped with your new Avid Motion Graphics system. The System 
ID is used for expediting warranty verification and customer service. 
After activation, the License Profile tab of the Avid License Control 
tool displays information about your system. Click “Copy to 
Clipboard” to copy the information to your clipboard. You can then 
paste from the clipboard to an e-mail or create a text file. This is 
helpful if you need to save this information for your records or need 
to send system information to Avid Customer Support.

Device ID The Device ID is only needed if you are activating your software on a 
system that is not connected to the Internet. This is provided through 
the Avid License Control tool during activation.



Setting Up the Avid Motion Graphics Journalist Server

106

Setting Up the Avid Motion Graphics Journalist 
Server

After setting up and configuring the operating system settings for your Avid Motion Graphics 
system, you can set up the Avid Motion Graphics Journalist software and related applications.

Avid supplies one blank USB flash drive that can be used for installing Avid Motion Graphics 
Creation, Journalist, or News Control software.

n The Avid Motion Graphics software is available on the Avid Download Center 
(www.avid.com/support/downloadcenter).

To Install This Software See The Following Section

Avid Motion Graphics 
Journalist Server

See “Installing Avid Motion Graphics Journalist Server Software” on 
page 107.

Once installed, you need to license the software as described in 
“Licensing AMG NRCS Clients and AMG Clips” on page 115. 

Then you must configure the software as described in “Configuring the 
Avid Motion Graphics Journalist Server” on page 117.

Then, you must start the AMG Journalist Server software, as described in 
“Starting the AMG Journalist Server Applications” on page 120.

Avid Motion Graphics 
Journalist Client

See “Installing AMG Journalist Client Software” on page 120. 

AMG Preview Renderer See “Installing the AMG Preview Renderer” on page 121. 

AMG Advanced Device 
Manager

See “Setting Up the AMG Advanced Device Manager” on page 128. 

Once installed, you must configure the AMG Advanced Device Manager, 
as described in “Configuring the AMG Advanced Device Manager” on 
page 130. 

Avid Service Framework See “Installing the Avid Service Framework” on page 133. 

Once installed, you can configure the Avid Motion Graphics Device 
Service, as described in “Configuring the AMG Device Service” on 
page 141.

AMG Device Service See “Setting Up the AMG Device Service” on page 137.

Avid Motion Graphics News 
Control

See Chapter 7 the Avid Motion Graphics Setup Guide, or Chapter 2 of the 
Avid Motion Graphics News Installation Guide.
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Avid Motion Graphics Journalist Server Installation Tasks

The following steps describe how to install the Avid Motion Graphics Journalist Server (AMG 
Journalist Server) for integration with Avid iNEWS Command and Avid iNEWS newsroom 
computer system or ENPS. This assumes that the Avid Motion Graphics servers have already 
been installed and licensed.

You must be logged on to the Avid Motion Graphics server as Administrator.

The AMG Journalist Server installation process includes the following tasks:

• “Installing Avid Motion Graphics Journalist Server Software” on page 107

• “Licensing AMG NRCS Clients and AMG Clips” on page 115

• “Configuring the Avid Motion Graphics Journalist Server” on page 117

• “Starting the AMG Journalist Server Applications” on page 120

Installing Avid Motion Graphics Journalist Server Software

This section contains the basic procedures that must be followed to install the AMG Journalist 
Server.

Prior to starting the AMG Journalist installation, confirm the Win2008 R2 64 bit installation, and 
then install both the vcredist_x64 and vcredist_86 installers.

To confirm the Win2008 R2 64 bit installation:

1. Open a command prompt by selecting Start > Run. 

2. Type cmd.

3. Press Enter.

4. Type ver

5. Press Enter.

The version of the server should be 6.1.7601. 
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6. Before continuing with the AMG Journalist installation, enable Windows Media Player on 
the AMG Server as follows:

a. Launch Server Manager. 

n Windows Media Player must be enabled before proceeding. This is part of the Desktop 
Experience feature for Windows Server 2008.

b. Click on Features > Add Feature > Desktop Experience.

c. Accept Ink and Handwriting Service as well. 

d. Click Add Required Features, and click Next.

e. Click Install.

f. Reboot your AMG server.

To Install the Avid Motion Graphics Journalist Server:

1. Navigate to the installer for AMG Journalist Server, and double-click 
AMG_Journalist_Server_setup.exe.

The Avid Motion Graphics Journalist Installer splash screen opens:

2. Select the option to install Microsoft Visual C++ 2008 Redistributable.
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3. Select the option to install the Avid Motion Graphics Journalist Server.

The License Agreement dialog box opens.

n This will share the AMGNews folder and configure the X: drive. It also installs the AMG Drive 
Monitor.

4. Accept the terms of the license agreement, and click Next.

The Destination folder dialog box opens.
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5. Click Next to accept the path where the AMG Journalist Server will install the application 
files. 

For more information on this setting, please consult with your Customer Success 
Representative.

The AMG Share dialog box opens:
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6. Click Next to accept the default AMG Share and Drive Letter (X:), where the AMG 
Journalist Server will install the application files.

For more information on this setting, please consult with your Customer Success 
Representative.

The Ready to Install the Program dialog box opens:

7. Click Install to complete the AMG Journalist Server installation.

The screen refreshes with more options.
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8. On the Avid Motion Graphics Journalist splash screen, click the option PostgreSQL 8.4.4.

The Avid Motion Graphics Journalist splash screen appears as follows:

9. Click the first option Install PostgreSQL 8.4.4.

It will install the next three options automatically.

- PostgreSQL Service

- PostgreSQL Windows User

- PostgreSQL Windows Password
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10. Click the option to install PostgreSQLSubnet Selection.

The AMG PostgreSQL Database Access Configuration dialog box opens.

11. Select the Save pg_hba.conf option at the bottom left of the screen.

12. Press Enter to close the Command window.

13. Select the Back to Main Screen option the return to the AMG Journalist Installer Server 
Main menu.

14. Select Create AMG Databases.

15. Select Click here to Install AMG Journalist Databases.

Wait until the AMG Journalist databases are installed. When it is done, the message “AMG 
Database Creation Complete” appears.

16. Select Return to return to the AMG Journalist Server Installer main menu.
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17. Click the option to install AMG ODBC.

The AMGNews Journalist Server J-SERVER dialog box opens.

18. Select Yes on the pop-up menu.

19. Select Exit to exit the AMG Journalist Installer and return to the Windows desktop.
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Licensing AMG NRCS Clients and AMG Clips

The Avid Motion Graphics Journalist Server requires the AMG NRCS license.

The Avid Motion Graphics Journalist System ID label, as shown in the following illustration, is 
used as the System ID number to activate the Avid Motion Graphics NRCS Clients, and AMG 
Clips options. 

n The AMG Preview Renderer requires a separate license for it to be activated on the computer 
where the Preview Renderer software is installed.

The Avid Motion Graphics NRCS Client and AMG Clips activation is performed on the AMG 
Journalist Server.

To activate the license for Avid Motion Graphics NRCS Clients:

1. Locate your System ID and Activation ID card(s) included with your new hardware (in a 
separate box).
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2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control dialog box opens.

3. Click the Activate button to activate the Avid Motion Graphics NRCS license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. For more information, see “Software Licensing” 
on page 83.

n After your Avid software is activated, the License Profile tab displays your System ID, Activation 
ID, and Device ID.

4. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 87.

5. Enter your system identification number in the System ID text box.

6. Enter your activation identification number in the Activation ID text box.
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7. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the “Activate” 
button changes to a “Deactivate” button.

8. Back up your license profile information, and save it somewhere that you can access it.

Configuring the Avid Motion Graphics Journalist Server

After installing the server software, you must configure the Avid Motion Graphics Journalist 
Server.

To configure the Avid Motion Graphics Journalist Server:

1. On the Avid Motion Graphics Journalist Server, navigate to: 
C:\AMGNews\bins\cfg\AMGConf.ini.

2. In the GENERAL section:

t Set VIDEO FRAMES to NTSC or PAL.

t Set the SLUG FORMAT to <tpl>.

n All values in the AMG.ini files must be surrounded by quotes. When editing values, remember to 
keep the quotes in tact.

3. In the MOS DEVICE section:

t Confirm the NAME is set to AMGNews. 

n This assumes the desired MOS ID is AMGNews.

t In the CHANNELS field, enter the channels names that you intend to use in the system. 
Each name must be separated by a comma and space (e.g., 1, 2, 3, for graphics 
channels).

n iNEWS Command will need to use the same channel names, so it's a good idea to write down or 
remember the channel names used here.

4. In the PREVIEW SNAPS section:

t Set the IP to the specific address for the local AMG Journalist Server (do not use 
127.0.0.1, or a host name).

n This IP is for the AMG News Preview Server application, which runs on the AMG Journalist 
Server. The IP does not point to the AMG Preview Renderer itself - that IP is set in a different .ini 
file, and explained in Step 11.
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5. In the GATEWAY section:

t Set the IP to the specific address for the local AMG Journalist Server.

n Do not use 127.0.0.1, or a host name)

t For iNEWS, leave the NCS and MOS ports at their current values (e.g., NCS UPPER 
PORT Should be 10441 for iNEWS, and NCS LOWER PORT should be 10440 for 
iNEWS).

t For ENPS, change the NCS UPPER PORT to 10541, and the NCS LOWER PORT to 
10540.

6. In the MANAGER section:

t Set the IP to the specific address for the local AMG Server. 

n Do not use 127.0.0.1, or a host name.

t For iNEWS, confirm that IS NCS is set to YES.

t For ENPS, change IS NCS to NO.

7. In the CONTROL section (where NAME = CTRL1):

t For Command, comment out this entire section with a ; at the beginning of each line.

8. In the CONTROL section (where NAME = COMMAND1):

t Set the IP to the specific address for the Avid Motion Graphics computer.

t If you have a second device, you need to add a new section with the name 
COMMAND2, for the second device. This is done by doing the following:

- Copy the [CONTROL] section, and paste it just below the original CONTROL section.

- Change the NAME field to COMMAND2.

- Change the IP field to that of the second AMG Playout chassis.

9. In the RENDER sections (There are two.):

t For Command, comment out this entire section with a ; at the beginning of each line.
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10. In the NCS section:

t In the NAME field, enter the NRCS server name. 

n This is the iNEWS system name which you can get by typing status on the iNEWS console.

t For iNEWS, leave the IP as is at 127.0.0.1.

t For ENPS, enter the IP for the ENPS server. For the buddy server, add the following:

"BACKUP NAME" = "ENPS BUDDY SERVER NAME"

"BACKUP IP" = "ENPS BUDDY SERVER IP"

t If you want to see more than the first 2 replaceable fields in the Command playlist, 
change the ABSTRACT FMT field from <2values> to the desired number.

t For ENPS, confirm that the <ch> variable has been added to the beginning of the 
ABSTRACT FMT line. 

For example: “ABSTRACT FORMAT” = “<ch>:<tpl>:<2values>”

11. Select File > Save, and then close the AMGConf.ini file.

12. On the AMG Journalist Server, go to C:\AMGNews\bins\conf\Previewunits.ini.

There are 2 UNITs sections. In each UNIT field, the default UNIT1 and UNIT2 are for 
Render Engines A, and B on the Preview Renderer machine.

In both IP fields, enter the IP address for where the AMG Preview Renderer will be running.

13. In the [UNIT] section, for UNIT1, and UNIT2, set the IP address to the IP address of the 
Preview Renderer machine.

If any additional Preview Renderers are added, you need to create two additional UNIT 
sections. This is done by doing the following:

- Copy the [UNIT] section, and paste it just below the original UNIT section.

- Change the UNIT1 field to UNIT3.

- Change the UNIT2 field to UNIT4.

- Change the IP field to that of the second Preview Renderer.

14. Select File > Save, and then close the Previewunits.ini file.

15. Double-click on My Computer and navigate to the X: drive.

16. Open TPL_example, and copy and paste the contents to the TPL folder on the X: drive.

17. Launch the AMG Monitor application. For more information, see “Starting the AMG 
Journalist Server Applications” on page 120.
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Starting the AMG Journalist Server Applications

After the AMG Journalist server configuration is complete, you can start the AMG Journalist 
Server applications.

To start the AMG Journalist Server applications:

1. Turn on the Avid Motion Graphics Journalist server.

2. Double-click the AMG Application Monitor shortcut on the desktop, and enable and start 
the Avid Motion Graphics Journalist Server applications.

- AMG Gateway: manages communication between NRCS, database, and Command.

- AMG News Licenser: gives out Avid Motion Graphics Journalist client license seats.

- AMG Preview Renderer: manages Avid Motion Graphics Preview Renderer requests

3. Select AMG Gateway, and click Enable Application.

4. Select AMG News Licenser, and click Enable Application.

5. Select AMG News Preview Server, and click Enable Application.

6. The Avid Motion Graphics Journalist Server applications should start automatically.

Installing AMG Journalist Client Software

The following steps describe how to install the Avid Motion Graphics Journalist Client for 
integration with Command, and iNEWS or ENPS. 

The network drive should be connected before starting this setup. Make sure the network drive is 
mapas follows: network drive \\***.***.***.***\AMGNews, where * is AMGJournalist server 
IP.

n If you configure AMG Journalist for iNEWS, you can use it as a plug-in to Interplay Central, but 
you must first enable your browser to accept MOS plugins.

To install the AMG Journalist Client plug-in:

1. Navigate to the network drive (via UNC path - \\servername\AMGNews).

2. Open the install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe to run the executable.

4. In the AMG Journalist Applications window, click the AMG NRCS Client to install it.

5. Select Microsoft Visual C++ Redistributable to install it.

6. Select AMG Drive Monitor to install it. Make sure the IP address for the AMG Journalist 
server is populated. Follow the prompts (Install, Next, Finish) to complete the installation.
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7. Select AMG ODBC to install it. 

n A database password is not necessary, and should not be entered.

8. Select AMG NRCS to install, and click Finish to complete the installation.

9. Select Exit to close the installer.

You can now test the AMG Journalist Client. 

10. (Optional) If you are using AMG Journalist Client (a MOS plugin) with iNEWS and 
Interplay Central, you need to configure your web browser to accept MOS plugins.

t If you are using Chrome as your browser, you must install the Chrome Extension for 
Interplay Central MOS plug-in. For more information, see Appendix F of the Interplay 
Central Services Installation and Configuration Guide.

t If you are using Internet Explorer as your browser, you must enable Interplay Central 
MOS plug-ins in Internet Explorer. For more information, see Appendix G of the 
Interplay Central Services Installation and Configuration Guide.

Setting Up the AMG Preview Renderer

This section contains the following topics:

• “Installing the AMG Preview Renderer” on page 121

• “Licensing the AMG News Preview Renderer and AMG Clips” on page 123

• “Starting the Avid Motion Graphics Preview Renderers” on page 127

• “Creating Project Shortcuts on the AMG Preview Renderer” on page 127

Installing the AMG Preview Renderer

The following describes installing the Avid Motion Graphics Preview Renderer on a dedicated 
computer.

For baseline computer requirements, see an Avid Sales associate.

Before starting this procedure, the X-drive should be connected. Make sure the network drive is 
mapped as follows: \\***.***.***.***\AMGNews, where * is AMG Journalist server IP address.

To install the Avid Motion Graphics Preview Renderer:

1. Navigate to the X-drive (via UNC path - \\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.
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4. Select Yes. 

The User Account Control dialog box opens.

n The installer may detect some items already installed. If the menu item as a green check next to 
it, it is already installed and you can move on to the next step. In the example above, the first four 
items have already been installed.

5. In the AMG Journalist Applications window, click Avid Motion Graphics News Preview 
Renderer to install it.

6. Click Microsoft Visual C++ 2008 Re-distributable to install it.

7. Click the Avid Motion Graphics Drive Monitor to install it. 

8. You will need to enter the IP address for the Avid Motion Graphics Journalist server.

The Host name or IP address for the Avid Motion Graphics Journalist Server will appear in 
the AMG Drive Monitor dialog box. Follow the prompts, clicking Next, to proceed. Then, 
click Install. When finished installing, click Finish. 

9. Click Avid Motion Graphics ODBC to install it. Follow the prompts, clicking Install, and 
then click Next to proceed.

n A database password is not necessary, and should not be entered.

10. Click Avid License Control to install it.

11. Click Avid Motion Graphics News Preview Renderer to install it.



Setting Up the AMG Preview Renderer

123

12. Click Avid Motion Graphics Font Package to install it.

n If you planing to use Avid Deko compositions in AMG, you need to install Deko Player 6.3.0 and 
Deko Chart Designer 1.1.0. If you are not upgrading from Avid Deko you can skip these to 
installs.

13. Click Exit to close the installer licensing.

14. Open the Avid License Control tool.

15. Add the Preview Renderer licenses (Preview and Clips). If you do not have a Preview 
Renderer license, contact your sales representative to obtain a license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 

Licensing the AMG News Preview Renderer and AMG Clips

Once you have installed the AMG Preview Renderer on a dedicated computer, you need to 
license the AMG News Preview Renderer, and the AMG Clips option should be activated on 
AMG chassis.

Before you begin, you should have the following two Activation labels:

• AMG News Preview Renderer Activation label

• AMG Clips Activation label
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You will also need to the System ID from the AMG Journalist System ID label. The Avid Motion 
Graphics Journalist System ID label, as shown in the following illustration, is used as the System 
ID number to activate the AMG News Preview Renderer and AMG Clips products.

The activation is performed on the computer that you installed the AMG Preview Renderer on.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. For more information, see “Software Licensing” 
on page 83.

To activate the license for AMG News Preview Renderer and AMG Clips:

1. Locate your System ID and Activation ID card(s) included with your new hardware (in a 
separate box).
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2. Open the Avid License Control tool, click Start > Programs > Avid > Utilities > Avid 
License Control.

The Avid License Control tool opens.

n After your Avid software is activated, the License Profile tab displays your System ID, Activation 
ID, and Device ID.

3. Click the Activate button for AMG News Preview Renderer license.
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4. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 87.

5. Enter your system identification number in the System ID text box.
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6. Enter your activation identification number in the Activation ID text box.

7. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

8. Repeat Steps 3-7 to activate the AMG Clips license on the AMG chassis.

9. Back up your license profile information, and save it somewhere that you can access it.

Starting the Avid Motion Graphics Preview Renderers

After starting Avid Motion Graphics and the Avid Motion Graphics Journalist Server, you must 
start the Avid Motion Graphics Preview Renderers A and B.

To start the Avid Motion Graphics Preview Renderers A & B

1. On the Avid Motion Graphics Preview Renderer computer, select Start > AMGNews 
Preview Renderer A.

2. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

3. On the Avid Motion Graphics Preview Renderer computer, select Start > AMGNews 
Preview Renderer B.

4. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

Creating Project Shortcuts on the AMG Preview Renderer

After the on-air project is finalized, you can create Start Menu shortcut to open the project on the 
AMG Preview Renderer.

To create project shortcuts on the AMG Preview Renderer:

1. Navigate to X:\TPL\basic.ldr.

2. Create a shortcut to that file on the desktop.

3. Double-click the file to open the project in Preview Renderer A.

4. With the project open, double-click the shortcut again, to open the project in Preview 
Renderer B.

5. Drag the Preview Renderer A shortcut to the Start menu.

Now you can click Start, point to the Preview Renderer A, and select the project to open 
both Preview Renderers.
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Setting Up the AMG Advanced Device Manager

This section contains information on how to install, license, and configure the AMG Advanced 
Device Manager. 

This section contains the following topics:

• “Installing the AMG Advanced Device Manager” on page 128

• “Licensing the AMG Advanced Device Manager” on page 129

• “Configuring the AMG Advanced Device Manager” on page 130

Installing the AMG Advanced Device Manager

This topic contains information on how to install and configure Avid Motion Graphics Device 
service on each Avid Motion Graphics playout chassis.

To install the AMG Advanced Device Manager:

1. Navigate to the Avid Motion Graphics Journalist Server installation path (via UNC path - 
\\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.

4. In the AMG Journalist Applications window, click AMG Playout.

5. (Option) If not already installed, click Microsoft Visual C++ Redistributable to install.

6. (Option) If not already installed, click Avid Motion Graphics Drive Monitor to install. You 
will need to enter the IP address for the Avid Motion Graphics Journalist server 

7. Click Avid Motion Graphics ODBC to install. A database password is not necessary, and 
should not be entered.

8. Click the AMG Advanced Device Manager option to install the AMG Advanced Device 
Manager onto the AMG Playout server.

n Wait for all of the components to install before continuing. After each component successfully 
installs, a green circle, containing a white check mark, replaces all of the red circles, containing 
white Xs. If a component is already installed, it is detected and the green circle with the check 
mark appears immediately.

n Avid License Control should already be installed, and have a green check mark next to it.

9. Open the Avid License Control tool and confirm that you have the respective AMG licenses 
added (green check mark). If not done, add the AMG ADM license. For more information, 
see 
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n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 

Licensing the AMG Advanced Device Manager

This topic contains information on how to license the AMG Advanced Device Manager.

If you have not already done so, open Avid license control under Start > All Programs > Avid > 
Utilities and add the AMG NRCS license. That is the only license component that is needed on 
the AMG Journalist Server. 

n If you do not have an NRCS license, contact your sales representative to obtain a license. 

n The license is most easily added with an internet connection, so that the machine can connect to 
the Avid license server and verify the license.

To license the AMG Advanced Device Manager:

1. Open Avid License Control by navigating to Start > All Programs > Avid > Utilities. 

2. Locate Avid Motion Graphics, ADM in product list and activate it by pressing the Activate 
button.

3. In the “How would you like to proceed?” section, select the I am connected to the Internet 
and will use this computer option, and then click Continue.

n If you select “I am not connected to the Internet and will be using another computer that is 
connected to the Internet” continue with “License Activation Without an Internet Connection” 
on page 87.
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4. Enter your system identification number in the System ID text box.

5. Enter your activation identification number in the Activation ID text box.

6. Click the Activate button.

The Activation tool confirms your system information. When the activation is complete, a 
message informs you that your software has been successfully activated and the Activate 
button changes to a Deactivate button.

Configuring the AMG Advanced Device Manager

Once you have installed and licensed the AMG Advanced Device Manager on your AMG 
Playout chassis, you must configure it.

Configuring the AMG Advanced Device Manager:

1. From the Start menu select All Programs > Avid > Advanced Device Manager 
Configuration Tool. The Advanced Device Manager Configuration dialog box opens. 
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There are two protocol selection tabs available. The Primary Protocol Selection is used to 
configure AMG Channel A with Avid Command. 

n If the AMG Playout chassis is optioned for Dual Channel, and you want to control the second 
channel using a different protocol, this can be accomplished by selecting the Secondary Protocol 
Selection tab. Select AMG News Output Channel B.

2. In the Protocol In field (for use with Command), select GAP (Graphics Automation 
Protocol).

3. In the ADM PORT field, set the value to 5200.

4. In the AMG Config.ini Location field, make sure it points to X:\bins\cfg\AMGConf.ini.
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5. In the MOS DEVICE field, type AMGNews.

6. In the Protocol out field, select AMG.

7. In the Receive PORT field, select 5555.

8. In the AUTO LOAD field, select True.

9. In the Pattern Match field, type X:\RSC\IMG. Then, in the >> field, type C:\TMP.

10. In the TPL Folder field, make sure it points to X:\TPL.

11. In the METATPL Folder field, make sure it points to X:\METATPL.

12. In the TPL EXTENSION field, scn.

13. , To set up the first output channel (A), do the following: 

a. In the AMG Output Channel section, select A to set up the first output channel.

b. In the PGM-A IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

c. In the PGM-A PORT field, select 5124.

d. In the PVW-A IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

e. In the PVW-A PORT field, select 5124.

14. (Option) If the chassis is a single channel AMG Playout chassis, go to the Step 16: 

15. To set up the second Output channel (B), do the following: 

a. Enable the B Channel by selecting Yes in the Enable B Channel? menu.

b. In the AMG Output Channel section, select B to set up the second output channel.

c. In the PGM-B IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

d. In the PGM-B PORT field, select 6124.

e. In the PVW-B IP or Name field, type the IP address of the local AMG chassis. You can 
use the local host name, as well.

f. In the PVW-B PORT field, select 6124.

16. Click the Save Configuration button and close the Advanced Device Manager 
Configuration Tool.
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Installing the Avid Service Framework
If you are running iNEWS Command, the Avid Motion Graphics chassis needs at least the core 
components of Service Framework installed, so that it is able to connect to a computer running 
the Avid Lookup service. 

To install the Avid Service Framework:

1. Insert the Command installation CD (or access the install program from the network).

The autorun installation program starts and displays the following screen.

n The Command Documentation button will open a window displaying the contents of the Doc 
folder on the Command installation CD in which product documentation is provided in PDF 
format.

If the autorun does not begin, manually navigate to and run the ServiceFrameworkSetup.exe 
install program.

2. Click the Avid Service Framework button. 

n Other dialog boxes could appear depending on whether older versions of Service Framework are 
found, particularly if upgrading existing software. If one appears, read it carefully and reply 
accordingly with regard to upgrades, etc.
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A splash graphic will appear briefly as the installer prepares the InstallShield Wizard. Then 
the Welcome dialog box appears.

3. Click Next.

The Destination Folder dialog box opens.
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4. Set the location to which Avid Service Framework will be installed and click Next.

The Workgroup Name dialog box opens.

5. Type the name of the Command workgroup in the field.

c If you are updating the Service Framework software, the installer remembers the last 
installed value. If the workgroup name was changed after the install, the installer will not 
be aware of the change.
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6. Click Next. 

The Options dialog box opens.

7. Select the option: Avid Service Framework Client and click Next.

The Custom Setup dialog box opens.
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By default, the Time Synchronization service is selected to be installed; however, this 
service should only be installed if you do not already use something to synchronize your PC 
clocks. If you use NTP or some other method for time synchronization, do not install this 
service. For more information about the services in this dialog box, see the tables in 
“Installing the Avid Service Framework” on page 133.

8. Click Next and follow the installation instructions to complete the installation.

n You might be required to restart your system to complete the installation.

After installation, verify that the services are running on each computer where Service 
Framework services were installed.

Setting Up the AMG Device Service

This section contains information on how to install and configure the AMG Device Service. 

This section contains the following topics:

• “Installing Avid Motion Graphics Device Service” on page 137

• “Configuring the AMG Device Service” on page 141

Installing Avid Motion Graphics Device Service

This section provides the standard procedure for installing the Avid Motion Graphics Device 
Service on each Avid Motion Graphics playout chassis.

To install the Avid Motion Graphics Device Service on the AMG playout chassis:

1. On the AMG playout chassis, install iNEWS Command and select the AMG Device Service 
from the install menu.

When the autorun program starts, select the Avid iNEWS Command button. The 
InstallShield Wizard starts and displays the Welcome screen.
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2. Click Next.

The License Agreement appears.
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3. Read the License Agreement, accept the terms, and click Next.

If you do not accept the terms, the installation program will not continue.

n You can print the terms if you want to read them later or keep a copy for your records.

The Destination Folder dialog box opens.
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4. Do one of the following:

t Click Change to designate an install directory, and then click Next.

t Accept the default location by clicking Next.

The Options dialog box opens.

5. Select Avid Motion Graphics, and click Next.

The Custom Setup dialog box appears with the default services selected for installation of 
client software. However, for CII integration, you must modify the selections to customize 
your installation. 

If you select Avid Motion Graphics, no more services would be selected. Only AMG device 
service
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6. Click Next to continue.

7. When the Ready to Install the Program dialog box appears, click Install.

8. When the installation is complete, click Finish.

You are now ready to install the appropriate plug-in or the Graphic Inventory Editor (GIE), if 
necessary.

Configuring the AMG Device Service

Once you have installed the AMG Device Service on each Avid Motion Graphics playout 
chassis, you must next configure it. 

To configure the AMG Device Service:

1. Select Start > All Programs > Avid Service Framework.

2. Open the Avid Service Configuration application.

3. Navigate to the local machine, open the drop down menu, and select the Avid Motion 
Graphics Device Service.

4. Enter a Device name (in lowercase), such as “amg1”, and set the channel count to 1 for 
single-channel, or 2 for dual-channel playout chassis.

5. Click the AMG Device Service Settings tab.
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6. In the ADM IP field, type the local machine’s specific IP address.

7. In the NET CONNECT AS, type the computer name\user name for the AMG Journalist 
Server, so that the device service connects to the AMG Journalist Server with the right 
credentials. 

n If the Journalist Server uses a local log in, enter the local computer name and user name, such 
as AMGJourn\Admin. A domain login also works here.

8. In the NET PASSWORD field, type the password for that user name (if there is one). 
Otherwise, leave it blank.

9. In the NET SHARED RESOURCE field, type the AMG Journalist computer name and 
share name. For instance, \\AMGJourn\AMGNews.

n Make sure the case matches.

10. Confirm that the SYSTEM MOS ID is correct. It should be the same (including the case) as 
was configured in the AMGConf.ini and the ADM Configuration.

n After changing any value, select a different field before clicking Apply, so that the last change is 
kept. Or press Enter.

11. After the configuration is complete, click the Apply button.

The service restarts automatically.

12. Close the window. 

Confirming Functionality

Once you have created a project to test with, you can confirm functionality by doing the 
following:

• Starting the Avid Motion Graphics Journalist Server

• Starting Avid Motion Graphics

• Starting the Avid Motion Graphics Preview Renderers

• Testing the AMG Journalist Client

• Testing Command Inventory, Playout, and Editing
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Starting the Avid Motion Graphics Journalist Server

Starting the Avid Motion Graphics Journalist Server is the second task in confirming 
functionality.

To start the Avid Motion Graphics Journalist Server:

1. Turn on the Avid Motion Graphics Journalist Server.

2. Click the Avid Motion Graphics Monitor shortcut to start the following server applications:

- Avid Motion Graphics Application Monitor

- AMG Gateway

- AMG News Licenser

- AMG News Preview Server

Starting Avid Motion Graphics

Starting the Avid Motion Graphics server is the first task in confirming functionality.

To start Avid Motion Graphics:

1. Turn on the Avid Motion Graphics computer.

2. Start the Avid Motion Graphics application.

3. Click File, > Project > Open and navigate to the X:\TPL folder to open the project.

4. Click the Playout button. This step is required for any playout operation.

5. Run the Advanced Device Manager. This initiates the Open All command. You are now 
ready to play items in Command. If you have to close and open the UI for any reason, do the 
following:

- Open the Avid Motion Graphics application from your shortcut.

- In the Avid Motion Graphics user interface, switch to Playout mode.

- In the open Advanced Device Manager, click the Connect button, which initiates the 
Open All.
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Starting the Avid Motion Graphics Preview Renderers

After starting Avid Motion Graphics and the Avid Motion Graphics Journalist Server, you must 
start the Avid Motion Graphics Preview Renderers.

To start the Avid Motion Graphics Preview Renderers A & B”

1. On the Avid Motion Graphics preview Renderer computer, click Start > AMGNews 
Preview Renderer A.

2. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

3. On the Avid Motion Graphics preview Renderer computer, click Start > AMGNews 
Preview Renderer B.

4. Select File > Project > Open All, and navigate to the X:\TPL folder to open the project.

Testing the AMG Journalist Client

After starting the Avid Motion Graphics Preview Renderers, you can test the functionality of the 
Avid Motion Graphics Journalist client.

To test the AMG Journalist client:

1. Open the AMG Journalist client.

If you are using the iNEWS NRCS client to open the AMG Journalist plug-in, go to Tools > 
Plugins > AMG Journalist.

The Plugin window will open and become a part of your workspace. 

To check functionality, compare the TPL folder content with what you see in the plugin. The 
AMG Journalist plug-in should open the TPL folder and scan for AMG projects. So you 
should be able to see any project compositions.

2. Double-click an item to open it in the template editor.

3. Add replacement data and click Save.

The new item should appear in the Graphic Database area list with a unique ID for the item.

4. Open the new item and edit the first replaceable field.

5. Click Save and confirm that the data has updated.

6. Open the created item and click the Preview button. 

Preview will not be enabled if it has not been installed.

7. Confirm that the correct replacement data appears.

8. Open the created item and click the Movie button.

Movie will not be enabled if it has not been installed.
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9. Confirm that the item appears with motions and correct replacement data.

10. Create several more items and drag them into the rundown.

11. Create a hand-entered item.

12. Designate one of the items as a library graphic and drag into a playlist.

13. MON Load the show, and confirm that all graphics appear in the Command playlist.

Testing Command Inventory, Playout, and Editing

After confirming functionality of the Avid Motion Graphics Journalist Client, you must test the 
Command inventory, playout, and editing functionality.

To test Command inventory, playout, and editing:

1. In the Inventory Panel, confirm that you can see the templates from the your project, and the 
library graphic you created.

2. Confirm that thumbnails appear in the playlist.

3. Lock channel group by doing the following:

a. Confirm that the replacement fields update (if not already updated).

b. Cue and play items – confirm on output.

4. Open item in media viewer and change replacement data by doing the following:

a. Confirm that data is updated in the playlist.

b. Confirm that the thumbnail updates.

c. Open the item in the Avid Motion Graphics Journalist client, and confirm that the 
replacement data has also changed here.

5. Play the cued item. Confirm that it appears on the output, and that the next item cues as 
expected. 

6. Eject the item from the program channel.
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Example of AMGConf.ini File for iNEWS Command

This topic contains an example of the AMGConf.ini configured for iNEWS Command.

; This a sample base file for AMG, iNews, and iNews Command.

;

[GENERAL]

"ENCODING"= "UTF8";UTF8 or ASCII

"VIDEO FRAMES"= "NTSC";PAL or NTSC, it is used to calculate the length of 
the graphics

"LOG FILES"= "3";Max num log files

"TEXT DB"= "P_TEXTS";Database that can be used to fill templates

"AUTO SLUG"= "MIXED";TRUE, FALSE or MIXED

"SLUG FMT"= "<tpl>:<id>";Format used to generate auto slugs

"AUTO SNAPS"= "FALSE";TRUE to enable auto snaps feature

"OBJ READY"     = "TRUE";TRUE if graphics must be created "Ready for Onair" 
by default

"WAIT ACK"= "FALSE";Wait for ACKS

"FORMAT"= "jpg";Snapshot format

"TPL EXTENSION"= "scn"

[PREVIEW SNAPS]

"NAME"= "SNAPS"

"IP"= "xxx.xxx.xxx.xxx"   ;AMG PreviewServer Application IP address

"PORT"= "6125";Port where to send the requests

"ACK PORT"= "5125";Port where the plug-in will get the answer
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"SNAPS PATH"= "X:\preview";net path where to find the snap files

"OBJS PATH"= "X:\preview\objs"  ;net path where to find the graphics images

"VIEW X-RES"= "400";Resolution used by the plug-in to show the

"VIEW Y-RES"= "225";generated snaps

;"EXPORT FMT"= "<date>_<time>_<user>" ;patern to generate exported movie 
names

;"EXPORT PATH"= "";SNAPS PATH will be used if this is not defined

;"EXPORT MASTER" = "USER";USER or SERVER. Who copies the final file to 
EXPORT_PATH

[GATEWAY]

"NAME" = "GW1"   ;This name will be used by other components

"IP" = "xxx.xxx.xxx.xxx";AMG Gateway Application IP address (journalist 
server) 

"NCS UPPER PORT" = "10441"   ;MOS Protocol Ports 

"NCS LOWER PORT" = "10440"

"MOS UPPER PORT" = "10541"

"MOS LOWER PORT" = "10540"

[MOS DEVICE]   ;THIS DEVICE IS FOR COMMAND

"NAME"= "CMD"            ;Render Unit name (this needs to match MOSID in 
system.map file)

"GATEWAY"= "GW1"   ;Gateway that creates content for this Render Unit

"TPL FOLDER"= "X:\Tpl"   ;Net path where the templates can be found

"RSC FOLDER"= "X:\RSC"   ;Net path where resources used to create graphics 
can be found
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"OBJ FOLDER"= "P_RENDER2"

"DB TYPE"= "ODBC"   ;System used to manage the graphics. FILE (deprecated) 
or ODBC. 

"VERSION"= "2.6"   ;Protocol Version. "2.6" or "2.8" for MOS, "CA" for 
ControlAir

"CHANNELS"= "1,2"

[CONTROL]

"NAME"= "COMMAND1"   ;Name used by the Render Unit to reference this 
Controller

"MOS DEVICE"= "CMD"      ;Name used by the Gateway where the Controller 
sends commands

"IP"= "xxx.xxx.xxx.xxx" ;IP where the Controller is running - (the AMG 
Chassis)

"PORT"= "8888"

"ALL UPDATES"= "TRUE"

[MANAGER]   ;License Manager settings.

"NAME"= "MAIN"

"IP"= "xxx.xxx.xxx.xxx" ;AMG News Licenser Application IP address

"PORT"= "5140"

"IS NCS"= "YES"   ;If using iNEWS, it's YES. If using ENPS, NO.  Refers to 
whether 

   ;or not the License server will act as an NCS server.

[NCS]   ;THIS NCS SECTION IS FOR COMMAND

"NAME"= "NRCS4"   ;iNEWS server name, ENPS server name or RCG Manager Name
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"IP"= "127.0.0.1"       ;localhost

"AUTO ABSTRACT" = "TRUE"      ;Generate the abstract field for iNews and 
ENPS

"ABSTRACT FMT"= "<tpl>:<2values>" ;Format used to generate the auto 
abstract

"DB TYPE"= "ODBC"      ;it MUST be "ODBC". Only used in stand-alone mode

"DB PATH"= "P_NCS"   ;ODBC source name.

"VENDOR" = "MOS"   ;Speciall behaviour for some vendors [MOS, VSN]

;[DICTIONARY]

;"NAME"= "MyDICT"

;"REPLACE"= "X:\RSC >> D:\Playout\Clips"



7 Installing and Configuring Avid Motion 
Graphics News Control

The following provides instructions for installing and configuring Avid Motion Graphics News 
Control (AMG News Control) software and related applications.

Avid Motion Graphics Servers must have already been installed and licensed before you can 
install Avid Motion Graphics News Control.

To use AMG News Contol you will also need to install, license and configure an iNEWS MOS 
Gateway. Once configured, the iNEWS MOS Gateway communicates to AMG News Control via 
the AMG MOS Gateway which is automatically installed when you install the AMG Journalist 
Server applications.

Before you begin, make sure you have licenses for the following AMG News components:

• NRCS

• AMG News Preview Renderer (2)

• AMG Clips (2)

• AMG News Control

The following topics is included:

• AMG News Control Installation Tasks

• Example of AMGConf.ini File for AMG News Control

After setting up and configuring settings of the operating system for your Avid Motion Graphics 
system you can install the Avid Motion Graphics News Control software and related 
applications.

n The Avid Motion Graphics software is available on the Avid Download Center 
(www.avid.com/support/downloadcenter).
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AMG News Control Installation Tasks

When you do not have iNEWS Command, but use scripts and rundowns in a MOS environment 
you can use Avid Motion Graphics News Control. This section contains procedures on how to 
install and configure the Avid Motion Graphics News Control for use in a MOS workflow 
environment. 

Before installing AMG News Control, the Avid Motion Graphics servers must have already been 
installed and licensed.

You must be logged on to the Avid Motion Graphics server as Administrator.

n If you are not using iNEWS Command, you will need AMG MOS Gateway and Avid MOS 
Gateway.

The AMG Journalist Server installation process includes the following tasks:

• “Installing AMG Journalist Server Software” on page 152

• “Configuring the AMG Journalist Server with AMG News Control” on page 152

• “Licensing AMG News Control” on page 154

• “Understanding the X: Drive Network Share” on page 155

• “Installing Avid Motion Graphics Journalist Client” on page 155

• “Installing the AMG Preview Renderer” on page 156

• “Creating a Project Shortcut” on page 158

• “Configuring Avid MOS Gateway, AMG News Control and iNEWS” on page 159

• “Configuring ENPS to Host the AMG Journalist Client” on page 160

• “Confirming Avid Motion Graphics Journalist Functionality” on page 161
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Installing AMG Journalist Server Software

When installing Avid Motion Graphics News Control for integration with AMG Journalist 
Server and either the Avid iNEWS News Room Computer System (NRCS) or ENPS, you must 
first make sure AMG Journalist Server is installed. This might already be done. 

If AMG Journalist Server software is:

• Not installed, go to the topic “Installing Avid Motion Graphics Journalist Server Software” 
on page 107. Once it is installed, you need to configure it for AMG News Control. For mor e 
information, see “Configuring the AMG Journalist Server with AMG News Control” on 
page 152.

• Already installed, you must configure it for AMG News Control. To do so, continue with the 
topic “Configuring the AMG Journalist Server with AMG News Control” on page 152.

Even if the AMG Journalist Server has been configured initially, it still must be installed and 
configured the for use with AMG News Control.

Configuring the AMG Journalist Server with AMG News Control

After installing, the Avid Motion Graphics Journalist Server components on your Journalist 
Server, they must be configured.

n  Installers for other related Avid Motion Graphics News components are opened from the AMG 
Journalist Server.

To configure the Avid Motion Graphics Journalist Server:

1. On the Avid Motion Graphics Journalist Server, navigate to: 
C:\AMGNews\bins\cfg\AMGConf.ini.

2. In the General section:

t Set VIDEO FRAMES to NTSC or PAL.

3. In the Preview Snaps section:

t Set the IP to the specific address for the local machine (do not use 127.0.0.1, or a host 
name).

4. In the Gateway section:

t Set the IP to the specific address for the local machine (do not use 127.0.0.1, or a host 
name).

5. In the MOS Device section:

t Confirm the NAME is set to set to your desired MOS DEVICE ID for the AMG playout 
system.
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6. In the Control section (where NAME = CTRL1):

t Set the IP address to the specific address on which AMG News Control will run.

7. In the Control section (where NAME = COMMAND1):

t For AMG News Control, comment out this entire section with a ;.

8. In the Render Sections (There are two.):

t Set the IP to the specific address for the AMG Playout Servers.

9. In the Manager section:

t Set the IP to the specific address for the AMG Journalist server (do not use 127.0.0.1, or 
a host name).

t For iNEWS, confirm that IS NCS is set to NO.

10. In the NCS section:

t In the NAME field, enter the iNEWS server name in the NAME.

t In the IP field, enter the IP address of the computer running the Avid MOS Gateway.

11. On the AMG Journalist Server, go to C:\AMGNews\bins\cfg\Previewunits.ini.

t In both IP fields, enter the IP address for where the AMG News Preview Renderer will 
be running.
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Licensing AMG News Control

Open Avid License Control on the AMG Journalist Server, and confirm that you have an NRCS 
license and AMG News Control licenses (if necessary). If you do not have an NRCS license, 
contact your sales representative to obtain a license.

To License Avid Motion Graphics News Control:

1. Open Avid License Control tool.

2. Activate the Avid Motion Graphics NRCS license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license.
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Understanding the X: Drive Network Share

The AMG News system includes a network share folder known as the X: Drive. This is a 
centralized location where many of the components for the AMG News system reside. The X: 
Drive includes installers and configuration files for components. The X: Drive is also the 
centralized repository for the sites graphic templates and assets. It is vital that consistent network 
connectivity is available between AMG News components and the X: Drive. 

By default, the X: Drive is installed on the AMG Journalist Server as part of the AMG News 
installation. 

The following is the X: Drive directory structure overview.

• Bins — Include executable files for AMG News Components, cfg folder containing 
configuration ini files, plug-in folder containing plug-ins for use within Journalist client, and 
a log folder for log files.

• Bins\cfg — Contains ini files for configuration.

• Install — Installers for AMG News Components.

• TPL — Graphic templates for AMG News Project

• RSC — Shared assets for use as replaceable fields in AMG Journalist Clients.

• TPL_Example—An example news project with replaceable fields for testing

When this is this is done, there is an AMG News icon on the desktop. Double-click it to start the 
following AMG server applications:

• AMG News Licenser: gives out AMG Journalist client license seats

• AMG Gateway: manages communication between NRCS, database, and Avid MOS 
Gateway.

• AMG News Preview Server: manages Preview requests for Journalist Clients.

The install comes with a ‘basic’ project, that can be used for initial testing and confirmation.

Installing Avid Motion Graphics Journalist Client

The following steps describe how to install the Avid Motion Graphics Journalist client for 
integration with Avid Motion Graphics News Control. They assume that the Avid Motion 
Graphics servers have already been installed and licensed.

To install the Avid Motion Graphics Journalist client:

1. Navigate to the Avid Motion Graphics Journalist Server (via UNC path - 
\\servername\AMGNews).

2. Open the install folder.
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3. Click AMGDriveMonitor to install.

This configures the X: Drive and configures the system tray icon.

4. Click AMGODBC to install. 

This configures the database connection.

5. Click the AMGNRCS to install. 

This configures the AMG Journalist Client.

Installing the AMG Preview Renderer

The following describes installing the Avid Motion Graphics Preview Renderer on a dedicated 
computer.

For baseline computer requirements, see an Avid Sales associate.

Before starting this procedure, the X-drive should be connected. Make sure the network drive is 
mapped as follows: \\***.***.***.***\AMGNews, where * is AMG Journalist server IP address.

To install the Avid Motion Graphics Preview Renderer:

1. Navigate to the X-drive (via UNC path - \\servername\AMGNews).

2. Open the Install folder.

3. Double-click the Avid_Motion_Graphics_Journalist_setup.exe.
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4. Select Yes. 

The User Account Control dialog box opens.

n The installer may detect some items already installed. If the menu item as a green check next to 
it, it is already installed and you can move on to the next step. In the example above, the first four 
items have already been installed.

5. In the AMG Journalist Applications window, click Avid Motion Graphics News Preview 
Renderer to install it.

6. Click Microsoft Visual C++ 2008 Re-distributable to install it.

7. Click the Avid Motion Graphics Drive Monitor to install it. 

8. You will need to enter the IP address for the Avid Motion Graphics Journalist server.

The Host name or IP address for the Avid Motion Graphics Journalist Server will appear in 
the AMG Drive Monitor dialog box. Follow the prompts, clicking Next, to proceed. Then, 
click Install. When finished installing, click Finish. 

9. Click Avid Motion Graphics ODBC to install it. Follow the prompts, clicking Install, and 
then click Next to proceed.

n A database password is not necessary, and should not be entered.

10. Click Avid License Control to install it.

11. Click Avid Motion Graphics News Preview Renderer to install it.
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12. Click Avid Motion Graphics Font Package to install it.

n If you planing to use Avid Deko compositions in AMG, you need to install Deko Player 6.3.0 and 
Deko Chart Designer 1.1.0. If you are not upgrading from Avid Deko you can skip these to 
installs.

13. Click Exit to close the installer licensing.

14. Open the Avid License Control tool.

15. Add the Preview Renderer licenses (Preview and Clips). If you do not have a Preview 
Renderer license, contact your sales representative to obtain a license.

n The license is most easily added with an internet connection, so that the computer can connect to 
the Avid license server and verify the license. 

Creating a Project Shortcut

Create a Start Menu shortcut to open the project in the Preview Renderer.

To create a project shortcut:

1. Navigate to X:\TPL\basic.ldr (or the specific project name).

2. Create a shortcut to that file on the desktop.

3. Double-click the file to open the project in Preview Renderer A.

4. With the project open, double-click the shortcut again, to open the project in Preview 
Renderer B.

This enables you to click Start, point to the Preview Renderer A, and select the project to 
open both Preview Renderers.

5. Navigate to the AMG Journalist Server.

t Click AMGDriveMonitor to install. This configures the x: Drive and configures the 
system tray icon

t Click AMGODBC to install. This configures the database connection.

6. Open Avid License Control.

7. Confirm that the AMG licenses are in place: AMG, Clips, 3D Stereo (if purchased).
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Configuring Avid MOS Gateway, AMG News Control and iNEWS

The last steps are to configure the MOS device channels, and iNEWS rundowns.

To Configure Avid MOS Gateway:

1. In iNEWS SYSTEM.MOS-MAP, add an entry for the new MOS ID. See the following 
example:

2. In iNEWS SYSTEM.MAP, add an entry for the MOS device and its corresponding MOS 
Gateway. See the following example:

3. Configure the Avid MOS Gateway – MOS devices controlled by the Avid MOS Gateway 
must appear as an entry in the Avid MOS Gateway’s mosconfig.xml file. See the following 
example:
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Configuring ENPS to Host the AMG Journalist Client

If you are using AMG Journalist with ENPS, then you must configure ENPS to host the AMG 
Journalist client. 

n This can be done from any ENPS client machine. 

Once configured, the AMG Journalist client will need to be installed (from the X: drive) on all 
ENPS client machines that need access to it.

To configure ENPS to host the AMG Journalist client:

1. Open the ENPS client.

2. Select the green 'rover' on the 4th folder in the client, point to System Maintenance, and then 
MOS Configuration.

3. If you already have a MOS ID configured for the Command system, add the following 
information to the respective fields:

a. In the Description field, if a description is already entered, it should be changed to 
AMG Journalist, so users can easily identify it.

b. In the IP field, type the IP address of the Command server, if not already done.

c. In the ActiveX field, type RCGPLUGIN.RCGpluginCtrl.1, which identifies the AMG 
Journalist client plugin.

d. In the Program field, select the group that was created specifically for Command.

e. In the MOS Version field, verify that 2.8 is the recommended version.

n Make sure that the AMGConf.ini is also set to use MOS 2.8.

f. In the Local DragDrop field, make sure it is set to Off.

g. In the Story Send field, make sure this option is selected.

n Using the same MOS ID as the Command system allows the journalist to open graphics that 
have already been created.

n If you are using more than one ActiveX plugin (such as AMG Journalist and Deko Select), only 
one ActiveX plugin can be configured to use the same MOS ID as Command. The second ActiveX 
plugin will need to be set up with a separate MOS ID.
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Confirming Avid Motion Graphics Journalist Functionality

After installing and configuring the Journalist and News Control components, confirm the 
functionality.

To confirm Journalist functionality:

1. Open the AMG Journalist client.

2. Double-click an item to open it in the template editor.

3. Add replacement data and click Save.

The new item should appear in the Graphic Database area list with a unique ID for the item.

4. Open the new item and edit the first replaceable field.

5. Click Save and confirm that the data has updated.

6. Open the created item and click the Preview button.

7. Confirm that the correct replacement data appears.

8. Open the created item and click the Movie button.

9. Confirm that the item appears with motions and correct replacement data.

10. Create several more items and drag them into a rundown.

11. Create a hand-entered item. Confirm that it appears in News Control.

12. Designate one of the items as a library graphic and drag into a playlist.

13. MON Load the show, and confirm that all graphics appear in the Avid Motion Graphics 
News Control Workstation.
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Example of AMGConf.ini File for AMG News Control

This topic contains an example of the AMGConf.ini configured for AMG News Control.

; This is the base file for AMG, iNews, and AMG News Control

;

[GENERAL]

"ENCODING"= "UTF8";UTF8 or ASCII

"VIDEO FRAMES"= "NTSC";PAL or NTSC, it is used to calculate the length of 
the graphics

"LOG FILES"= "3";Max num log files

"TEXT DB"= "P_TEXTS";Database that can be used to fill templates

"AUTO SLUG"= "MIXED";TRUE, FALSE or MIXED

"SLUG FMT"= "<tpl>:<id>";Format used to generate auto slugs

"AUTO SNAPS"= "FALSE";TRUE to enable auto snaps feature

"OBJ READY"     = "TRUE";TRUE if graphics must be created "Ready for Onair" 
by default

"WAIT ACK"= "FALSE";Wait for ACKS

"FORMAT"= "jpg";Snapshot format

"TPL EXTENSION"= "scn"

[PREVIEW SNAPS]

"NAME"= "SNAPS"

"IP"= "xxx.xxx.xxx.xxx"   ;AMG PreviewServer Application IP address 
(journalist server)

"PORT"= "6125" ;Port where to send the requests

"ACK PORT"= "5125" ;Port where the plug-in will get the answer
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"SNAPS PATH"= "X:\preview";net path where to find the snap files

"OBJS PATH"= "X:\preview\objs"  ;net path where to find the graphics images

"VIEW X-RES"= "400";Resolution used by the plug-in to show the

"VIEW Y-RES"= "225";generated snaps

"DICTIONARY"= "PreviewDICT";

;"EXPORT FMT"= "<date>_<time>_<user>"  ;patern to generate exported movie 
names

;"EXPORT PATH"= "";SNAPS PATH will be used if this is not defined

;"EXPORT MASTER" = "USER" ;USER or SERVER. Who copies the final file to 
EXPORT_PATH

[GATEWAY]

"NAME" = "GW1"   ;This name will be used by other components

"IP" = "xxx.xxx.xxx.xxx"    ;AMG Gateway Application IP address (journalist 
server) 

"NCS UPPER PORT" = "10441"   ;MOS Protocol Ports (default ports)

"NCS LOWER PORT" = "10440";Just leave this alone

"MOS UPPER PORT" = "10541";Just leave this alone

"MOS LOWER PORT" = "10540";Just leave this alone

[MOS DEVICE]   ;THIS DEVICE IS FOR NEWS CONTROL

"NAME"= "MSNAMG2";MOS name for AMG Playout server (this needs to match MOSID 
in

; system.map and system.mos-map file)
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"GATEWAY"= "GW1"   ;Gateway that creates content for this Render Unit

"TPL FOLDER"= "X:\Tpl"   ;Net path where the templates can be found

"RSC FOLDER"= "X:\RSC"   ;Net path where resources used to create graphics 
can be found

"OBJ FOLDER"= "P_RENDER2"   ;Just leave this alone

"DB TYPE"= "ODBC"   ;System used to manage the graphics. FILE (deprecated) 
or ODBC. 

"VERSION"= "2.6"   ;Protocol Version. "2.6" or "2.8" for MOS, "CA" for 
ControlAir

"CHANNELS"= "1, 2"

[CONTROL]   ;THIS CONTROL SECTION IS FOR NEWS CONTROL

"NAME"= "CTRL1"   ;Name used by the Render Unit to reference this Controller

"MOS DEVICE"= "MSNAMG2"   ;Name used by the Gateway where the Controller 
sends commands

"IP"= "xxx.xxx.xxx.xxx" ;IP where the AMG News Control is running

"PORT"= "5130"   ;Protocol messages

"CONTROL PORT"= "5127"   ;Port where the Controller receive commands

"CHANNELA"= "Render1"   ;Name of the first Program channel (required)

"PREVIEWA"= "Render2"   ;Name of the first Preview channel (required)

"DICTIONARY"= "ServerDICT"

[RENDER]   ;NEWS CONTROL - Settings for the first Program channel(required)

"NAME"= "Render1"

"IP"= "xxx.xxx.xxx.xxx" ;IP address of AMG Chassis

"PORT"= "5124"   ;Just leave this alone
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[RENDER]   ;NEWS CONTROL - Settings for the first Preview channel(required)

"NAME"= "Render2"

"IP"= "xxx.xxx.xxx.xxx" ;IP address of AMG Chassis

"PORT"= "5124"   ;Just leave this alone

[MANAGER]   ;AMG News Licenser Application IP address

"NAME"= "MAIN"   ;Just leave this alone

"IP"= "xxx.xxx.xxx.xxx" ;keeps track of licenses for AMG clients

"PORT"= "5140"   ;Just leave this alone

"IS NCS"= "NO"   ;Use "No" for iNews or ENPS, "YES" for for stand alone

[NCS]   ;THIS NCS SECTION IS FOR NEWS CONTROL

"NAME"= "NRCS4"   ;iNEWS server name, ENPS server name or RCG Manager Name

"IP"= "xxx.xxx.xxx.xxx" ;IP address of iNews MOS Gateway or ENPS server

"AUTO ABSTRACT" = "TRUE"   ;Generate the abstract field for iNews and ENPS

"ABSTRACT FMT"= "<tpl>:<2values>" ;Format used to generate the auto 
abstract

"DB TYPE"= "ODBC"   ;it MUST be "ODBC". Only used in stand-alone mode

"DB PATH"= "P_NCS"   ;ODBC source name.

"VENDOR" = "MOS"   ;Speciall behaviour for some vendors [MOS, VSN]

;[DICTIONARY]
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;"NAME"= "MyDICT"

;"REPLACE"= "X:\RSC >> D:\Playout\Clips"



8 Upgrading Your AMG Server Hardware to 
Dual Channel

This chapter provides procedures for upgrading a single channel Avid Motion Graphics Server to 
a dual channel Avid Motion Graphics server. This includes adding five additional media drives 
one additional VGA board, and one additional Video I/O board in your Avid Motion Graphics 
server. 

Do not add any hardware if there are any issues with the system. Correct all problems before 
adding new hardware and making changes to the system. Perform a quick check to verify that the 
system is in good working order.

n Before you begin, back up your media. This process adds media drives to your system. Once 
they are added, you must Re-RAID your system.

Topics in this chapter include:

• Electrostatic Discharge Precautions

• Electrostatic Discharge Precautions

• Removing and Installing the System Cover

• Electrostatic Discharge Precautions

n  You will need both #1 and #2 Phillips-head screwdrivers to perform the procedures described in 
this section. You will also need wire cutters to cut the tie-strap to the power bundle. 
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Avid Motion Graphics Server Board Slots

The following illustration shows the dual channel Avid Motion Graphics server rear panel as it 
looks with the two additional boards installed in Slots 4 and 5.

• The NVidia® Quadro 4000 VGA board is shipped installed in Slot 4 of the dual channel Avid 
Motion Graphics servers. When upgrading a single channel Avid Motion Graphics Server to 
dual channel, you must add this board to Slot 4.

• The AJA Kona 3G Video I/O board is shipped installed in slot 5 of the dual channel Avid 
Motion Graphics servers. When upgrading a single channel Avid Motion Graphics server to 
dual channel, you must add this board to Slot 5.

Avid Motion Graphics Server Dual Channel Rear Panel

Electrostatic Discharge Precautions

Electrostatic discharge (ESD) can damage disk drives, electronic components, and other parts. 
Avid recommends that you perform all procedures in this chapter only at an ESD workstation. If 
one is not available, provide some ESD protection by wearing an antistatic wrist strap attached to 
chassis ground (any unpainted metal surface) on your Server when handling parts.

Always handle boards carefully. They can be extremely sensitive to ESD. Hold electronic boards 
only by their edges. After removing a board from its protective wrapper, place the board 
component side up on a grounded, static free surface. Use a conductive foam pad if available but 
not the wrapper. Do not slide the board over any surface.

AJA Kona 3G Video I/O
NVidia Quadro 4000 VGA
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Upgrade Checklist

The following table provides a checklist of tasks that must be performed when upgrading a 
single channel Avid Motion Graphics server to a dual channel Avid Motion Graphics server.

 Disconnect all cables from your AMG server chassis, and remove the AMG server from the rack.

 Remove the system cover, as described in “Removing and Installing the System Cover” on 
page 170.

 Install the additional VGA and Video I/O boards, as described in “Installing the Additional VGA 
and Video I/O Boards” on page 172.

 Replace the server cover, as described in“Removing and Installing the System Cover” on 
page 170.

 Re-rack the AMG server, as described in “Installing the AMG Server in a Rack” on page 34.

 Install the additional five (5) RAID media drives, as described in “Inserting Additional Media 
Drives in Your AMG Server” on page 176.

 Connect your power and other cables to your AMG server, as described in “Connecting Power 
Cords to the AMG Server” on page 58.

 Power on your Avid Motion Graphics server, as described in “Powering on Avid Motion 
Graphics” on page 59.

 Re-RAID your media drives, as described in“Re-RAIDing Media Drives” on page 178.
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Materials Checklist

The following materials are included in the upgrade kit:

• 1 Nvidia VGA board

• 1 AJA Video I/O Board

• 1 Breakout Panel

• 1 cable needed for Breakout panel

• 1 DVI-VGA Adapter (not needed)

• 1 USB Software Drive

• 1 USB Drive Image (TBD)

• 1 Avid Motion Graphics Activation Card

Removing and Installing the System Cover

To remove the top cover:

1. Observe the safety precautions described in Electrostatic Discharge Precautions.

2. Make sure the Avid Motion Graphics server is powered off and all peripheral devices and 
AC power cords are disconnected.

3. Use a #2 Phillips Screwdriver to remove the four top cover screws shown in the following 
illustration.

4. Completely loosen the captive thumb screws on the back of the server. 
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5. Pull the two pull tabs on the sides of the cover outward.

n Make sure the top of unit first needs to slide to the rear to dis-engage it from the chassis front 
cover.

Removing the Top System Cover

6. Lift and slide the cover off the system to remove it.

Front

Thumb screws

Pull tabs

Top cover 
screws
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To install the server system cover:

1. Place the cover over the server so that the side edges of the cover sit just outside the server 
sidewalls.

2. While pulling the tabs outward, slide the cover forward until the tabs click into place and 
release the pull tabs. 

3. Replace the four top cover screws previously removed.

4. Tighten the rear thumbscrews.

5. Reconnect all peripheral devices and the AC power cords.

Installing the Additional VGA and Video I/O Boards

To install the additional VGA and Video I/O boards:

1. Observe the safety precautions described in Electrostatic Discharge Precautions.

2. Use a #2 Phillips Screwdriver to remove the cover and then lift cover out as previously 
described, see Removing and Installing the System Cover.
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3. Remove the T-bar by removing the ten (10) screws that are securing it to the chassis. After 
removing the T-Bar, there is a cover (that directs heat to the rear of the system). Remove that 
cover also.

Removing the T-Bar

4. Identify the appropriate slot for the additional VGA and Video I/O boards you are installing. 

5. Remove the screw securing each of the blank panels associated with the slots where you are 
installing the additional VGA and Video boards. 

Front

2 ScrewsT-Bar

4 Screws

4 Screws
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Removing the Blank Card Slot cover

6. Insert the Video I/O board in Slot 4 so that it fits into the connector and fills the hole where 
you previously removed the blank panel (Slot 4).

n Be sure that the tab at the bottom panel seats into the slot on the bottom of the server chassis.

Front

USB/PCI Card

NVidia Quadro
VGA board

AJA Kona 3G 
Video I/O board

Serial
Card

Slot for New AJA Kona 3G 
Video I/O board

Slot for New NVidia Quadro
VGA board
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Slot 4 Slot 5

Single Channel Server 
Expansion Slots

Location of VGA Power
Connector
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7. Insert the VGA board in Slot 5 so that it fits into the connector and fills the hole where you 
previously removed the blank panel (Slot 4). 

n When installing the VGA board, be careful not to pinch the cables that connect the PS/2 USB 
board.

n Be sure that the tab at the bottom panel seats into the slot on the bottom of the server chassis.

8. Connect power to the VGA board by doing the following:

a. Pull aside the shroud.

b. Locate a 6-pin power connector from rear of the fan base.

n If two power connectors are attached together, you might need to release one by cutting the 
plastic fasteners that bundle the power connectors.

Locating the VGA Power Connector

c. Pull one power connector out and slide it under the midplane and attach it to the 
connector on the rear of the new VGA board that you just installed.

d. Replace the heat shroud using the 2 Phillips screws.

9. Re-attach the T-Bar with the ten (10) screws that you removed earlier.

10. Replace the top cover, see Removing and Installing the System Cover.

11. Re-rack the AMG server, see Removing and Installing the System Cover.
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12. Reconnect all peripheral devices and the AC power cords into the server.

Inserting Additional Media Drives in Your AMG Server

This procedure contains information on how to insert the additional five (5) media drives into 
your Avid Motion Graphics server so that it will be a dual channel capable Avid Motion 
Graphics server.

To insert the additional media drives in your AMG server:

1. Obtain the five (5) additional media drives. 

2. Remove the drive carriers from Slots 7-11 of the chassis by pushing the button, then pull the 
handle to unlatch the drive and slide each empty drive carrier out of the Avid Motion 
Graphics chassis.

n The actual drives are not numbered.

3. For each new media drive, push the drive carrier latch in, to release the handle and pull the 
handle completely open prior to inserting the drive carrier into the open slot.

4. Make sure the drive LEDs are on the bottom before you begin to slide the drive into the 
server.

  Fault LED (red)
  Power/Activity LED (blue)

Drive lockDrive carrier latch
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c Do not force a drive into a slot. If you are having problems installing a drive, check to make 
sure it is level and flat as you insert it into the server, that the drive carrier latch is open and 
at a 45 degree angle to the drive carrier, and that the LEDs are on the bottom of the drive 
carrier.

5. Slide the drive into the open drive slot in the Avid Motion Graphics server chassis until it 
stops. Approximately 1/2 inch of the drive carrier should be outside the server.

6. Push the handle into the drive carrier. This seats the drive in the Avid Motion Graphics 
server. You’ll hear a click when the drive is fully seated and the handle latches in place.

Turning on Your Avid Motion Graphics Server

When you turn on the power to your Avid Motion Graphics Server hardware, you must do it in 
the following order so that the Avid Motion Graphics Server locate and acknowledge all of its 
connected components.

n If you encounter an error when starting the Avid Motion Graphics application for the first time, 
close the error message and change the display resolution frequency to 60Hz. For further 
information contact Avid support.

You should re-connect the system to the to the KVM as you had prior to removing the chassis. It 
is not required to connect a second KVM connection to the Nvidia board installed during this 
upgrade process. This board is for internal use only and is not required to connect. In fact, if it is 
connected, you might not see your desktop or post as it boots. 

To power on each component:

1. (Option) If you have a KVM switch as part of your system, ensure the power is on.

2. Ensure you have all your network cables connected before you turn on the power or load the 
Avid Motion Graphics Server software.

3. Push the power button at the top left on the front of the your Avid Motion Graphics Server.

4. Wait for the Windows operating system to load before you attempt to use the Avid Motion 
Graphics Server. This can take several minutes. When the system starts up, login to your 
system with your current username and password.

If you haven’t changed it, the default login username is AMG, which is not case sensitive 
and the password is left blank (no password is assigned). 

When installing the software, you should log on as user of AMG and no password. 

n If you log on as Administrator when installing the software, it will not launch. 
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If you need to restore the operating system on the server using the USB provided, the 
username is Administrator and the password is avid (the password is case sensitive and is 
lower case).

It will recognize the new drives, but you must now re-RAID your media drives. For more 
information, see Re-RAIDing Media Drives.

(Optional) Upgrading the AMG Software

If you do not have AMG v2.5 or later software installed, you must upgrade to the latest software. 

For more information, see the latest version Avid Motion Graphics Server ReadMe, located on 
the Knowledge Base at www.avid.com/US/support. 

(Optional) Upgrading AJA and NVidia Driver Configuration Settings

After you have installed the NVidia Quadro 4000 VGA board, and the AJA Kona 3G Video I/O 
board into the server and power it on, the Windows Hardware Wizard displays. You might need 
to update the AJA and NVidia drivers for Avid Motion Graphics v2.0 and earlier. 

For instructions on updating the drivers, see the Avid Motion Graphics Server ReadMe.

Re-RAIDing Media Drives

This topic contains information on how to re-RAID your media drives in the event that you are 
converting a single channel Avid Motion Graphics Server to a dual channel Avid Motion 
Graphics server.

c Before you perform this procedure, you must back up your media if you haven’t already 
done so.

This procedure creates a new RAID50 drive group on the Avid Motion Graphics server.

Before you begin this procedure, you must have already removed the physical media drives from 
the chassis and replaced them with new drives, as described in the topic Inserting Additional 
Media Drives in Your AMG Server. 

To re-RAID Media Drives:

1. On the Avid Motion Graphics server, right click on Computer, and select Manage.

The Computer Management dialog box opens.

2. In the Storage folder, select Disk Management.

The Disk Management window opens.

http://www.avid.com/US/support
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3. Right-click on the (D:) partition in Disk 1, and select Delete Volume from the menu. Then, 
right-click on the (E:) partition in Disk 1, and select Delete Volume from the menu

The Disk Management dialog box should appear as in the following example.

n If Disk 2 also appears, right-click on the (F:) partition in Disk 2, and select Delete Volume from 
the menu.

4. Once you have verified that you have deleted the existing volumes, you can close the Disk 
Management window, and go to the next step.



Upgrade Checklist

180

5. Start the MegaRAID Storage Manager by selecting Start > All Programs > MegaRAID 
Storage Manager > StartupUI, or select the MegaRAID Storage Manager desktop icon.

n If your Avid Motion Graphics server OS image is later than version 4, it will not have the LSI 
MegaRAID Storage Manager software pre-installed. Earlier Avid Motion Graphics software 
versions had this software pre-installed on the server. To get the latest LSI MegaRAID Storage 
Manager software, it is available to download under LSI's terms and conditions at 
http://www.lsi.com.

From the website, you can locate and download the latest Windows-based LSI MegaRAID 
Storage Manager software that supports the MegaRAID SAS 9260 4i product.

 The MegaRAID Storage Manager - Host View dialog box opens.

6. Select the IP address URL link of the Avid Motion Graphics server in the IP Address field.

 The Enter User Name & Password dialog box opens.

7. Type the local machine login credentials.

a. In the User Name field, type administrator.

b. In the Password field, type avid.

Make sure the Login Mode is set to Full Access.

c. Click OK (Login).

The LSI MegaRAID Storage Manager application opens.
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8. Click the Logical tab to confirm that the new drives you inserted appear in the Unconfigured 
Drives tree.

In the following example, note the following:

-  The previously installed drives (Slots 12 -16) appear in the Drives tree.

- The drives you just installed in Slots 7-11 appear In the Unconfigured Drives tree, as 
“Unconfigured Good”. This indicates that they are new un-configured media drives.
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9. Clear the existing configuration by doing the following:

a. Right-click on the LSI MegaRAID SAS.

b. Select the Clear Configuration option from the list

The Confirm Clear Configuration dialog box opens.

10. Select the Confirm check box, and click Yes to clear the existing configuration. 

After the existing configuration is cleared, all of the drives that were in the Span: 0, and 
Span:1 trees should now appear in the Unconfigured Drives tree as “Unconfigured Good”.
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11. Right-click the LSI MegaRAID SAS again, and select Create Virtual Drive.

The Create Virtual Drive - Choose mode dialog box opens.

12. Select the Advanced radio button, and click Next.

The Create Drive Group - Drive Group Settings dialog box opens.

13. Select the Drive group settings by doing the following:

a. In the RAID level field, select RAID 50 - Spanned Drive Group.

b. Select five drives by pressing Ctrl and clicking on the five drives. 

The Add > button becomes enabled.

c. Click the Add > button to add the five drives to Span: 0 in the Drive Group0 tree.

d. Create a new Span by clicking the Create Span button. 

It will generate Span: 1 at the bottom of the Drive groups field.

e. Select the remaining five drives by pressing Ctrl and clicking on the remaining five 
drives. 

f. Click the Add > button to add them to Span: 1.

g. Click the Create Drive Group button.

h. Click the Next button.

The Create Virtual Drive - Virtual drive settings dialog box opens.
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14.  In the Virtual drive settings dialog box, do the following:

a. In the Virtual drive name field, make sure it says VD_0.

b. In the Capacity field, leave the default of 7.273.

c. In the Initialization state field, select No Initialization.

d. In the Units field, leave the default of TB.

e. In the Strip(e) size field, select 512 KB.

f. In the “Read Policy, select Always Read Ahead.

g. In the “Write policy” field, select Always Write Back.

h. In the I/O Policy field, select Direct I/O.

i. In the Access policy field, select Read Write.

j. In the Disk Cache Policy field, select Disabled.

k. Click the Create Virtual Drive button.

The Always Write Back Selected dialog box opens.

l. Click Yes to confirm the changes for the write policy setting.
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m. Click the Next Button.

The Create Virtual Drive - Summary dialog box opens.

15. Review the summary for the settings you selected to create the virtual drives. Make sure the 
settings are correct before you create the virtual drive.

16. Once you have confirmed your settings are correct, click the Finish button to create the 
virtual drive.
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17. When you are done, the Logical Tab should appear as it does in the following example:

After the configuration, the system might go to “initializing mode”. This takes about 6 or 7 
hours to initialize a single disk.

n To view your progress, select Manage > Show Progress.



Upgrade Checklist

187

18. In Windows, do the following: 

a. Right-click on Computer, and select Manage. 

The Computer Management dialog box opens.

b. In the Storage tree, select Disk Management. 

The Initialize Disk dialog box opens.

19. In the Initialize Disk dialog box, do the following:

a. Select Disk 1

b. Select the GPT (GUID Partition Table) option.

c. Click OK.

20. In Computer Management > Storage > Disk Management, right click on the new 
Unallocated Drive space for Disk 2, and select New Simple Volume.

21. Click Next on the volume wizard screen.

The Specify Volume Size dialog box opens. It should show 512000 MB for the volume size. 
This gives you a 500 GB partition.

22. Click Next.

The Assign Drive Letter or Path dialog box opens.

23. In the “Assign the following drive letter” field, make sure the drive letter is set to “D” and 
click Next.

The Format Partition dialog box opens.
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24. In the Format Partition dialog box, do the following:

a. Select the “Format this volume with the following settings” option.

b. Set the Allocation unit size to 64K.

c. Change the Volume label to Graphics.

d. Make sure the “Perform a quick format” check box is selected.

e. Click Next.

25. Click Finish.

After the format is complete, the drive should show Healthy (Primary Partition).

26. Close the Disk Manager. 

27. Reboot the system. 

You are now done creating the new media drives.



9 Adding and Replacing Hardware

This section provides procedures for replacing components in your Avid Motion Graphics server.

The following topics are covered in this chapter:

• Electrostatic Discharge Precautions

• Removing and Replacing Data Drives

• Replacing the Avid Motion Graphics Server

• Replacing System Drives in the Server

• Installing GPI Functionality in Your AMG Server

Electrostatic Discharge Precautions

Electrostatic discharge (ESD) can damage disk drives, electronic components, and other parts. 
Avid recommends that you perform all procedures in this chapter only at an ESD workstation. If 
one is not available, provide some ESD protection by wearing an antistatic wrist strap attached to 
chassis ground (any unpainted metal surface) on your Server when handling parts.

Always handle boards carefully. They can be extremely sensitive to ESD. Hold electronic boards 
only by their edges. After removing a board from its protective wrapper, place the board 
component side up on a grounded, static free surface. Use a conductive foam pad if available but 
not the wrapper. Do not slide the board over any surface.

Removing and Replacing Data Drives

The Avid Motion Graphics server automatically uses the spare drive in the server to repair the 
RAID group where the drive has failed or was taken offline. 

n You do not need to stop the Avid Motion Graphics server to replace a single drive. 
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As long as you have a spare drive in the server, the RAID controller automatically starts 
repairing a RAID group using the spare when:

• The RAID controller identifies a drive has failed.

• A data drive has been taken offline (Make Drive Offline) using the LSI MegaRAID Storage 
Manager.

• A data drive has been physically pulled from the server (without being identified using one 
of the two previous conditions).

Removing a Drive

When a RAID data drive fails, the Avid Motion Graphics server automatically rebuilds the RAID 
set when a new drive is installed. 

You can identify the failed drive by locating the data drive on the front that has both the blue and 
red LEDs on solid, for a list of data drive LED meanings, see “Avid Motion Graphics Server 
Front” on page 19.

You can remove the failed RAID data drive whenever the red and blue LEDs have indicated that 
the drive has failed. When the new drive is inserted, the Avid Motion Graphics server 
automatically starts the rebuild process. The rebuild process does not need to be completed 
before you can use Avid Motion Graphics server.

To remove a drive from the Avid Motion Graphics server:

1. Locate the data drive on the front of the Avid Motion Graphics server that has the solid blue 
and red LEDs on solid.

n The RAID group uses the other four drives in the RAID to repair the group. 

2. Push the button, then pull the handle to unlatch the drive and slide the drive carrier out of the 
Avid Motion Graphics server.

Replacing a Drive

After removing a data drive as previously described (see “Removing a Drive” on page 190), 
install the replacement data drive as described in the following procedure. When the new data 
drive is inserted, the Avid Motion Graphics server automatically adds the new drive into the 
RAID group.

To replace a drive in the Avid Motion Graphics server:

1. Make sure the handle on the drive carrier is unlatched and pulled open as far as possible.

2. Slide the drive into the open drive location in the Avid Motion Graphics server until it stops. 
Approximately 1/2 inch of the drive carrier should be outside the server.
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3. Push the handle into the drive carrier. This seats the drive in the server. 

The new drive becomes part of the RAID group.

Replacing the Avid Motion Graphics Server

Use the following procedure when replacing an and Avid Motion Graphics server. For purposes 
of this procedure, the server to be replaced is referred to as “old server” and the replacement 
server as “new server.”

n If your Avid Motion Graphics server OS image is later than version 4, it will not have the LSI 
MegaRAID Storage Manager software pre-installed. Earlier Avid Motion Graphics software 
versions had this software pre-installed on the server. To get the latest LSI MegaRAID Storage 
Manager software, it is available to download under LSI's terms and conditions at 
http://www.lsi.com.

From the website, you can locate and download the latest Windows-based LSI MegaRAID 
Storage Manager software that supports the MegaRAID SAS 9260 4i product.

n Although not required for this procedure, it might be helpful to note the host names, passwords, 
IP address, and other important network details.

To replace an Avid Motion Graphics server:

1. Power-off the old server by clicking Start > Shut Down.

2. Disconnect the two power cords from the back of the old server.

3. Disconnect the 1-Gb connections from old server.

4. Carefully remove both system drives from the rear of the old server. Put them in a safe place.

These are mirrored drives. The order in which you replace these drives in the new server 
should not matter. Although it would be good practice to mark the system drives as the upper 
and lower and replace them back in the same order in the new server.

5. Carefully remove all (5 or 10) data drives from the front of the old server and put them in a 
safe place.

These data drives are labeled by the system as a RAID group (5 drives in the RAID group). 
The order in which you replace these drives in the new server should not matter. Although it 
would be good practice to mark the data drives as to the slot location and replace them back 
in the same order in the new server.

6. Remove the old server from the rack.

7. Install the new server into the rack (without the system or data drives).

8. Carefully reinsert the both system drives into the rear of the new server. 
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If you recorded the locations from which the drives were removed on the original server, 
insert them into the same upper and lower locations.

9. Carefully reinsert all data drives into the original position in which they were in on the old 
server. 

If you recorded the locations from which the drives were removed on the original server, 
insert them into the same drive slot locations.

10. Insert the two power cords into the power supplies on the back of the server.

11. Reconnect any 1-Gb cables that were disconnected earlier.

12. Move the Application Key (dongle) or software license from the old Avid Motion Graphics 
server to the new Avid Motion Graphics server.

13. Power-on the new server.

Give the new server at least 3 minutes to initialize

c When the replacement server starts, the LSI MegaRAID BIOS reports the presence of 
foreign drive arrays and asks you to press “F” to import Foreign Configuration, press “C” 
to enter the setup utility, or press any key to continue. Do not import the foreign 
configuration, press the space bar to continue and proceed to step 14. 

14. You need to import the RAID configuration using the LSI MegaRAID Storage Manager 
tool. 

n If your Avid Motion Graphics server OS image is later than version 4, it will not have the LSI 
MegaRAID Storage Manager software pre-installed. Earlier Avid Motion Graphics software 
versions had this software pre-installed on the server. To get the latest LSI MegaRAID Storage 
Manager software, it is available to download under LSI's terms and conditions at 
http://www.lsi.com.

From the website, you can locate and download the latest Windows-based LSI MegaRAID 
Storage Manager software that supports the MegaRAID SAS 9260 4i product.

The following procedure summarizes the LSI MegaRAID procedure for importing a Foreign 
Configuration. For more information, see the LSI MegaRAID Storage Manager tool Help.

a. Start the LSI MegaRAID Storage Manager tool and log in using the Administrator name 
and password.

b. Click the Logical tab.

c. Select the LSI MegaRAID controller in the left pane.

d. Select Go To > Controller > Scan Foreign Configuration. 

A pop-up window appears reporting the detection of foreign configurations.
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c Do not select the Clear option. Clearing the configuration deletes the RAID configuration 
off the disks. Doing so renders the RAID set un-usable. All of the data in the Storage Group 
(in which this server is a part of) becomes unrecoverable.

e. Select the “Import logical configuration from all foreign drives” option and click OK.

The Foreign Configuration Wizard window appears listing the foreign configurations.

This example depicts the configuration for a single channel (5 drive) model AMG 
server.
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f. Click Accept.

g. A dialog box appears asking you to confirm the import, click Yes.

h. You are informed when the import completes, click OK.

n A background initialization is started and can take several hours to complete. You can use the 
server, but performance is best once the initialization is finished. 

Replacing System Drives in the Server

There are two system drives installed in the Avid Motion Graphics server. The two drives are 
mirrored and accessible from the rear of the server. If you have a failure on either one of the two 
system drives you can pull the failed drive out of the server and install a replacement without 
turning off the Avid Motion Graphics server. The Avid Motion Graphics server continues to run 
properly if one of the two system drives are removed.

n The drive carriers for the system drives are locked to avoid them from opening during shipment. 
The plastic drive carrier key is mounted on the rear of the server beside the system drives.
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Replacing System Drives in the Server

If replacing the system drives as part of a complete server replacement, see “Replacing the Avid 
Motion Graphics Server” on page 191. When moving the systems drives from one server to 
another, the order in which you replace these drives in the new server should not matter. 
Although it would be good practice to mark the system drives as the upper and lower and replace 
them back in the same order in the new server.

To replace a single failed system drive:

1. Open the Intel Rapid Storage Technology application:

 Start > Programs > Intel > Intel Rapid Storage Technology

2. Click the Manage button in the application. 

A. Run hardware scan button
B. Disk icons
C. Status line

3. Pull the failed drive out of the server and install a replacement without turning off the server. 

Once the drive is installed, use the Intel Rapid Storage Technology application to initiate the 
rebuild operation as described in the following steps. 

AA

BB

CC
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4. Click the Run hardware scan button (identified as A in the above illustration) to refresh the 
RAID data to the current state. 

5. The volume icon has two smaller disk icons attached to it - one for each disk of the RAID 
set. Perform one of the following operations: 

- If the disk has previously been part of the RAID set, the disk appears as an icon attached 
to the Volume 0 icon and the application immediately begins the rebuild. You can 
monitor the status, in this case the status line displays “Rebuilding x% complete.”

- If the replacement disk has never been part of this RAID set, the disk icons display a list 
of available disks. The Status line will display “Degraded,” and the words “rebuild to 
another disk” is underlined. Click on the underlined text.

6. A window opens that offers a choice of drives to add to the array. Click on the one drive that 
needs to be added to the RAID set. The rebuild operation begins immediately. 

You can use the Status line to monitor the status of the rebuild. The top of the screen says 
Manage Volume, and the status line says “Rebuilding x% complete.”

n You can perform other work while the rebuild completes.

To replace both system drives:

1. If both system drives fail, shut down the system, and unplug the power cords.

2. Remove both system drives.

3. Install new system drives into the two drive carriers and insert them into the two system 
drive slots

4. Replace the power cords and restart the system.

5. Enter the Intel RAID BIOS by pressing CTRL+I when the text MATRIX RAID BIOS 
appears on the screen.

6. Choose Create the new RAID set. This will create the system drive mirror.

a. Change RAID type from RAID 0 Stripe to RAID 1 Mirror (volume name and capacity 
can be left at the defaults).

b. Select Create RAID, answer yes to the “are you sure” messages.

c. The RAID set (Volume 0) should be shown as online with the two physical disks (port0 
and 1) listed below as array members.

d. Exit the RAID BIOS and allow the system to restart.

7. Turn on your server and reimage your system drives which includes loading the Windows 
operating system, see “Reinstalling the Windows Operating System” on page 210.

8. Use the same IP addresses previously assigned.

9. Install the Avid Motion Graphics server software on the new system drives, see “Installation 
Considerations” on page 66. 
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10. Verify the Avid Motion Graphics server is functioning. If not, call customer support before 
continuing.

Installing GPI Functionality in Your AMG Server

This topic contains information on how to install GPI functionality in your AMG playout server.

You can also install the GPI card in another computer. Information on how to install the GPI card 
on another computer is not covered in this guide. 

However, once you have installed the GPI card in another computer, you must install and 
configure the AMG GPI service on that computer, as described in “Installing and Configuring 
the AMG GPI Service” on page 205. Once installed, you can then, set up the GPI service in 
AMG Control as described in “Setting Up AMG GPI Service in AMG Control” on page 207.

Before you can install GPI service functionality, you must purchase a Sealevel SeaIO card 
(model BD8004, or Model 8012).

n This card must be purchased separately. Avid does not supply this card.

Once you purchase the card, follow the procedures below to install the Sealevel SeaIO GPI card 
in the Avid Motion Graphics Playout chassis.

The following topics are included:

• “Materials Checklist” on page 198

• “GPI Card Installation Checklist” on page 198

• “Removing and Installing the System Cover” on page 199

• “Installing the GPI Card on Your AMG Server” on page 201

• “Installing and Configuring the AMG GPI Service” on page 205

• “Setting Up AMG GPI Service in AMG Control” on page 207
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Materials Checklist

The following materials are required to perform this procedure:

• 1 Sealevel SeaIO GPI board (Model BD8004, or Model 8012)

• #2 Phillips Screwdriver

GPI Card Installation Checklist

The following table provides a checklist of tasks that must be performed when installing a GPI 
card in an Avid Motion Graphics playout server.

 Disconnect all cables from your AMG playout chassis (server), and remove the AMG server 
from the rack.

 Remove the system cover, as described in “Removing and Installing the System Cover” on 
page 199.

 Install the GPI card in your AMG playout chassis (server), as described in “Installing the GPI 
Card on Your AMG Server” on page 201

Depending on whether your AMG server is single or dual channel, do one of the following:

• For single channel AMG servers, install the GPI card in slot 4 or 5.

• For dual channel AMG servers, remove the USB PS/2 card from Slot 6, and install the GPI 
card in Slot 6.

n Doing so will reduce the number of USB slots in your AMG Playout server to two. 

 Replace the server cover, as described in“Removing and Installing the System Cover” on 
page 199.

 Re-rack the AMG server, as described in “Installing the AMG Server in a Rack” on page 34.

 Connect your power and other cables to your AMG server, as described in “Connecting Power 
Cords to the AMG Server” on page 58.

 Power on your AMG playout server, as described in “Powering on Avid Motion Graphics” on 
page 59.

 Install and configure the AMG GPI service on the computer where you installed the GPI card, as 
described in “Installing and Configuring the AMG GPI Service” on page 205.

 Set up GPI service in AMG Control, as described in “Setting Up AMG GPI Service in AMG 
Control” on page 207.
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Removing and Installing the System Cover

To remove the top cover:

1. Observe the safety precautions described in “Electrostatic Discharge Precautions” on 
page 189.

2. Make sure the Avid Motion Graphics server is powered off and all peripheral devices and 
AC power cords are disconnected.

3. Use a #2 Phillips Screwdriver to remove the four top cover screws shown in the following 
illustration.

4. Completely loosen the captive thumb screws on the back of the server. 
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5. Pull the two pull tabs on the sides of the cover outward.

n The top of unit first needs to slide to the rear to dis-engage it from the chassis front cover.

Removing the Top System Cover

6. Lift and slide the cover off the system to remove it.

Front

Thumb screws

Pull tabs

Top cover 
screws
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To install the server system cover:

1. Place the cover over the server so that the side edges of the cover sit just outside the server 
sidewalls.

2. While pulling the tabs outward, slide the cover forward until the tabs click into place and 
release the pull tabs. 

3. Replace the four top cover screws previously removed.

4. Tighten the rear thumbscrews.

5. Reconnect all peripheral devices and the AC power cords.

Installing the GPI Card on Your AMG Server

This topic contains information on how to install a GPI card in your AMG playout chassis. 

n The GPI card does not need to be installed in the AMG chassis. It can also be installed in any 
server that has room for the card. 

n If you are installing the GPI card in another computer, these instructions do not apply.

To install the GPI Card in your AMG playout chassis:

1. Observe the safety precautions described in “Electrostatic Discharge Precautions” on 
page 189.

2. Use a #2 Phillips Screwdriver to remove the cover and then lift cover out as previously 
described, see “Removing and Installing the System Cover” on page 199.
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3. Remove the T-bar by removing the ten (10) screws that are securing it to the chassis. After 
removing the T-Bar, there is a cover (that directs heat to the rear of the system). Remove that 
cover also.

Removing the T-Bar

Front

2 ScrewsT-Bar

4 Screws

4 Screws
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4. Identify the appropriate slot for the GPI card you are installing. 

t For single channel AMG servers, insert the GPI card in either Slot 4 or Slot 5.

Removing the Blank Card Slot cover (Single Channel Server)

Front

USB/PCI Card

NVidia Quadro
VGA board

AJA Kona 3G 
Video I/O board

Serial
Card

Slot 4 or Slot 5 can be used 
for installing the new GPI card 

S
D

I 3
S

D
I 4

S
D

I 2
S

D
I 1

Slot 4 Slot 5

Single Channel Server 
Expansion Slots
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t For dual channel servers, you must remove the USB/PS2 card from Slot 6, and install 
the GPI card in Slot 6.

Removing the Blank Card Slot cover (Dual Channel Server)

Front

USB/PCI Card 
(Remove this card before 
installing the GPI card)

NVidia Quadro
VGA boards

AJA Kona 3G 
Video I/O boards

Serial
Card

Slot 6 can be used for 
installing the new GPI card 

Slot 6

S
D

I 3
S

D
I 4

S
D

I 2
S

D
I 1

Dual Channel Server
Expansion Slots

S
D

I 3
S

D
I 4

S
D

I 2
S

D
I 1
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5. Remove the screw securing the blank panel (or populated slot) associated with the slot 
where you are installing the GPI card. 

6. Insert the GPI card into the slot so that it fits into the connector and fills the hole where you 
previously removed the blank panel.

n Be sure that the tab at the bottom panel seats into the slot on the bottom of the server chassis.

7. Re-attach the T-Bar with the ten (10) screws that you removed earlier.

8. Replace the top cover, see “Removing and Installing the System Cover” on page 199.

9. Re-rack the AMG server, see “Removing and Installing the System Cover” on page 199.

10. Reconnect all peripheral devices and the AC power cords into the server.

11. Turn on your Avid Motion Graphics server, as described in “Turning on Your Avid Motion 
Graphics Server” on page 177. Once your server is up and running, you will need to install 
and configure your GPI service.

For more information, see “Installing and Configuring the AMG GPI Service” on page 205.

Installing and Configuring the AMG GPI Service

Once you have installed the GPI card, you must install and configure the Avid Motion Graphics 
GPI Service on the computer where the GPI card was installed. 

Once configured, the GPI service listens for the button pushes on the GPI card, and then sends 
the appropriate command to the AMG playout application that the service is configured for.

c The AMG GPI Service must always be installed in the computer where the physical GPI 
card has been installed.

Before you install and configure the GPI service, make sure you have the appropriate drivers 
provided by Sealevel. 

n The AMGGPIConf.exe program is installed together with the service and its main purpose is to 
allow administrators the ability to configure the service. This program must be run with 
Administrator privileges which it tries to do by default. The program generates a configuration 
file called AMGGPIConf.ini that will be read by the service. Each time the configuration gets 
changed, the service must be restarted to apply the new settings. 

For troubleshooting purposes, the AMG GPI service will generate log files and store them at 
"C:\ProgramData\Avid\AMGGPI\logs".
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To install and configure the AMG GPI service:

1. On the AMG playout server, navigate to \AMGGPI\setup.exe to locate the installer for the 
GPI service, and double-click to run the installer.

2. Access the Avid Motion Graphics GPI Configuration tool by selecting Start > All 
Programs > Avid > Avid Motion Graphics > AMG GPI Configuration.

The Avid Motion Graphics GPI Configuration Tool dialog box opens:

3. Complete the fields on the Avid Motion Graphics GPI Configuration Tool as follows:

a. In the GPI Card Port field, select the port that the GPI card is inserted in.

n Sealevel GPI cards are accessed via "ports" that enable you to have more than one card installed 
on the same computer. Usually, the first installed card is accessed using the 0, the second card 
using the 1, and so on.

b. In the AMG News Control IP field, type the computer's IP where the AMG Control or 
AMG NewsControl is running.

c. In the AMG News Control Port field, type the TCP/IP port used by the AMG Control or 
AMG NewsControl to receive control messages. In this example, we are using port 
5130.

d. In the Commands section (GPI Input 00 - 15), you can use these drop lists to allow 
administrators to set which command will be sent when a GPI input level changes to 1 
from 0.

e. When you are done, click the Save Cfg button to save your configuration changes.

Clicking on this button updates the GPIConf.ini _le. The GPI service must be restarted 
to force it to read the new configuration.
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n Clicking the Clear Cfg button reverts all drop lists to the “Nothing” value.

f. Click the Restart button to restart the service. Any changes in the configuration from 
the last time the service was started will get applied.

g. (Option) Click the Run Service, button to run the service if it is not running. Click the 
Stop Service button to stop the service.

h. (Option) Click the Check Service button shows a pop-up with information about the 
state of the GPI service, and if the service is installed and running.

4. Next, you must set up the AMG GPI in the AMG Control application. For more information, 
see “Setting Up AMG GPI Service in AMG Control” on page 207.

Setting Up AMG GPI Service in AMG Control

Once the GPI port is configured, you must set it up in the AMG Control application.

AMG Control must be installed on a computer that has network access to the Avid Motion 
Graphics Server, or any Windows computer.

n We do not recommend installing AMG Control on the AMG server chassis as this might cause 
performance issues.

n License Activation is required.

To set up AMG GPI Service in AMG Control:

1. On the Windows computer where you installed AMG Control, open the AMG Control 
application, and click on the Settings icon (upper right of AMG Control). 
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2. Click the Miscellaneous tab. 

The Settings dialog box opens:

3. In the Port field, set the port to match the port that is used in the Avid Motion Graphics GPI 
Configuration Tool.

n In this example, we are using 5130.

4. In the GPIs section, click the Enabled check box, and click OK.

If AMG Control is able to connect, the GPI icon will turn green. If it cannot connect, the port 
will turn gray as shown below.



10 Product Recovery

This section describes the procedures to recover your Avid Motion Graphics server drive by 
reinstalling Windows 7 Ultimate and Avid specific additions and changes.

This procedure restores only the Windows operating system and the hardware drivers. It does not 
restore the Avid Motion Graphics software. The Avid Motion Graphics software must be 
reinstalled separately, after the operating system recovery is complete. 

The version number of your current image on the Avid Motion Graphics server can be found in 
the C:\IMAGE.TXT file on the root directory of the system drive. There is also an IMAGE.TXT 
file on the USB flash drive to inform you of the version you are about to install. To find out the 
current version of the Avid Motion Graphics server image, see the Avid Motion Graphics 
ReadMe.

c When reimaging an Avid Motion Graphic server that is currently licensed, you must first 
deactivate the Avid licence, see “Deactivating the License” on page 89.

You might need to reinstall the Windows 7 Ultimate operating system on your Avid Motion 
Graphics server if you are directed to do so by Avid Customer Support or if you are initializing a 
new system drive. The Product Recovery performs a Windows 7 Ultimate installation to the 
entire system drive and replaces all the data on your system drive partitions. 

n After reimaging the system, the Windows and Administrator password are set to avid.
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Reinstalling the Windows Operating System

Avid provides a recovery image on the 16 GB USB flash drive provided with your Avid Motion 
Graphics server. The USB flash drive you allows you to re-install the operating system and 
drivers as it was shipped from Avid.

To reinstall the Windows operating system from the Avid Product Recovery flash drive:

1. Locate the 16 Gb USB flash drive with the Avid Motion Graphics image.

2. Stop all activity on Avid Motion Graphics server and select Start > Shut Down.

The Shut Down Windows dialog box opens.

3. Insert USB flash drive into the front USB port in the system.

n You must enter the BIOS with USB flash drive plugged-in to set correct drive boot order.

4. Remove all USB devices except for the USB flash drive plugged into the front of the AMG 
Server before continuing. 

5. Restart the AMG server and press the Delete key several times during startup until you see 
“Entering Setup.”

6. Set the USB drive to boot first. 

a. Using the arrow keys, navigate to the Boot tab.

b. Down arrow and select Hard Disk Drives and press Enter.

c. Select 1st Drive and press Enter.

d. Down arrow and select “USB Kingston DataT.” 

n Depending on the manufacturer of the USB flash drive, this USB selection in the BIOS might 
change. The initial release includes a Kingston USB flash drive. This might not be the 
manufacturer of the USB flash drive in future releases.

7. Press ESC to escape from the Hard Disk Drive menu. Select Boot Device and set priority to 
“USB Kingston DataT.”

8. Press F10 to Exit and Save your changes.



Reinstalling the Windows Operating System

211

9. Press Enter or click OK to confirm the changes.

The system continues to start from the USB flash drive.

Wait until two windows appear, click on the blue window and select one of the available 
options:

- Recover the OS partition only.

- Recover the entire system disk.

- Exit without doing a recovery.

10. At the prompt, type 2 to “Recover the entire system disk.” 

When you type 2, a warning screen opens, informing you that you are about to recover the 
Windows operating system. 

n If you type 3, the recovery quits to the Main menu. You need to type 3 again to get to command 
window. Press Ctrl+Alt+Delete to quit in any of these windows. 

11. A yellow screen appears type Y.

12. A red screen appears type Y.

The reimaging takes about 1 hour and 30 minutes.

c Do not remove the USB flash drive while performing the product recovery. If you remove 
the USB flash drive an error is displayed stating it cannot write the Ghosterr.txt file. If the 
USB flash drive was removed, you cannot continue the process by re-installing the USB 
flash drive. You would have to start the recovery process from the beginning.

13. A gray screen prompts you to reboot. Type S to eject the media and shut down the system 
and remove the USB flash drive from the system.

14. (If removed) Reconnect all the network Ethernet cables.

15. Continue with configuring the operating system as described in see “Network and Operating 
System Settings” on page 59.



11 Specifications

This information provides on the dimensions, weight, environmental, electrical, and the power 
cord specifications for the Avid Motion Graphics Server. It also recommends the use of an 
un-interruptible power supply (UPS) and supported network cabling.

n For safety and regulatory information about your Avid Motion Graphics Server, see “Safety and 
Regulatory Information” on page 215.

The following main topics describe: 

• Dimensions and Weight

• Environment

• Electrical

• Uninterruptible Power Supply (UPS)

• Supported Cabling
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Dimensions and Weight

The following describes the dimensions and weight of the Avid Motion Graphics Server.

Environment

The following describes the optimal operating environmental specifications for the Avid Motion 
Graphics Server.

Electrical

The following describes the electrical specifications for the Avid Motion Graphics Server.

Uninterruptible Power Supply (UPS)

Avid recommends you purchase an Uninterruptible Power Supply (UPS) to use with your Avid 
Motion Graphics Server. A UPS protects you against sudden power surges or losses that could 
cause you to lose files or experience data corruption. The power outlets need to be from the same 
distribution panel. This helps prevent ground loops that can be caused by plugging equipment 
into power sources with different ground potentials. Make sure there is adequate, dedicated 
power for each UPS.

Component Name Height Width Depth Maximum Weight

Avid Motion Graphics Server 5.25 in (133 mm) 17.0 in (432 mm) 29 in (737 mm) 112 lbs (50.8 kg) with the 
maximum numbers of 
drives installed

Component Name Operating Temperature Operating Humidity Storage Temperature

Avid Motion Graphics Server 32°F to 104°F (0°C to 40°C) 5% to 95% (at 38°C) 
non-condensing

–4°F to 140°F (–20°C to 
60°C)

Component Name Voltage Frequency Watts

Avid Motion Graphics Server 100 to 240 Vac, 8 amps, Two 
hot-swap redundant AC 
power supplies

50 to 60 Hz 1100 W System Watts; running load 
software and 100% CPU usage
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w All the electrical work at your site should be done by a licensed electrician. All the 
electrical changes must meet country, state, and local electrical codes.

The Avid Motion Graphics Server supports UPS devices that are connected using network 
connections, USB connections, and serial connections. Install the software from the UPS 
manufacturer for advanced shutdown behavior, calibrate the UPS device. These software 
packages also allow for a connected Windows-based servers to send alerts to other 
Windows-based servers to perform actions.

The Motion Graphics Server is connected to a network and the network policy settings might 
also prevent you from completing this procedure. Make sure there is adequate power and the 
correct receptacle type for each hardware component, the rack power strips, and the UPS. Do not 
use extension cords to plug in any of the hardware components.

Supported Cabling

Avid supports the following cable types for connecting an Avid Motion Graphics Server.

Supported Cables Function
Connector Style and 
Maximum Cable Length

Cable Connection Type: Ethernet 
network cable, CAT5e, CAT6, or 
CAT6a

Ethernet Avid ISIS clients, Avid 
Interplay servers to shared storage 
networks Avid AirSpeed capture 
and playback servers to shared 
storage networks

RJ45 connector 100 Meters; If using CAT5e 
the cable it must be rated for 350 MHz for 
maximum length. The minimum GigE cable 
length for Avid network products is 6 feet or 
2 meters.



A Safety and Regulatory Information

This document contains safety and regulatory information for Avid hardware.

• Warnings and Cautions

• FCC Notice

• Canadian Notice (Avis Canadien)

• European Union Declaration of Conformity

• Disposal of Waste Equipment by Users in the European Union

• Argentina Conformity

• Australia and New Zealand EMC Regulations

• Japan EMC Regulations

• Korean EMC Regulations
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Warnings and Cautions

c This equipment is intended only for installation in a RESTRICTED ACCESS LOCATION.

c Never install equipment if it appears damaged.

c Disconnect the power cord before servicing unit.

c Only perform the services explicitly described in this document. For services or procedures 
not outlined in this document, speak with authorized Avid service personnel.

c Follow all warnings and cautions in the procedures.

c Operate the device within its marked electrical ratings and product usage instructions.

c If you need to replace a battery in an Avid hardware unit, be sure to use the correct battery 
type. There might be a risk of explosion if a battery is replaced by an incorrect type. 
Dispose of used batteries according to the manufacturer's instructions.

c For products with a power switch the main power switch should remain accessible after 
installation.

FCC Notice
Part 15 of the Federal Communication Commission Rules and Regulations has established Radio 
Frequency (RF) emission limits to provide an interference free radio frequency spectrum. Many 
electronic devices produce RF energy incidental to their intended purpose. 

Class A Equipment

This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC rules. These limits are designed to provide reasonable protection 
against harmful interference when the equipment is operated in a commercial environment. This 
equipment generates, uses, and can radiate radio frequency energy and, if not installed and used 
in accordance with the instructions, may cause harmful interference to radio communications. 
Operation of this equipment in a residential area is likely to cause harmful interference, in which 
case the user will be required to correct the interference at personal expense.

Modifications

The FCC requires the user to be notified that any changes or modifications made to Avid 
hardware that are not expressly approved by Avid Technology may void the user’s authority to 
operate the equipment.



Canadian Notice (Avis Canadien)

217

Cables

Connections to Avid hardware must be made with shielded cables with metallic RFI/EMI 
connector hoods in order to maintain compliance with FCC Rules and Regulations.

Canadian Notice (Avis Canadien)

Class A Equipment

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing 
Equipment Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel 
brouilleur du Canada.

European Union Declaration of Conformity

Declaration of conformity
Konformitätserklärung
Déclaration de conformité
Declaración de Confomidad
Verklaring de overeenstemming
Dichiarazione di conformità

We/Wir/Nous/WIJ/Noi:

Avid Technology
75 Network Drive
Burlington, MA, 01803 USA

European Contact: Nearest Avid Sales and Service Office or
Avid Technology International B.V.
Sandyford Industrial Estate
Unit 38, Carmanhall Road
Dublin 18, Ireland
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declare under our sole responsibility that the product,
erklären, in alleniniger Verantwortung,daß dieses Produkt,
déclarons sous notre seule responsabilité que le produit,
declaramos, bajo nuestra sola responsabilidad, que el producto,
verklaren onder onze verantwoordelijkheid, dat het product,
dichiariamo sotto nostra unica responsabilità, che il prodotto,

Product Name(s): Avid Motion Graphics Server

Model Number(s): 7020-30333-xx

Product Option(s): This declaration covers all options for the above product(s).

to which this declaration relates is in conformity with the following standard(s) or other 
normative documents.
auf das sich diese Erklärung bezieht, mit der/den folgenden Norm(en) oder Richtlinie(n) 
übereinstimmt.
auquel se réfère cette déclaration est conforme à la (aux) norme(s) ou au(x) document(s) 
normatif(s).
al que se refiere esta declaración es conforme a la(s) norma(s) u otro(s) documento(s) 
normativo(s).
waarnaar deze verklaring verwijst, aan de volende norm(en) of richtlijn(en) beantwoordt.
a cui si  riferisce questa dichiarazione è conforme alla/e seguente/i norma/o documento/i 
normativo/i.

The requirements of the European Council:

Safety: Directive 2006/95/EEC

UL 60950-1, 2nd edition
CAN/CSA-C22.2 No. 60950-1-07; 2007
IEC 60950-1, 2nd edition
EN 60950-1:2006

EMC: Directive 2004/108/EC

EN55022:2006 /A1:2007
EN55024:1998 /A1:2001 /A2:2003
EN61000-3-2:2006
EN60000-3-3:1995 /A1:2001 /A2:2005

Gerrett Durling, VP of Engineering, Shared Services

Issued In Burlington MA, USA 2011
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Disposal of Waste Equipment by Users in the 
European Union

This symbol on the product or its packaging indicates that this product must not be disposed of 
with other waste. Instead, it is your responsibility to dispose of your waste equipment by handing 
it over to a designated collection point for the recycling of waste electrical and electronic 
equipment. The separate collection and recycling of your waste equipment at the time of disposal 
will help conserve natural resources and ensure that it is recycled in a manner that protects 
human health and the environment. For more information about where you can drop off your 
waste equipment for recycling, please contact your local city recycling office or the dealer from 
whom you purchased the product.

Argentina Conformity

Made in USA

Australia and New Zealand EMC Regulations

Ken Hopkins
Avid Technology (Aust) Pty Ltd
c/o – Elliot House
Suite 810, Level 8
140 Arther St
North Sydney
NSW – 2060
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Japan EMC Regulations

Class A Equipment

This is a Class A product. In a domestic environment this product may cause radio interference 
in which case the user may be required to take corrective actions. VCCI-A

Korean EMC Regulations

Class A Equipment

Please note that this equipment has obtained EMC registration for commercial use. In the event 
that it has been mistakenly sold or purchased, please exchange it for equipment certified for 
home use.



Avid
75 Network Drive
Burlington, MA 01803-2756 USA

Technical Support (USA)
Visit the Online Support Center at 
www.avid.com/support

Product Information
For company and product information, 
visit us on the web at www.avid.com


	Title Page
	Contents
	Chapter 1 Avid Motion Graphics Overview 13
	Chapter 2 Rack Mounting and Cabling Your Server 34
	Chapter 3 Software Installation 65
	Chapter 4 Software Licensing 83
	Chapter 5 Video Setup and Preferences 91
	Chapter 6 Installing and Configuring Avid Motion Graphics Journalist 104
	Chapter 7 Installing and Configuring Avid Motion Graphics News Control 150
	Chapter 8 Upgrading Your AMG Server Hardware to Dual Channel 167
	Chapter 9 Adding and Replacing Hardware 189
	Chapter 10 Product Recovery 209
	Chapter 11 Specifications 212
	Appendix A Safety and Regulatory Information 215

	Using This Guide
	If You Need Help
	Accessing the Online Documentation

	Avid Motion Graphics Overview
	Product Suite
	Unpacking a New System
	Opening the Shipping Container
	Verifying Components
	Inspecting Components for Damage

	Avid Motion Graphics Hardware
	Avid Motion Graphics Server Front
	Server Controls and LEDs
	Drive Array and Slot Locations (Single Channel Servers)
	Drive Array and Slot Locations (Dual Channel Servers)
	RAID Behavior

	Avid Motion Graphics Server Rear Panel
	Expansion Slots
	System Drives
	Power Supplies
	USB Ports
	USB Devices and License Activation ID

	Checklist: Pre-Installation Preparations

	Rack Mounting and Cabling Your Server
	Installing the AMG Server in a Rack
	Rack-mount Requirements
	Positioning the Server in the Rack
	Separating the Slide Rails
	Attaching Inner Slide Rails to the Server
	Attaching the Outer Rails to a Square-Hole Rack
	Attaching the Outer Rails to a Round-Hole Rack
	Securing the Server in a Rack

	Installing the RAID Drives
	Installing the Breakout Box
	Cabling Avid Motion Graphics
	Video Connections
	Video Formats AMG 2.x Servers
	Video Formats AMG 1.x Servers and DekoPlayer Formats
	Connecting Video Cables
	Connecting the KVM Switch
	COM Port Pinouts
	Connecting VGA Cables
	Serial Input and Output Connections
	Connecting the Serial Cable
	Setting Serial Protocol
	Connecting to Ethernet Port 1

	Connecting a Keyboard, Monitor, and Mouse

	Connecting Power Cords to the AMG Server
	Powering on Avid Motion Graphics
	Network and Operating System Settings
	Server Log On
	Specifying a Unique Computer Name
	Configuring Date and Time Parameters
	Install the LSI MegaRAID Storage Manager Software
	Disabling Ethernet Ports
	Network Protection

	Configuring the RAID Drives (For Single Channel Servers only)

	Software Installation
	Installation Considerations
	Installing Avid Motion Graphics Software and All Dependencies
	Installing Avid Motion Graphics Tools
	Installing Avid Motion Graphics Plugins

	Software Licensing
	What You Need to Activate the Software License
	License Activation Using an Internet Connection
	License Activation Without an Internet Connection
	Deactivating the License


	Video Setup and Preferences
	Video Setup
	Shaped and Unshaped Keying

	Preferences
	Configuring Viewports Preferences
	Configuring Text Preferences
	Configuring Path Preferences
	Configuring Desktop Shortcut Preferences
	Configuring Miscellaneous Preferences
	Configuring the Reduced Renderer Preferences


	Installing and Configuring Avid Motion Graphics Journalist
	What You Need to Activate the Software License
	Setting Up the Avid Motion Graphics Journalist Server
	Avid Motion Graphics Journalist Server Installation Tasks
	Installing Avid Motion Graphics Journalist Server Software
	Licensing AMG NRCS Clients and AMG Clips
	Configuring the Avid Motion Graphics Journalist Server
	Starting the AMG Journalist Server Applications

	Installing AMG Journalist Client Software
	Setting Up the AMG Preview Renderer
	Installing the AMG Preview Renderer
	Licensing the AMG News Preview Renderer and AMG Clips
	Starting the Avid Motion Graphics Preview Renderers
	Creating Project Shortcuts on the AMG Preview Renderer

	Setting Up the AMG Advanced Device Manager
	Installing the AMG Advanced Device Manager
	Licensing the AMG Advanced Device Manager
	Configuring the AMG Advanced Device Manager

	Installing the Avid Service Framework
	Setting Up the AMG Device Service
	Installing Avid Motion Graphics Device Service
	Configuring the AMG Device Service

	Confirming Functionality
	Starting the Avid Motion Graphics Journalist Server
	Starting Avid Motion Graphics
	Starting the Avid Motion Graphics Preview Renderers
	Testing the AMG Journalist Client
	Testing Command Inventory, Playout, and Editing

	Example of AMGConf.ini File for iNEWS Command

	Installing and Configuring Avid Motion Graphics News Control
	AMG News Control Installation Tasks
	Installing AMG Journalist Server Software
	Configuring the AMG Journalist Server with AMG News Control
	Licensing AMG News Control
	Understanding the X: Drive Network Share
	Installing Avid Motion Graphics Journalist Client
	Installing the AMG Preview Renderer
	Creating a Project Shortcut
	Configuring Avid MOS Gateway, AMG News Control and iNEWS
	Configuring ENPS to Host the AMG Journalist Client
	Confirming Avid Motion Graphics Journalist Functionality

	Example of AMGConf.ini File for AMG News Control

	Upgrading Your AMG Server Hardware to Dual Channel
	Avid Motion Graphics Server Board Slots
	Electrostatic Discharge Precautions
	Upgrade Checklist
	Materials Checklist
	Removing and Installing the System Cover
	Installing the Additional VGA and Video I/O Boards
	Inserting Additional Media Drives in Your AMG Server
	Turning on Your Avid Motion Graphics Server
	(Optional) Upgrading the AMG Software
	(Optional) Upgrading AJA and NVidia Driver Configuration Settings
	Re-RAIDing Media Drives


	Adding and Replacing Hardware
	Electrostatic Discharge Precautions
	Removing and Replacing Data Drives
	Removing a Drive
	Replacing a Drive

	Replacing the Avid Motion Graphics Server
	Replacing System Drives in the Server
	Replacing System Drives in the Server

	Installing GPI Functionality in Your AMG Server
	Materials Checklist
	GPI Card Installation Checklist
	Removing and Installing the System Cover
	Installing the GPI Card on Your AMG Server
	Installing and Configuring the AMG GPI Service
	Setting Up AMG GPI Service in AMG Control


	Product Recovery
	Reinstalling the Windows Operating System

	Specifications
	Dimensions and Weight
	Environment
	Electrical
	Uninterruptible Power Supply (UPS)
	Supported Cabling

	Safety and Regulatory Information
	Warnings and Cautions
	FCC Notice
	Class A Equipment
	Modifications
	Cables

	Canadian Notice (Avis Canadien)
	Class A Equipment

	European Union Declaration of Conformity
	Disposal of Waste Equipment by Users in the European Union
	Argentina Conformity
	Australia and New Zealand EMC Regulations
	Japan EMC Regulations
	Class A Equipment

	Korean EMC Regulations
	Class A Equipment



